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PCGRIDDS32 FORWARD 
 

Welcome to PCGRIDDS32, the Microsoft Windows 32-bit version of the original Personal Computer 
based Gridded Interactive Display and Diagnostic System (PCGRIDDS).  It is intended as a 
forecaster's tool for providing interactive access to high resolution meteorological information in support 
of domestic forecasting and international aviation using the Microsoft WINDOWS computer 
environment. 
 
This release is a major step forward for the PCGRIDDS program.  It offers 32-bit programming power to 
an already very capable and powerful system.  PCGRIDDS32 retains the original PCGRIDDS look-and-
feel while adding the ability to process much larger GRIB data sets, more flexible display capability and 
increased processing speed. There have been very few restrictions and numerous improvements over 
the 16-bit DOS version of PCGRIDDS and many others are in the plans.  These differences are 
covered in the Introduction section of this document. 
 
PCGRIDDS32 is an interim product to bridge the gap between the DOS and Windows environment.  A 
future version will be a full MS Windows point-and-click GUI (WINGRIDDS?) and possibly a Linux 
version as well (LINGRIDDS?) 
 
You are encouraged to explore the new capabilities of the software and your comments on the 
operation of the system and your suggested enhancements to the basic set of menu-mode display and 
product options are always welcome.  The best way to learn about PCGRIDDS32 as a tool in 
addressing your forecasting problems is quite simply to try it. 
 
Good luck and enjoy. 
 
 
Ralph A. Petersen 
Jacqueline M. Lord 
Jeff Krob 
 
National Weather Service/NESDIS 
National Oceanic and Atmospheric Administration 
Department of Commerce 
United States of America 
 
 
PCGRIDDS32 Internet Home Page: http://home.comcast.net/~jkrob/ 
PCGRIDDS32 User Support Forum: http://www.weathergraphics.com/forum 
PCGRIDDS32 Email Support: Jeffrey.A.Krob@noaa.gov 
                                                 jkrob@comcast.net 
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Introduction 
 
PCGRIDDS32, a 32-bit Personal Computer based GRidded Interactive Display and Diagnostic System, 
is a software package that allows the user to view meteorologically significant fields of gridded analysis 
and numerical weather prediction model output.  The fields are displayed in either contour or vector 
format, whichever is appropriate for a particular field.  This package also allows the user to extract a 
variety of information from meteorological diagnostic parameters computed from the gridded data fields. 
 
The flexibility of PCGRIDDS32 allows the package to meet the needs of users with a wide range of 
skills and requirements.  The novice can quickly learn to display a wide variety of predefined products 
using the PCGRIDDS32 Menu system.  More advanced users can develop specialized products to 
meet their individual needs using the programmable PCGRIDDS32 Command language, including the 
creation of customized menu options to meet specific user needs. 
 
This documentation guides users through installation and the basic concepts of operating 
PCGRIDDS32 through its menu system.  It then proceeds with a discussion of topics useful for the 
more advanced user or system administrator.  Additional ONLINE HELP is available while using 
PCGRIDDS32.  All users should read the first four sections carefully: 
 

A. Introduction 
B. Installation of PCGRIDDS32 
C. Sample PCGRIDDS32 Applications Session 
D. Using PCGRIDDS32 

 
The remaining sections can be selected according to the user’s needs and interests. 
 

 Before Installation 
 
System Requirements and Preparation 
 
-- Hardware Recommendations 
 

AMD Athlon/Intel PENTIUM processor or greater running MS Windows 95 or greater. 
 
 VGA graphics adapter    Microsoft Windows compatible VGA or better color 

monitor. 
 

 
 16MB or greater memory   This amount of memory is the minimum required to 

run PCGRIDDS32.  As with any Microsoft Windows 
installation, the more memory, the better. 

 
 PostScript printer     As stated before, PCGRIDDS32 has no printing 

capability at this time.  When it is included, it will use 
the default Windows printer.  Any Ink or Laser printer 
will work.  Dot matrix printers will not work.  

 
 
-- System Setup 

PCGRIDDS32 runs Microsoft Windows 95 or later.  The system configuration necessary to run 
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PCGRIDDS32 is described in this section.   
 
 

Networks 
 Installation The PCGRIDDS32 software is designed for installation on a standalone 

PC. 
 

 Data  The data displayed within PCGRIDDS32 may be located on a network 
drive.  The complete path (drive and directory ) to the data must be 
specified in the file, USER\PCGMODE.DAT.  Refer to ‘PCGRIDDS32 
Configuration’ in section L (Customizing PCGRIDDS) for additional 
information. 

 
 
-- Memory Requirements 

PCGRIDDS32 requires a minimum of 3MB of memory.  The ingest programs that convert data 
from GRIB to PCGRIDDS32 format require about 3MB each of memory.  Check the available 
memory for running programs. 
 

 
Installation of PCGRIDDS32 
 
 

 New Installation of PCGRIDDS32 
 

Before you start the installation, read and check the following information. 
 

1. The PCGRIDDS32 software must be installed on a hard drive which is located on 
a standalone PC.   

 
2. If necessary, the installation will create the following directories:  \PCGRIDDS32.  

If the directories already exist, it will write over any files in these directories.  
Before installation save any important files in these directories and remove the 
directories. 

 
3. The PCGRIDDS32 installation consists of unzipping a compressed file. This 

compressed file is a self-extracting executable file. 
 
 

 Internet Access to PCGRIDDS32 Software and Documentation 
  
At this time, PCGRIDDS32 software and documentation is not available at the NWS web site or 
through FTP file transfer. 
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-- Install PCGRIDDS32 from your hard drive 
Once the transfer of the PCGRIDDS32 files to your local system is complete, you can install 
PCGRIDDS32 from your hard drive. 

 
1. Copy the PCGRIDDS32 installation ZIP file to a temporary directory of the hard drive you 

wish PCGRIDDS32 to execute from. 
 
 2. Uncompress the PCGRIDDS32 installation ZIP file with the Winzip or other ZIP file           

decompression program.  Uncompress the files from the Root directory.  The PCGRIDDS32 
directory will be created as part of the unzip process. 

 
3.   Once the installation is complete, you may delete the PCGRIDDS32 installation ZIP file. 
 

 4. Change directory to \PCGRIDDS32.  Find the P32.BAT file.  With the mouse, highlight the 
file and drag the file to the desktop.  Create a ‘Shortcut’ to the desktop for this file.  Rename 
the icon from ‘P32’ to ‘PCGRIDDS32’.  This way, you may  do a quick-start of PCGRIDDS32 
just by double-clicking the desktop icon.  Feel free to choose an icon which pleases you. 

 
NOTE: If the directory used for data displayed by PCGRIDDS is not stored in the directory 

C:\PCGRIDDS32\GRIDDATA directory, you MUST modify entry 2 in the file 
USER\PCGMODE.DAT.  Refer to the section ‘PCGRIDDS32 Configuration’ or the 
internal documentation in the file for additional information. 

 
 Install PCGRIDDS32 Program Files from Compact Disk 
  
The following procedure describes the installation of the PCGRIDDS32 software from compact 
disk (CD): 

  
 1. Place CD in your CD drive. 
 
 2. Uncompress the PCGRIDDS32 installation ZIP file with the Winzip or other ZIP file           

decompression program.  Uncompress the files from the Root directory.  The PCGRIDDS32 
directory will be created as part of the unzip process. 

 
 3. Change directory to \PCGRIDDS32.  Find the P32.BAT file.  With the mouse, highlight the 

file and drag the file to the desktop.  Create a ‘Shortcut’ to the desktop for this file.  Rename 
the icon from ‘P32’ to ‘PCGRIDDS32’.  This way, you may do a quick-start of PCGRIDDS32 
just by double-clicking the desktop icon.  Feel free to choose an icon which pleases you. 

 
 

 
NOTE: If the data displayed by PCGRIDDS is not stored in the directory 

C:\PCGRIDDS32\GRIDDATA directory, you MUST modify entry 2 in the file 
USER\PCGMODE.DAT.  Refer to the section ‘PCGRIDDS32 Configuration’ or the 
internal documentation in the file for additional information. 
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-- Directory Structure 
Below is a diagram of the directory structure required to run PCGRIDDS32.  All directories must 
be present in order to run PCGRIDDS32.   

 
 

─PCGRIDDS32──────┬───DATA 
                 ├───ANIMATION 
                 ├───GRIDDATA 
                 ├───HELP 
                 ├───MACROS 
                 ├───MAPFIL 
                 ├───PRTFIL 
                 ├───USER 
                 ├───BATCH 
                 └───GRIB─────┬──NWS 
                              ├──MOS 
                              ├──USER 
                              └──WAFS─────┬──OCTANTI 
                                          ├──OCTANTJ 
                                          ├──OCTANTK 
                                          ├──OCTANTL 
                                          ├──OCTANTM 
                                          ├──OCTANTN 
                                          ├──OCTANTO 
                                          └──OCTANTP 

 
 

PCGRIDDS32 The main PCGRIDDS32 directory contains the temporary and status files written 
by PCGRIDDS32 and the program files used to run the PCGRIDDS32 system. 

Your system administrator may modify the .PCG file to meet the needs of your 
environment.  If an error occurs during the execution of PCGRIDDS32, files, such as 
M.OUT, GRIB2PCG32.OUT and NGRB2PCG32.OUT may provide information about 
the source of the problem. 

 
GRIDDATA The GRIDDATA directory is the default directory where the gridded 

meteorological data are stored. 
Gridded data files can be added or deleted.   

 
 MACROS  The MACROS directory contains the currently active command files (xxxx.CMD) 

used to display PCGRIDDS products, the text file for the 'Product Category' 
menu (CMDMENU.LST), and the text files for the 'Product List' menus 
(CMDMENU.###). 

 
PCGRIDDS32 is delivered with a default set of macros.  You are encouraged to develop 
customized command files and menus to meet the special requirements of your 
environment (refer to 'Defining Products'). 

 
HELP  The HELP directory contains files used to supply ONLINE HELP for 

PCGRIDDS32. 
PCGRIDDS32 is delivered with a default set of HELP files.  If any customized macros are 
added to a 'Product List' menu, it is strongly recommended that a corresponding HELP file 
should also be added to the HELP directory. 
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USER  The USER directory contains files that control defaults for and the appearance of 
product displays, menu displays, and printed output.  Other files provide 
PCGRIDDS with information about your computing environment. 

These files can be modified to meet your requirements (refer to 'Customizing 
PCGRIDDS32'). 

 
DATA  The DATA directory contains supporting data files used by PCGRIDDS32 to 

display items such as forms, messages, and maps.  This directory does not 
contain gridded data files. 

The contents of these files are crucial to the operation of PCGRIDDS32 and should be 
modified only by the system administrator. 

 
           ANIMATION       The ANIMATION directory contains all of the file which are created and used 
                                     every time an animation command is executed within PCGRIDDS32. 
 
 
 

PRTFIL  The PRTFIL directory contains files used for printing.  Files with the extension 
.SVG contain products saved by the user for printing and restoring to the screen. 

The files, !A.SVG and A.SVG, are dummy files used by PCGRIDDS32 and should not be 
deleted.  Files that begin with '!' are used for delayed printing and should be managed 
through PCGRIDDS32.  All other .SVG files may be deleted by the user when they are no 
longer needed. 

 
MAPFIL  In order to display a map on the screen, PCGRIDDS32 must transform 

latitude/longitude based line segment coordinates (found, for example, in the file 
C:\PCGRIDDS32\DATA\WORLD.MAP) to the current map projection on the 
screen.  This is a time consuming process.  To increase the efficiency of 
PCGRIDDS32, display maps can be saved.  The MAPFIL directory contains the 
saved display maps (QCONTMP.###, QCONLTLN.###) and the list (MAP.LST) 
of and index (MAP.IDX) to the names of the saved display maps. 

Your system administrator can save frequently accessed display maps by using the SVMP 
command.  Files in this directory are controlled by PCGRIDDS32 and should not be 
modified by any user. 

 
BATCH  The BATCH directory contains batch files that control printing, and setting 

system files for PCGRIDDS32. 
These files are crucial to the operation of PCGRIDDS32 and its applications.  The system 
administrator can modify the files SAVGRIB, AUTOIN, FTPGRIB, PRINTPS, 
PRINTDL, and PRINTHP (refer to ‘Customizing the Ingest Process’ and ‘Batch Files for 
Printing’).  Except for translation, the remaining files should not be modified. 

 
GRIB  The GRIB directory contains files that control the selection and processing of 

GRIB data that is converted to PCGRIDDS32 format.  Within it are located the 
sub-directories NWS, WAFS and USER. Under the WAFS directory are a 
subdirectory for each WAFS Octant, I-P. 

Files in this directory are crucial to the operation of the ingest process and should not be 
modified by any user. 

 
NWS  Non-WAFS GRIB data files that will be converted to PCGRIDDS32 

format are stored  in the C:\PCGRIDDS32\GRIB\NWS directory. 
At this time, files in this directory are provided by the user using other transfer 
methods separate from PCGRIDDS32. 
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MOS  Non-WAFS MOS GRIB data files that will be converted to 
PCGRIDDS32 format are stored  in the C:\PCGRIDDS32\GRIB\MOS 
directory. 

At this time, files in this directory are provided by the user using other transfer 
methods separate from PCGRIDDS32. 

 
WAFS  WAFS GRIB data files that will be converted to PCGRIDDS32 format 

are stored  in the C:\PCGRIDDS32\GRIB\WAFS\OCTANT* directory 
where the ‘*’ stands for the Octant letter it represents. The user should 
place all ‘J’ Octant GRIB files in the 
C:\PCGRIDDS32\GRIB\WAFS\OCTANTJ directory and so on. 

At this time, files in this directory are provided by the user using other transfer 
methods separate from PCGRIDDS32. 

 
USER The USER directory contains files that control the menu displays, 

options, and processes related to the conversion of data from GRIB to 
PCGRIDDS format. 

These files can be modified by the system administrator to meet your 
requirements (refer to ‘Customizing the Ingest Process’). 
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PCGRIDDS to PCGRIDDS32 Differences  
 
 
This is PCGRIDDS32, a Microsoft Windows 32-bit implementation of the DOS-based 
PCGRIDDS written by Dr. Ralph Petersen and Jackie Lord.  Dr. Petersen was gracious 
enough to give me the code and allow me to create PCGRIDDS32.  PCGRIDDS32 is a 32-bit 
program, however, it is not a full Windows, ‘point-and-click’ GUI program.  The Windows GUI 
version is in the planning (WINGRIDDS) and is several years away.  PCGRIDDS32 is an 
intermediate step to the Win-GUI final product.  With that in mind, there have been a few 
features in the DOS PCGRIDDS that I have had to remove or have not been able to 
implement.  They are: 
 
1. Access to the DOS prompt – Now that PCGRIDDS32 is in a Windows environment, there is 

no need to call DOS from within PCGRIDDS32.  Now, when PCGRIDDS32 is executing, 
just ALT-TAB to switch to the Windows environment to go to explorer, the Command 
Prompt or any other program.  PCGRIDDS32 is still active on the Task Bar. 

2. Forms – PCGRIDDS had a utility to modify the layout and color of forms used in the 
program.  In PCGRIDDS32, the forms are fixed in their layout and color and can not be 
modified.  

 
I have tried to make PCGRIDDS32 a faithful copy of PCGRIDDS in the look-and-feel, however, 
there was one function which had to be implemented in a different way.  That is: 
 
1. ESC Key – The ESC key was used in PCGRIDDS while in the Menu Mode to back out of 

menus or cancel menu operations.  In PCGRIDDS32, the F12 Function key has replaced 
the ESC.  PCGRIDDS32 is running in a special ‘Standard Graphics/Fullscreen” graphics 
mode so the program takes up the whole screen area with no Windows-style border.  If the 
ESC key is pressed, the program is shifted from the Fullscreen mode to the “Standard 
Graphics/Quickwin” mode that shows the Windows-style border around the parimeter of the 
screen. If in Quickwin mode, the way to return to Fullscreen mode is to depress ALT-Enter.  
PCGRIDDS32 will run fine in Quickwin mode however, the PCGRIDDS32 screen area in 
Quickwin mode is shifted down the height of the border across the top and the bottom area 
is lost that amount plus the thickness of the border across the bottom of the screen.  That 
means the color bar information is lost as well as the green information bar in the Menu 
mode. 

 
*****  NOTICE *****   The mouse is visible in PCGRIDDS32 but is never used so it is 
recommended just move it to the side of the screen, out of the way.  If one of the mouse 
buttons is depressed while PCGRIDDS32 is running, it will have the same effects as pressing 
the ESC key mentioned above.  However, the mouse button/ESC key issue does have one 
useful function.  If PCGRIDDS32 should ever hang execution and will not respond to normal 
keyboard entry, pressing the ESC key or mouse button should kick PCGRIDDS32 into the 
Quickwin mode revealing the “X” in the upper right corner. Clicking this with the mouse will kill 
the execution of PCGRIDDS32. 
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Enough of the bad stuff.  Here is a rundown of all the improvements: 
 
1. Screen Resolution – PCGRIDDS32 will operate at whatever screen resolution Windows is 

running in when PCGRIDDS32 is started.  If you should change the screen resolution while 
PCGRIDDS32 is running, it will stay at the previous setting until PCGRIDDS32 is 
terminated and restarted.  FYI – PCGRIDDS32 looks ‘fine’ in 1280x1024!! 

2. MAPTYPE.DAT – This file is now obsolete and is no longer needed for PCGRIDDS32 to 
open and display PCG files.  NGRB2PCG32 includes a copy of the GRIB GDS (Grid 
Description Section) and calculates grid projection from that data. 

3. Mercator Grids – PCGRIDDS32 now is able to handle Mercator grid projections. 
4. Map Background -  The geopolitical map background display method has been improved.  

When you open a new PCG file, the map is created then and stored as a Bit-mapped file 
for use whenever a parameter is plotted on the screen.  Speed is improved dramatically – 
especially on slower machines. 
This is also true for the TIME and CROSS Sections.  When an area is selected, the 
background is pre-drawn and stored so the numerous commands previously needed to 
draw that background every time you wish to plot a parameter is no longer needed.  The 
background is automatically drawn.  

5. PCGRIDDS32 is Y2K enabled 
6. There is no more WAFS or NWS mode of PCGRIDDS32.  That was implemented in 

PCGRIDDS to handle the ingesting of WAFS or NWS GRIB files in the same directory  
(Grib/Final).  With the rewriting of NGRB2PCG32 for NWS GRIB and GRIB2PCG32 for 
WAFS GRIB, they handle their files in separate directories (Grib/NWS for NGRB2PCG32 
and Grib/WAFS/* for GRIB2PCG32).  The NWS and WAFS GRIB ingest menu has been 
combined into one menu.  Within the Grib/WAFS directory, there are eight subdirectories; 
one for each octant you wish to ingest.  The WAFS GRIB ingestion process has been 
simplified.  All preprocessing has been incorporated into GRIB2PCG32 so all that is 
needed is to select the global area you wish to ingest then convert the GRIB files to the 
PCGRIDDS32 file.  Both the NWS and WAFS ingest process will select and ingest all the 
parameters and all the times of the files you download.  The selection options that were in 
PCGRIDDS has been removed. 

7. Thickness (THCK) as well as Thermal Wind (TWND) are no longer fixed to 1000 – 500 mb 
layers.  THCK and TWND will now calculate using whatever the PCGRIDDS32 Layers are 
set to. 

 
 
Any new diagnostic commands are covered in the Release Notes and in the ‘Diagnostic 
Functions’ section of the manual. 
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GRIB2PCG to GRIB2PCG32 Differences  
 
 
This will explain the program GRIB2PCG32 in reference to the DOS version, GRIB2PCG and 
list the changes and improvements to the program. 
 
GRIB2PCG32 is the GRIB file ingest utility for PCGRIDDS32.  The DOS version, GRIB2PCG 
had several drawbacks that were: 
 
1. Limited GRIB file size ingest capability. 
2. Limited PCGRIDDS file size (1499 records). 
3. 8.3 DOS file name restriction on GRIB file and PCGRIDDS file. 
4. Required entering grid parameters into MAPTYPE.DAT and GRIBSPEC.DAT files. 
5. Required a separate pre-processing be done to inventory the GRIB files. 
6. Required the GRIB file names be listed in GRIBCOPY.DAT before NGRB2PCG could 

ingest them.  
 
In GRIB2PCG32, all of these limitations were removed.  GRIB2PCG32 has these capabilities 
and improvements; 
 
1. GRIB2PCG will create a PCGRIDDS32 file of up to 1,000,000 records or the 4 Gb OS 

limit…whichever comes first! 
2. GRIB file names can be up to 80 characters long. 
3. The PCGRIDDS32 file name convention has been changed.  For example, the DOS 

version created a PCGRIDDS file with the name AVN06JAN.12Z that showed January, 6 , 
12Z model run of the AVN without showing any information concerning which octants were 
ingested.  With GRIB2PCG32, the convention is now JA060312.AVN* where the characters 
to the right of the ‘.’ show the three letter name of the model run and all octants included in 
the ingest such as JA060312.AVN-IJKLMNOP.  The ‘AVN’ is obtained from the file 
GRIBMODL.DAT and the grid number is obtained from the new file GRID.DAT which 
associates the grid number with a unique alphanumeric character similar to what was done 
in GRIBSPEC.DAT however, no GRIB parameters are required now (see below). 

4. MAPTYPE.DAT and GRIBSPEC.DAT are now obsolete and are not needed/included in 
GRIB2PCG32 or PCGRIDDS32.  All grid information is obtained from the GRIB GDS (Grid 
Description Section). 

5. GRIB2PCG32 now gets the GRIB file name information directly through OS System Calls 
and the batch file ‘front-end’ where a DIR command was called to build GRIBCOPY.DAT is 
no longer needed.  GRIB2PCG32 can be executed directly. 

6. GRIB2PCG32 is Y2K enabled and is designed to incorporate the upcoming GRIB II 
standard.   

7. GRIB2PCG is faster than the DOS version. 
 
GRIB2PCG32 generated files are not compatible with the DOS version and cannot be 
displayed on the DOS PCGRIDDS. 
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NGRB2PCG to NGRB2PCG32 Differences  
 
 
This will explain the program NGRB2PCG32 in reference to the DOS version, NGRB2PCG 
and list the changes and improvements to the program. 
 
NGRB2PCG32 is the GRIB file ingest utility for PCGRIDDS32.  The DOS version, NGRB2PCG 
had several drawbacks that were: 
 
7. Limited GRIB file size ingest capability. 
8. Limited PCGRIDDS file size (1499 records). 
9. 8.3 DOS file name restriction on GRIB file and PCGRIDDS file. 
10. Required entering grid parameters into MAPTYPE.DAT and GRIBSPEC.DAT files. 
11. No Mercator projection capability. 
12. Required the GRIB file names be listed in GRIBCOPY.DAT before NGRB2PCG could 

ingest them.  
13. Had a bug where Lat/Lon grids were shifted 90 degrees to the east. 
 
 
In NGRB2PCG32, all of these limitations were removed.  NGRB2PCG32 has these capabilities 
and improvements; 
 
8. Ingest GRIB size of up to 2,500,000 grid points.  The largest grid in NWS inventory is 

1,509,285 points (AWIP Grid #227 5km Lambert over US). 
9. NGRB2PCG will create a PCGRIDDS32 file of up to 1,000,000 records or the 4 Gb OS 

limit…whichever comes first! 
10. GRIB file names can be up to 80 characters long. 
11. The PCGRIDDS32 file name convention has been changed.  For example, the DOS 

version created a PCGRIDDS file with the name AU050100.AV3 that showed August 5, 
2001, 00Z model run of the AVN on grid# 003.  With NGRB2PCG32, the convention is now 
AU050100.AVN003 where the six characters to the right of the ‘.’ show the three letter 
name of the model run and the three digit grid number.  The ‘AVN’ is obtained from the file 
GRIBMODL.DAT and the grid number is obtained from the new file GRID.DAT which 
associates the grid number with a unique alphanumeric character similar to what was done 
in GRIBSPEC.DAT however, no GRIB parameters are required now (see below). 

12. MAPTYPE.DAT and GRIBSPEC.DAT are now obsolete and are not needed/included in 
NGRB2PCG32 or PCGRIDDS32.  All grid information is obtained from the GRIB GDS (Grid 
Description Section). 

13. NGRB2PCG32 can now ingest Lat/Lon, Mercator, Polar Stereographic and Lambert grid 
projections. 

14. NGRB2PCG32 now gets the GRIB file name information directly through OS System Calls 
and the batch file ‘front-end’ where a DIR command was called to build GRIBCOPY.DAT is 
no longer needed.  NGRB2PCG32 can be executed directly. 

15. NGRB2PCG32 is Y2K enabled and is designed to incorporate the upcoming GRIB II 
standard.   
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16. NGRB2PCG is faster than the DOS version. 
 
NGRB2PCG32 generated files are not compatible with the DOS version and cannot be 
displayed on the DOS PCGRIDDS. 
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PCGRIDDS32 Applications 
 
-- Display the PCGRIDDS32 Applications menu (Fig.21). 
 

1. Type: CD \PCGRIDDS32 
Changes to the PCGRIDDS32 directory. 

 
2. Press: [P32][Enter] 

Displays the ‘PCGRIDD32S Applications’ menu. 
 
 

Fig.21 
┌────────────────────────────────────────────────────────────┐ 
│  ╔══════════════════════════════════════════════════════╗  │ 
│  ║                  PCGRIDDS32 Applications             ║  │ 
│  ║                                                      ║  │ 
│  ║  1. Ingest GRIB Data                                 ║  │ 
│  ║  2. Run PCGRIDDS32                                   ║  │ 
│  ║  X. Exit to DOS                                      ║  │ 
│  ║                                                      ║  │ 
│  ║ Version 3/2005                           MARCH 2005  ║  │ 
│  ╚══════════════════════════════════════════════════════╝  │ 
│  Your choice? (1-2 or X to exit)                           │ 
└────────────────────────────────────────────────────────────┘ 

 
 
-- Menu options 
 

1. Ingest GRIB Data 
Convert data in GRIB format to a form that PCGRIDDS32 can read (refer to ‘Ingesting 
GRIB Data’). 

 
2. Run PCGRIDDS32 

Begin a PCGRIDDS32 session (refer to ‘Using PCGRIDDS32’). 
 

X. Exit PCGRIDDS32 
Return to Windows after completing a PCGRIDDS32 session or applications. 
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Ingesting GRIB Data  
 
As the name implies, PCGRIDDS32 works off of GRIB model data.  However, PCGRIDDS32 cannot 
work with the GRIB data directly. It must convert the GRIB data to PCGRIDDS32 rapid-access format 
before any data can be displayed.  This process is referred to as ingesting GRIB data and this is where  
the GRIB ingest utilities are used.  The use of these utilities will be covered in separate sections below. 
 
Due to changes in the directory structure of the NCEP/NWS FTP Servers, PCGRIDDS32 can no longer 
transfer GRIB files from the NWS to the PCGRIDDS32 host PC. The user must do this function 
manually using other, third-party FTP applications.  This may be fixed in future versions.   
 
The PCGRIDDS-format files created with these new GRIB ingest utilities are not compatible with the 
DOS versions.  A new version, PCG Version 2, has been created to allow for larger data sets as well as 
including the Grid Navigation information so the files MAPTYPE.DAT and GRIDTYPE.DAT are no 
longer needed in association with these new files.  However, if you still wish to display the older, PCG 
Version 1 (DOS) versions of PCG files, due to the lack of grid navigation information embedded within 
the file, the MAPTYPE.DAT file from the DOS PCGRIDDS program which created those files will have 
to be copied to \PCGRIDDS32\DATA directory so PCGRIDDS32 may obtain the grid navigation 
information and display the Version 1 files correctly.  
 
The PCG Version 2 files have a different naming convention from PCG Version 1 files.  The Version 1 
files had a name format such as for WAFS : WAF27APR.00Z  where: 
 
      WAF  - WAFS grid 

27  - Day of the month 
APR  -  Month 
00Z   -  Hour of Model run 

 
or for NWS-type files: JN089500.E48  where: 
 
      JN  -  Month 

08 -  Day of the month 
95    -  Year 
00    -  Hour of Model run 
E48 -  Three alphanumeric representation for grid projection from MAPTYPE.DAT file. 

 
The PCG Version 2 files have a different, and much more descriptive naming convention.  WAFS, NWS 
and NWS MOS files still have their differences.  A WAFS file would have a name such as:   
MAR150312.AVN-JKLI 
where: 
 
     MAR   -  Month 

15    -  Day of month 
03    -  Year (last two digits) 
12    -  Hour of Model run 
AVN    -  3-letter Model name 
JKLI    -  Octants included in GRIB ingest 
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Or for NWS-type files: NOV070312.ETA211  where:    
 
   NOV  -   Month 
      07     -   Day of the Month 
      03     -   Year (last two digits) 
      12     -   Hour of Model run 
     ETA   -   3-letter Model name 
     211    -   Grid Projection Number             
 
Or for NWS MOS-type files: NOV070312.ETAMOS211  where:    
 
   NOV  -   Month 
      07     -   Day of the Month 
      03     -   Year (last two digits) 
      12     -   Hour of Model run 
     ETA   -   3-letter Model name 
     MOS  -   Signifying MOS-type data 
     211    -   Grid Projection Number             
 
-- Types of GRIB data 

Several types of GRIB data are available to the PCGRIDDS32 user:  WAFS (global data), NWS 
and NWS - MOS.  Because the data are structured differently, the ingest procedures for the data 
types are different.  The selected ingest procedure which is displayed in the title of the ‘Ingest 
GRIB Data’ menu must match the data type that is ingested. 

 
WAFS 
 Data for global grids (WAFS data) are subdivided into octets (I,J,K,L,M,N,O,P).  This data 

must be preprocessed to create an inventory and list of model runs available for conversion 
from GRIB to PCGRIDDS32 format.  Only one model run may be converted to 
PCGRIDDS32 format in a single ingest session. WAFS GRIB data is preprocessed and 
converted to PCGRIDDS32 format using the utility GRIB2PCG32.EXE.  If any problems or 
errors occur while using GRIB2PCG32, please refer to the file GRIB2PCG32.OUT. 

 
NWS 

Data for the entire grid are stored together as a single group in NWS GRIB data files.  No 
pre-processing of NWS GRIB data is necessary before the data are converted to 
PCGRIDDS32 format.  Multiple model runs may be converted from GRIB to PCGRIDDS32 
format in a single ingest session.  The conversion utility is called NGRB2PCG32.EXE.  If any 
problems or errors occur while using NGRB2PCG32, please refer to the file 
NGRB2PCG32.OUT. 

 
MOS 
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Data for the entire grid are stored together as a single group in MOS GRIB data files.  No 
pre-processing of MOS GRIB data is necessary before the data are converted to 
PCGRIDDS32 format.  However, the data parameters for a MOS file are different than a 
NWS file so a different ingest utility is required. Where the GRIBPARM.DAT file is used in 
the NWS ingest process, a new file, MOSGRIBPARM.DAT is required to process MOS 
GRIB files. Multiple model runs may be converted from GRIB to PCGRIDDS32 format in a 
single ingest session.  The conversion utility is called NMOSGRB2PCG32.EXE.  If any 



problems or errors occur while using NMOSGRB2PCG32, please refer to the file 
NMOSGRB2PCG32.OUT. 

 
-- Selecting the method used to process GRIB data 
 
The procedure used to convert GRIB data to PCGRIDDS32 format differs for NWS, NWS-MOS and 
WAFS data.  The selected procedure MUST match the type of GRIB data that you process. When 
ingesting and converting GRIB files to PCG files, when using NWS GRIB, the user must use the 
INGEST NWS menu selections and vice-versa for WAFS.  
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    WAFS GRIB Data Ingest 
 

The following steps show you how to manually convert WAFS data encoded using a GRIdded 
Binary format (GRIB) to PCGRIDDS32 format.  The instructions assume you are using the sample 
WAFS data set provided with the program.  After you have completed the example, read the 
documentation in detail to get a better understanding of the software and to answer your 
questions. 
 
WAFS GRIB data can be ingested in a manual mode or automatic mode.  The following 
instructions show the steps for manual WAFS GRIB ingest.  At the end of these instructions, the 
automatic method is explained.  

 
-- Starting the manual ingest process 

Use the following steps to display the ‘Ingest WAFS GRIB Data’ menu.  Selecting options from 
this menu prepares your GRIB data for ingest and begins the ingest process. 

 
  1. From the desktop, double-click the icon PCGRIDDS32 

The ‘PCGRIDDS32 Applications’ menu is displayed on the screen (Fig.1). 
 

2. Type: 1 
Selects choice #1 (Ingest GRIB Data) from the Applications menu.  Displays the ‘Ingest GRIB 
Data’ menu (Fig.15). 

 
 

Fig.15 
┌─────────────────────────────────────────────────────────────┐ 
│  ╔═══════════════════════════════════════════════════════╗  │ 
│  ║                   Save GRIB Data                      ║  │ 
│  ║                                                       ║  │ 
│  ║ 1. Save GRIB Data                                     ║  │ 
│  ╚═══════════════════════════════════════════════════════╝  │ 
│  ║                 Ingest WAFS GRIB Data                 ║  │ 
│  ║                                                       ║  │ 
│  ║ 2. Delete WAFS GRIB Data                              ║  │ 
│  ║ 3. Select WAFS area for Gridded Data Set              ║  │ 
│  ║ 4. Convert WAFS GRIB Data to PCGRIDDS32 Format        ║  │ 
│  ╚═══════════════════════════════════════════════════════╝  │ 
│  ║                 Ingest NWS GRIB Data                  ║  │ 
│  ║                                                       ║  │ 
│  ║ 5. Delete NWS GRIB Data                               ║  │ 
│  ║ 6. Interpolate GRIB to new Grid Projection            ║  │ 
│  ║ 7. Convert NWS GRIB Data to PCGRIDDS32 Format         ║  │ 
│  ║ 8. Convert MOS GRIB Data to PCGRIDDS32 Format         ║  │ 
│  ║ X. Return to Main Menu                                ║  │ 
│  ╚═══════════════════════════════════════════════════════╝  │ 
│  Your Choice? (1-8 or X to Return)                          │ 
└─────────────────────────────────────────────────────────────┘ 

 
 
-- Save GRIB Data 

Use the following optional steps to archive GRIB data files from previous forecasts, if desired,  
before you acquire new data: 

 
1. Type: 1 
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Selects choice #1 (Save GRIB Data) from the ‘Ingest WAFS GRIB Data’ menu. 
 

2. Type the directory where you want the GRIB data saved. 
You must specify the complete path of an empty directory.  Press [ESC] if you want to stop the 
copy process at this point. 

 
3. Press: [Enter] 

Begins the copy process. 
 

If the directory you specify does not exist, you are given an option to create the directory.  Press 
[Y] to create the directory or [N] to quit the copy process. 

 
If the directory you specify is not empty, you are given an option to delete all the files in the 
directory.  Press [Y] to delete the files or [N] to quit the copy process. 
 
 
If the default copy procedure does not meet the needs of your environment, your system 
administrator can modify the batch file C:\PCGRIDDS32\BATCH\SAVGRIB.BAT (refer to 
‘Customizing the WAFS Ingest Process’). 

 
 
-- Delete GRIB Data 

GRIB data from the previous forecast cycle should be deleted before you acquire GRIB data for 
a new forecast cycle.  This will avoid mixing data from different model forecasts and speed up the 
conversion to PCGRIDDS32 format because the programs that perform these conversions may 
process files for ALL the forecast model dates that are present. 

 
To delete GRIB data, type: 2 

Selects choice #2 (Delete GRIB Data) from the ‘Ingest WAFS GRIB Data’ menu. 
 

You are asked to verify that you want to delete all the files in the GRIB/WAFS/* directory.  Press 
[Y] to begin deleting files.  Press [N] to stop the deletion process. 

 
 
-- Converting WAFS Data from GRIB to PCGRIDDS32 format 

An important step must be taken to describe the area included in the PCGRIDDS32 data set and 
begin the conversion.  You can perform this action by selecting one or more of the following 
entries from the ‘Ingest WAFS GRIB Data’ menu. 

 
3. Select area for gridded data set. 
4. Convert GRIB data to PCGRIDDS32 format. 

 
Steps 3 & 4 are required the first time you convert GRIB data to PCGRIDDS32 format.  The 
values you set are saved for subsequent conversions.  If you use the same parameters for future 
conversions, only step 4 (Convert GRIB data to PCGRIDDS32 format) is required.  To change 
parameters, select only the options you want revised.  The remaining parameters are defined 
from the values saved from the previous conversion.  These conversion steps are described in the 
following sections. A summary of the conversion process is contained in the file 
GRIB2PCG32.OUT. 
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If you initially decide to convert part of your GRIB data to PCGRIDDS32 format, you may convert 
additional data at a later time. 

 
As long as the new GRIB data you select covers the same area and was produced from the 
same model run as the initial data, the ingest program adds new variables to the existing file 
without reprocessing or overwriting the variables currently in the file. 

 
If you select a new area but the GRIB data are from the same model run, then the ingest 
program produces a new file with the same name, but modifies the last letter of the 
extension.  For example, if the initial PCGRIDDS32 file is WAF28APR.00Z, the next files are 
named WAF28APR.00Y, WAF28APR.00X (up to a total of 10 files). 

 
If the GRIB data are from a different model run, then a new PCGRIDDS32 file is produced 
and named according to the model run.  For example, if the last file produced is 
WAF28APR.00Z, then the first file from the next model run is named WAF28APR.12Z. 

 
 
-- Select Area for Gridded Data Set 

The surface of the earth is divided into eight areas (octants) identified by the labels 
I,J,K,L,M,N,O,P.  You must specify the area that is covered by the gridded data set you are 
creating from the GRIB data.  If you do not select a new area, then the area you selected for the 
last gridded data set is used.  Only those GRIB data octants within the selected area are included 
in the PCGRIDDS32 data set. 

 
The menu displayed on the screen lists the areas available for the conversion process.  The 
required octants are listed for each entry.  GRIB data for all octants required by the selected area 
must be placed in the GRIB/WAFS/OCTANT* directory where the “*” denotes the Octant letter.  If 
any required octants are missing for a field, GRIB data for that field will not be converted to 
PCGRIDDS32 format. 

 
The location of each octant is described below: 

 
Octant  Latitude  Longitude 
---------  -----------  -------------- 
I   0-90N   30W- 60E 
J   0-90N   60E-150E 
K   0-90N  150E-120W 
L   0-90N  120W- 30W 
M   0-90S   30W- 60E 
N   0-90S   60E-150E 
O   0-90S  150E-120W 
P   0-90S  120W- 30W 
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Use the following steps to select an area for the gridded data set: 
 

1. Type: 3 
Selects choice #3 (Select WAFS Area for Gridded Data Set) from the ‘Ingest WAFS GRIB Data’ 
menu.  Displays a menu listing the available areas.  A sample menu is shown in Fig.17.  Your 
system administrator can modify this menu to meet the needs of your environment (refer to 
‘Customizing the WAFS Ingest Process’). 

 
2. Select an area. 

To select an entry with the highlight 
Position the highlight to the desired choice and press [Enter]. 

 
To select an entry by letter 

Each line of the menu begins with a label (A.1, B.1, etc.) where the letter indicates the 
sequence of the line on the current page and the number shows the current menu page 
number.  For example, C.1 refers to line 3 on the first page of the menu.  You may select an 
entry on the current page by typing the letter of that entry. 

 
 

Fig.17 

 
 
 
 The information contained in the Select Area for Gridded Data Set is explained in the  
           ‘Customizing WAFS GRIB Ingest’ in the Customizing the PCGRIDDS32 System section. 
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-- Convert WAFS GRIB Data to PCGRIDDS32 Format 
After your GRIB data are stored in the GRIB\WAFS/Octant* directories, you are ready to 
preprocess the GRIB data to produce an inventory and list of model runs to be included in the 
gridded data set and convert your GRIB data to PCGRIDDS32 format. The WAFS GRIB 
preprocessing used to be a separate utility in PCGRIDDS.  In PCGRIDDS32, that function has 
been incorporated within the GRIB2PCG32 ingest utility. 

 
Use the following steps to proceed with the conversion process: 

 
1. Type: 4 

Selects choice #4 (Convert WAFS GRIB data to PCGRIDDS32 Format) from the ‘Ingest WAFS 
GRIB Data’ menu.  GRIB data are preprocessed and inventoried before they are converted to 
PCGRIDDS32 format.  This procedure may require a significant amount of time if you are 
processing a large quantity of data.  Control returns to the ‘Ingest WAFS GRIB Data’ menu when 
the conversion process is completed.  The data are now ready to be used in a PCGRIDDS32 
session. 

 
After the conversion is complete, the data files in PCGRIDDS32 format are placed in the directory, 
C:\PCGRIDDS32\GRIDDATA, and are available for display by PCGRIDDS32 (refer to ‘Sample 
PCGRIDDS Applications Session’). 

 
Note: All GRIB files are left unchanged after the PCGRIDDS32 file is created. 
 

 Once the WAFS GRIB ingest is complete, 
 

4. Type: X 
Selects choice #X (Return to Main Menu).  Returns to the ‘PCGRIDDS32 Applications’ menu.  
You can now type 2 to begin a PCGRIDDS32 session and use the data set you created or you can 
type X to exit. 

 
 

--Starting the automatic ingest process 
 

 The WAFS GRIB ingest process can be performed through a batch file for automatic execution.  
Within the batch file, GRIB2PCG32.EXE routine can be called from the command line with an 
Octets definition file listed in \PCGRIDDS32\GRIB as a command argument.  See the example 
below: 
 
 GRIB2PCG32 OCTETS.PL2 
 
This command string will execute the GRIB2PCG32 utility and it will ingest octets P & L. 
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 NWS GRIB Data Ingest 
 

The following steps show you how to convert NWS data encoded using a GRIdded Binary format 
(GRIB) to PCGRIDDS32 format.  The instructions assume you are using the sample NWS data 
set provided.  After you have completed the example, read the documentation in detail to get a 
better understanding of the software and to answer your questions. 

 
Sample data set contents 

The sample NWS data set contains: 
 

ETA model fields (24 hour forecast) 
 
 

Start a session. 
 

1. Type: CD \PCGRIDDS32 
Changes to the PCGRIDDS32 directory. 

 
2 Press: [P32][Enter] 

Displays the ‘PCGRIDDS32 Applications’ menu. 
 

3. Type: 1 
Selects choice #1 (Ingest GRIB Data) from the Applications menu.  Displays the ‘Ingest GRIB 
Data’ menu (Fig.15). 

 
 

Fig.15 
┌─────────────────────────────────────────────────────────────┐ 
│  ╔═══════════════════════════════════════════════════════╗  │ 
│  ║                   Save GRIB Data                      ║  │ 
│  ║                                                       ║  │ 
│  ║ 1. Save GRIB Data                                     ║  │ 
│  ╚═══════════════════════════════════════════════════════╝  │ 
│  ║                 Ingest WAFS GRIB Data                 ║  │ 
│  ║                                                       ║  │ 
│  ║ 2. Delete WAFS GRIB Data                              ║  │ 
│  ║ 3. Select WAFS area for Gridded Data Set              ║  │ 
│  ║ 4. Convert WAFS GRIB Data to PCGRIDDS32 Format        ║  │ 
│  ╚═══════════════════════════════════════════════════════╝  │ 
│  ║                 Ingest NWS GRIB Data                  ║  │ 
│  ║                                                       ║  │ 
│  ║ 5. Delete NWS GRIB Data                               ║  │ 
│  ║ 6. Interpolate GRIB to new Grid Projection            ║  │ 
│  ║ 7. Convert NWS GRIB Data to PCGRIDDS32 Format         ║  │ 
│  ║ 8. Convert MOS GRIB Data to PCGRIDDS32 Format         ║  │ 
│  ║ X. Return to Main Menu                                ║  │ 
│  ╚═══════════════════════════════════════════════════════╝  │ 
│  Your Choice? (1-8 or X to Return)                          │ 
└─────────────────────────────────────────────────────────────┘ 
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 Save GRIB Data 

Use the following optional steps to archive Final GRIB data files from previous forecasts, if 
desired, before you acquire new data: 

 
1. Type: 2 

Selects choice #2 (Save GRIB Data) from the ‘Ingest NWS GRIB Data’ menu. 
 

2. Type the directory where you want the GRIB data saved. 
You must specify the complete path of an empty directory.  Press [ESC] if you want to stop the 
copy process at this point. 

 
3. Press: [Enter] 

Begins the copy process. 
 

If the directory you specify does not exist, you are given an option to create the directory.  Press 
[Y] to create the directory or [N] to quit the copy process. 

 
If the directory you specify is not empty, you are given an option to delete all the files in the 
directory.  Press [Y] to delete the files or [N] to quit the copy process. 

 
If the default copy procedure does not meet the needs of your environment, your system 
administrator can modify the batch file C:\PCGRIDDS32\BATCH\SAVGRIB.BAT (refer to 
‘Customizing the NWS Ingest Process’). 

 
 

Delete existing GRIB data. 
Use the following optional steps to delete Final GRIB data files from previous forecasts, if desired, 
before you acquire new data: 

 
1. Type: 5 

Selects choice #5 (Delete Existing NWS GRIB Data). 
 

2. Type: Y 
Answers ‘yes’ when asked if you want to delete all the files in the GRIB\NWS directory.  Type N 
if you want to exit this process without deleting files. 

 
3. Press: [Enter] 

Clears the screen and returns to the ‘Ingest NWS GRIB Data’ menu. 
 
 
 Function #6 is reserved for future expansion. 
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Convert NWS GRIB data to PCGRIDDS32 format. 
 

1. Type: 7 
Selects choice #7 (Convert NWS GRIB data to PCGRIDDS32 Format).  Converts NWS GRIB 
data to PCGRIDDS32 format and places the data in the PCGRIDDS32\GRIDDATA directory.  
This procedure may require a significant amount of time if you are processing a large quantity of 
data.  Returns to the ‘Ingest NWS GRIB Data’ menu when the conversion process is completed.  
The data are now ready to be used in a PCGRIDDS32 session (refer to ‘Sample PCGRIDDS32 
Applications Session (NWS)’). 

 
2. Type: X 

Selects choice #X (Return to Main Menu).  Returns to the ‘PCGRIDDS32 Applications’ menu.  
You can now type 2 to begin a PCGRIDDS32 session and use the data set you created or you can 
type X to exit to Windows. 

 
 
 

Convert MOS GRIB data to PCGRIDDS32 format. 
 

1. Type: 8 
Selects choice #8 (Convert MOS GRIB data to PCGRIDDS32 Format).  Converts MOS GRIB 
data to PCGRIDDS32 format and places the data in the PCGRIDDS32\GRIDDATA directory.  
This procedure may require a significant amount of time if you are processing a large quantity of 
data.  Returns to the ‘Ingest NWS GRIB Data’ menu when the conversion process is completed.  
The data are now ready to be used in a PCGRIDDS32 session (refer to ‘Sample PCGRIDDS32 
Applications Session (NWS)’). 

 
2. Type: X 

Selects choice #X (Return to Main Menu).  Returns to the ‘PCGRIDDS32 Applications’ menu.  
You can now type 2 to begin a PCGRIDDS32 session and use the data set you created or you can 
type X to exit to Windows. 
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Using PCGRIDDS32 
 
This section provides background information on PCGRIDDS32, including detailed descriptions of how 
to use many options available when working in the Menu Mode.  It should be noted, there is no longer a 
WAFS version and NWS version of PCGRIDDS32 modes.  PCGRIDDS32 now processes and displays 
WAFS as well as NWS interchangeably.  Therefore, there is no need to switch back and forth as was 
the case in DOS PCGRIDDS. 
 
 
-- Modes of Operation 

PCGRIDDS32 has three modes of operation. 
 

Menu Mode  In Menu Mode you perform tasks such as displaying products, 
retrieving data, and modifying parameters by selecting choices from 
predefined options. 

 
Command Mode In Command Mode you display fields and the full variety of diagnostic 

calculations by entering PCGRIDDS32 commands directly from the 
keyboard. 

 
Automatic Mode In Automatic Mode you display fields and the full variety of diagnostic 

calculations by starting PCGRIDDS32, loading up to 20 data files and 
executing a single command macro from a batch file. 

 
During the execution of PCGRIDDS32, you can switch between the two operating modes.  To 
switch from Menu Mode to Command Mode, select the 'Command' entry from the main menu.  
To switch from Command Mode to Menu Mode, type MENU (or M) at the prompt. 
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PCGRIDDS32 Menu Mode 
 

The following discussions describe the operation of PCGRIDDS32 in Menu Mode. 
 

NOTE: The default operating mode for your PCGRIDDS32 system is controlled by the value of 
'PCGRIDDS32 startup mode' in the file C:\PCGRIDDS32\USER\PCGMODE.DAT.  When 
PCGRIDDS32 is installed, the default operating mode is 'Menu'.  You can set the default to either 
Menu Mode or Command Mode (refer to 'Customizing PCGRIDDS32' for more detailed 
instructions). 

 
 
-- Starting PCGRIDDS32 

Use the following steps to initiate a PCGRIDDS32 session in Menu Mode: 
 
  1. From the desktop, double-click the icon PCGRIDDS32 

The ‘PCGRIDDS32 Applications’ menu is displayed on the screen (Fig.1). 
 

3. Type: 2 
Selects choice #2 (Run PCGRIDDS32) from the Applications menu.  Displays the PCGRIDDS32 
logo and begins the session. 

 
 

Fig.1 
┌────────────────────────────────────────────────────────────┐ 
│  ╔══════════════════════════════════════════════════════╗  │ 
│  ║                PCGRIDDS32 Applications               ║  │ 
│  ║                                                      ║  │ 
│  ║  1. Ingest GRIB Data                                 ║  │ 
│  ║  2. Run PCGRIDDS32                                   ║  │ 
│  ║  X. Exit pcgridds32                                  ║  │ 
│  ║                                                      ║  │ 
│  ║ Version 3/2005                            MARCH 2005 ║  │ 
│  ╚══════════════════════════════════════════════════════╝  │ 
│  Your choice? (1-2 or X to exit)                           │ 
└────────────────────────────────────────────────────────────┘ 

 
 

When you enter PCGRIDDS32 you are automatically positioned to select a gridded forecast data 
file.  Move the mouse curser out of the way – the mouse is not used in PCGRIDDS32.  You must 
select a forecast file before you perform any other task within PCGRIDDS32. 
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-- Main Menu 
The main menu for PCGRIDDS32 is displayed horizontally on line 2 (top) of the screen (Fig.2). 

 
 

Fig.2 

 
 

This menu contains 6 options. 
 

File   Select, change, or list the contents of a forecast data file. 
 

Products  Display predefined PCGRIDDS32 products. 
 

Specs  Define the forecast hour and vertical level specifications. 
 

Display  Change to or define one of the following display modes:  Plan view, Cross-
section, Time-section. 

 
Command  Switch from Menu Mode to Command Mode to create customized products 

interactively. 
 

Exit   Exit PCGRIDDS32.  Files are closed.  Settings return to default. 
 
 
-- Function Keys 

A function key description line is displayed on the first line of the screen above the main menu.  
The function key line shows the function keys that are allowed for the current process, followed by 
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a one word description of their action.  The contents of this line changes depending on the current 
location within the menu system. 

 
When ONLINE HELP is available for a particular menu, the [F1] key is displayed at the beginning 
of the function key line (refer to ‘Online Help’). 

 
Note: The [F12] key is often labeled ‘Quit’ in the function key line.  This key allows you to 

quit the current process, but it does not let you inadvertently exit your PCGRIDDS32 
session.  The only way to exit your PCGRIDDS32 session is to select ‘Exit’ from the 
main menu. 

 
 
-- Grid Information 

A grid information line is displayed at the bottom of the screen.  This line shows the current 
settings that are used for data selection.  When you begin PCGRIDDS32, these values are set to 
the default values found in C:\PCGRIDDS32\USER\INITGRID.SPC (refer to 'Customizing 
PCGRIDDS32'). 

 
LEVEL Pressure level, Isentropic level or Height level 

 
LAYER A grid layer consisting of 2 levels; used for level differences, etc. 

 
FHR  Forecast hour 

 
FHRS Pair of forecast hours (Time range) used for time differences, etc. 

 
MODEL A 4 character forecast model identification name followed by the forecast model 

date 
 

m/#  Current display mode (m) and grid data-thinning factor (#).  The character 'm' can 
have one of three values:  P (Plan view), T (Time-section), X (Cross-section).  
The character # can have a power of two value: 1, 2, 4, 8, A(16), B(32), etc. 

 
 
-- Using Menus 
 

To move the highlight 
Use the arrow keys to move the highlight across or down the screen one position at a time.  
Use [HOME], [END], [PageUp], and [PageDown] to move the highlight to the top, bottom 
of the current screen or between screens. 

 
Note: Some menus require multiple screens for complete display.  Use the 

[PageDown] key to move from one screen to the next. Use the [PageUp] key to 
go back either to the beginning of the menu (‘Frst Page’) or to the previous page 
(‘Prev Page’).  The function key line indicates the action of the [PageUp] key. 

 
 

To exit a menu 
To exit a menu without making a selection and return to the previous menu, press [F12].  
The [F12] key can only be used to exit menus.  You cannot use it to exit PCGRIDDS32. 
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To make a selection 
For all menus, you can make a selection by moving the highlight to the desired choice and 
pressing [ENTER]. 

 
Some menus within PCGRIDDS32 have the first character of the menu text highlighted.  
This means that you can make a selection by typing the first character without pressing 
[Enter]. 

 
 

To move between menus 
You can go to the next menu by making a selection as described above.  You can return to 
the previous menu by pressing [F12]. 

 
The menu that appears when you make a selection from the main menu is called a primary 
menu.  At this point you can use the left/right arrow keys to move sequentially among the 
other primary menus without moving up to the main menu.  For example, if you are at the 
'Specs' menu, you can use the right arrow to move directly to the 'Display' menu. 

 
When you make a selection from a primary menu, either an action is processed or a 
secondary menu or form is displayed.   
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-- File Menu 
When you enter PCGRIDDS32, you are automatically positioned to select a gridded forecast data 
file from the menu shown in Fig.3.  You can return to this menu at any time by selecting 'File' 
followed by 'Select new forecast file'. 

 
 

Fig.3 

 
 
 

When you select 'File' from the main menu, a ‘pull-down’ menu (Fig.3) with the following choices 
is displayed. 

 
Select new forecast file 

Selects a new forecast data file from the list of files in the current gridded data 
directory. 

 
When you select this option, a list of available forecast data files is displayed on the 
screen.  To select a new forecast data file: 

 
1. Position the cursor to the desired file. 

By default the files are listed in alphabetical order by name. 
 

2. Press:  [Enter] 
Selects the file. A list of the gridded data available for the current forecast hour is 
displayed on the screen. 
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3. Press:  [F12] 
Erases the screen.  Returns to the ‘File’ menu. 

 
 
The current gridded data directory is specified in the file 
C:\PCGRIDDS32\USER\PCGMODE.DAT (refer to 'Customizing PCGRIDDS32').  The 
default value for this directory is C:\PCGRIDDS32\GRIDDATA. 

 
Selecting a new forecast data file must be the first action you perform in PCGRIDDS.  
No other actions (except exiting) are allowed until you select a file.  You can select 
only one file at a time.  Each file you select is added to the list of up to 20 files 
available for access by PCGRIDDS32.  However, you can use only one file at a time.  
The last file you select will be the active forecast data file unless you change it with 
choice #2 (Change forecast file). 
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Change forecast file 

Changes the active forecast data file to one of the files displayed in the list of 
previously selected forecast files (Fig.4).  Files are added to this list each time you 
select a new forecast file (choice #1).  Only one file may be active at a time.  Data for 
products are obtained from the active file. 

 
When you select this option, a list of previously selected forecast data files is displayed 
on the screen.  To change the active forecast data file: 

 
1. Position the cursor to the desired file. 

The currently active forecast data file is marked with an asterisk. 
 

2. Press:  [Enter] 
Makes the file active. A list of the gridded data available for the current forecast hour 
is displayed on the screen. 

 
3. Press:  [F12] 

Erases the screen.  Returns to the ‘File’ menu. 
 
 

Fig.4 
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List forecast file contents 

Lists the gridded data available in the active forecast data file at the currently selected 
forecast hour shown at the bottom of the screen (Fig.5). 

 
The information displayed at the beginning of the listing includes:  the filename 
(JUL030312.ETA211), the forecast model name (MODEL=ETA8), the model date 
(FROM 2002/04/28/00), the currently selected forecast hour (FHR=12), the level 
(LEVEL=250), the layer (LAYER=1000/ 500), and the time range (FHRS= 00/ 24) 

 
Data fields are identified by a 4 character description followed by a 4 character level.  
For example, TEMP 250 corresponds to the TEMPerature grid at 250 hPa and 
PRESTROP corresponds to the PRESsure grid at the TROPopause. 

 
 

Fig.5 

 
 
 
 
-- Specs Menu 

The 'Specs' option controls the setting of time and level specifications. 
 

Note: The time parameters should be set before the level parameters so that all of the levels 
available for the currently selected forecast hour are displayed when you select the 
vertical levels. 
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When you select 'Specs' from the main menu, a ‘pull-down’ menu (Fig.6) with the choices, 
‘Forecast hour’ and ‘Vertical level’, is displayed. 

 
Forecast hour 

When you choose this option, the current forecast hour and time range are displayed 
in a form (Fig.6) along with a list of the forecast times available in the currently active 
gridded data set. 

 
 

Fig.6 

 
 

You can modify the forecast time parameters by entering the integer times or selecting 
values from the list of available forecast hours (refer to ‘Using forms’ discussed later). 

 
To enter a value 

 
1. Position the cursor to the desired field (Forecast hour, Time range start or 

end). 
 

2. Type the number (refer to ‘Using forms’ discussed later). 
 

To select a value from the list 
 

1. Position the cursor to the desired field. 
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2. Press [F9] to activate the lookup menu. 
 

3. Move the highlight to the desired hour. 
 

4. Press [Enter] to select that hour. 
 

After you have completed all your revisions press [Enter] to save the values you have 
set. 

 
 

Vertical level 
With this option, the current level and layer values are displayed in a form (Fig.7) along 
with the list of levels which are available at the currently specified forecast time for the 
active gridded data set. 

 
 

Fig.7 

 
 

You can modify these parameters by entering values or selecting them from the list of 
levels displayed next to the form.  Since levels are listed only for the current forecast 
hour and may vary from one forecast time to another, you should select the time 
values (choice #1) before you select the levels. 
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To enter a value 
 

1. Position the cursor to the desired field (refer to ‘Using forms’ discussed 
next). 

 
2. Type the number. 

 
To select a value from the list 

 
1. Position the cursor to the desired field. 

 
2. Press [F9] to activate the lookup menu. 

 
3. Move the highlight to the desired level. 

 
4. Press [Enter] to select that level. 

 
After you have completed all your revisions press [Enter] to save the values you have 
set. 

 
 
-- Using Forms 

A form is a screen of text and areas, called fields, where you can enter information. 
 

To move the cursor 
You can use the arrow keys to move the cursor one character at a time within and between 
the individual form fields.  To move the cursor between fields use [Tab]. 

 
To clear fields 

To clear (remove the currently displayed values) all the fields within a form press [F5].  To 
clear a single field, move the cursor to that field and press [F6]. 

 
To enter data 

To enter data in a field, position the cursor to the field and type the value.  Blanks may not 
be entered in numeric fields.  To change the values in a field, use [F6] to clear the field and 
then type the new value.  An alternative method is to type over the old value using leading 
zeros to erase unwanted digits.  For example, to replace 4567 with 25, enter 0025. 

 
You must right justify values within a field.  PCGRIDDS32 will not perform that process 
automatically. 

 
To save changes 

You MUST press [Enter] to save the changes you set on the form.  If you press [F12] to exit 
a form, all the changes you made to the form are lost. 
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-- Display Menu 
The 'Display' option controls the setting and definition of the display mode.  When you select 
'Display' from the main menu, a ‘pull-down’ menu (Fig.8) appears on the screen with the following 
choices. 

 
Plan view 

Data are displayed over a horizontal area determined by a central latitude and 
longitude and a north/south distance in degrees. 

 
Cross-section 

Data are displayed at multiple pressure levels along a vertical cross-section path which 
is defined between a left latitude and longitude point and a right latitude and longitude 
point. 

 
Time-section 

The vertical structure of data is displayed for a specified time period and multiple 
pressure levels at a particular point which is defined by a latitude and longitude. 

 
 

Fig.8 
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Change the active display mode 
The active display mode is identified with an asterisk next to the appropriate menu choice.  
To change the active display mode, move the highlight to the desired mode and press [F2].  
The asterisk moves to the new display mode indicating that the change was performed. 

 
Note: A display mode must be defined before you can make it active. 
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Define The Plane View Mode 
After moving the highlight to the desired mode and pressing [Enter], the current latitude and 
longitude parameters that define the selected display mode are displayed in a form (Fig.9).  
You can use one of three methods to modify these parameters. 

 
To enter a value (Fig.9) 

 
1. Position the cursor to the desired field. 

Refer to ‘Using forms’ for a discussion of cursor movement. 
 

2. Type the value of the desired latitude or longitude in degrees. 
Degrees may be expressed as a positive integer value or as a positive real value with 
a maximum of two decimal places. 

 
3. When direction is required, type one of the following characters to indicate 

the appropriate hemisphere:  N, S, W, E. 
 

4. Press [Enter]. 
Saves the values you set. 

 
 

Fig.9 
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To select an entry from the lookup table (Fig.10) 

 
1. Press [F9]. 

Activates the lookup menu.  A list of display mode definitions is shown on the 
screen. 

 
2. Move the highlight to the desired definition. 

Remember the table may contain multiple pages. 
 

3. Press [Enter]. 
Selects the definition.  The parameters saved for the selected definition are entered 
into the form. 

 
4. Press [Enter]. 

Saves the values you set. 
 
 

Fig.10 
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To select an entry from the station id list (Fig.11) 

 
1. Press [F11]. 

Activates selection by station identifier (id).  A request for one or more station id's 
appears on the screen. 

 
2. Type a 3 or 4 character station id in the field. 

 
 

3. Press [Enter]. 
Retrieves the parameters for the station id and enters them into the form. 

 
4. When you are using the station id list to define a plan view, you must type 

in the N-S display distance manually if you want it changed from the current 
setting. 

 
5. Press [Enter]. 

Saves the values you set. 
 
 

Fig.11 
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For all three display modes, remember that you must press [Enter] to save the values you 
have set.  PCGRIDDS32 will define the new display mode and make it active.  After this 
process is completed, a map is displayed on the screen showing the current plan view 
definition.  The position of the cross-section line and the time-section point are indicated on 
the map if they are defined and lie within the map area. 

 
 
 

Define The Cross Section Mode  
After moving the highlight to the desired mode and pressing [Enter], the current latitude and 
longitude parameters that define the selected display mode are displayed in a form (Fig.12).  
You can use one of three methods to modify these parameters. 

 
To enter a value (Fig.12) 

 
1. Position the cursor to the desired field. 

Refer to ‘Using forms’ for a discussion of cursor movement. 
 

2. Type the value of the desired latitude or longitude in degrees. 
Degrees may be expressed as a positive integer value or as a positive real value with 
a maximum of two decimal places. 

 
3. When direction is required, type one of the following characters to indicate 

the appropriate hemisphere:  N, S, W, E. 
 
4.      Enter ‘U’ to display the Preset pressure levels listed the INITGRID.SPC file 

or enter ‘A’ to display all pressure levels in the current data file or enter ‘I’ to 
calculate data on Isentropic levels or enter ‘H’ to calculate data on height 
levels in feet or meters or enter ‘X’ to use a user defined file which is 
entered next. 

 
5.      Enter the 4-letter file name which contains the user defined pressure levels. 

 
6. Press [Enter]. 

Saves the values you set. 
 

 
 46



 
Fig.12 

 
 
 
 
 
 
To select an entry from the lookup table (Fig.13) 

 
1. Press [F9]. 

Activates the lookup menu.  A list of display mode definitions is shown on the 
screen. 

 
2. Move the highlight to the desired definition. 

Remember the table may contain multiple pages. 
 

3. Press [Enter]. 
Selects the definition.  The parameters saved for the selected definition are entered 
into the form. 

 
4. Press [Enter]. 

Saves the values you set. 
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Fig.13 

 
 
 
 

 
To select an entry from the station id list (Fig.14) 

 
1. Press [F11]. 

Activates selection by station identifier (id).  A request for one or more station id's 
appears on the screen. 

 
2. Type a 3 or 4 character station id in the field. 

If there is a second field, position the cursor to the next field using the [Tab] key and 
type a second station id. 

 
3. Press [Enter]. 

Retrieves the parameters for the station id and enters them into the form. 
 

4. Press [Enter]. 
Saves the values you set. 

 
 

 
 48



Fig.14 

 
 
 

Note: You can define cross-section lines and time-section points that fall outside the 
plan view display area but within the area covered by the currently active gridded 
data set.  However, they are not displayed on the plan view map. 

 
If both ends of the cross-section line or the time-section point fall outside the area 
covered by the currently active gridded data set, then the definition points for that 
display mode are canceled and you are returned to the plan view display mode. 
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Define The Time Section Mode  
After moving the highlight to the desired mode and pressing [Enter], the current latitude and 
longitude parameters that define the selected display mode are displayed in a form (Fig.15).  
You can use one of three methods to modify these parameters. 

 
To enter a value (Fig.15) 

 
1. Position the cursor to the desired field. 

Refer to ‘Using forms’ for a discussion of cursor movement. 
 

2. Type the value of the desired latitude or longitude in degrees. 
Degrees may be expressed as a positive integer value or as a positive real value with 
a maximum of two decimal places. 

 
3. When direction is required, type one of the following characters to indicate 

the appropriate hemisphere:  N, S, W, E. 
 

4.      Enter ‘U’ to display the Preset pressure levels listed the INITGRID.SPC file 
or enter ‘A’ to display all pressure levels in the current data file or enter ‘I’ to 
calculate data on Isentropic levels or enter ‘H’ to calculate data on height 
levels in feet or meters or enter ‘X’ to use a user defined file which is 
entered next. 

 
5.      Enter the 4-letter file name which contains the user defined pressure levels. 

 
6.      Enter ‘U’ to display the Preset forecast hours listed the INITGRID.SPC file 

or enter ‘A’ to display all forecast hours in the current data file or enter ‘X’ to 
use a user defined file which is entered next. 

 
7.      Enter the 4-letter file name which contains the user defined forecast hours. 

 
8. Press [Enter]. 

Saves the values you set. 
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Fig.15 

 
 
 
 
 
 
To select an entry from the lookup table (Fig.16) 

 
1. Press [F9]. 

Activates the lookup menu.  A list of display mode definitions is shown on the 
screen. 

 
2. Move the highlight to the desired definition. 

Remember the table may contain multiple pages. 
 

3. Press [Enter]. 
Selects the definition.  The parameters saved for the selected definition are entered 
into the form. 

 
4. Press [Enter]. 

Saves the values you set. 
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Fig.16 

 
 
 
 

 
To select an entry from the station id list (Fig.17) 

 
1. Press [F11]. 

Activates selection by station identifier (id).  A request for one or more station id's 
appears on the screen. 

 
2. Type a 3 or 4 character station id in the field. 

 
 

3. Press [Enter]. 
Retrieves the parameters for the station id and enters them into the form. 

 
4. Press [Enter]. 

Saves the values you set. 
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Fig.17 

 
 
 

Note: You can define cross-section lines and time-section points that fall outside the 
plan view display area but within the area covered by the currently active gridded 
data set.  However, they are not displayed on the plan view map. 

 
If both ends of the cross-section line or the time-section point fall outside the area 
covered by the currently active gridded data set, then the definition points for that 
display mode are canceled and you are returned to the plan view display mode. 

 
 

Change Display Lookup Tables 
One method of defining a display mode is to select an entry from the lookup table 
(described earlier).  You can customize the display lookup table to meet the needs of 
your environment. 

 
Saving new definitions 

 
1. Fill in the form fields with latitude and longitude values that define the 

desired location or area. 
It is not necessary to have PCGRIDDS32 process these values. 

 
2. Press [F10] 

Activate and display the lookup menu. 
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3. Press [F8] 
This is the function key labeled 'Insert'.  A prompt requesting you to enter a lookup 
identifier is displayed on the screen. 

 
4. Type a descriptive lookup identifier in the field. 

A helpful convention is to identify large areas with names alone and differentiate 
progressively smaller areas by enclosing the names in parentheses, brackets, and 
braces (curly brackets). 

 
5. Press [Enter] 

Record the lookup identifier in the table.  The new identifier is placed in the table in 
alphabetical order. 

 
6. Press [F12] 

Repeat the process for a new lookup table entry or perform another task. 
 
 

Deleting existing definitions 
 

1. Press [F10] 
Activate and display the lookup menu. 

2. Position the highlight to the definition you want to delete. 
 

3. Press [F7] 
This is the function key labeled 'Delete'.  The selected definition is deleted from the 
lookup table. 

 
4. Repeat steps 2-3 until you have removed all the unwanted definitions. 

 
5. Press [F12] 

Exit the lookup menu. 
 

Save a display map 
To increase the efficiency of PCGRIDDS32, your system administrator can use the 
SVMP command to SaVe frequently used display MaPs.  This command also allows 
you to print a list of currently saved display maps and to delete a saved display map. 

 
1. Select the plan view display. 

This procedure is described in the previous sections. 
 

2. Select ‘Command’ from the main menu. 
Switch to Command Mode. 

 
3. At the prompt type: SVMP 

A list of the currently saved maps is displayed on the screen. 
 

4. You can now perform one of the following operations. 
 

a. Save the currently defined display map. 
Press [F8] 

This is the function key labeled ‘Insert’. 
 

b. Print a list of the currently saved display maps. 
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Press [F3] 
This is the function key labeled ‘PRNT’. 

 
c. Delete a saved display map. 

Position the highlight to the entry you want to delete. 
 

Press [F7] 
This is the function key labeled ‘Delete’. 

 
5. Press [ESC] 

Quit SVMP. 
 

6. Type: MENU 
Return to Menu Mode. 

 
When you enter SVMP, the following information describing saved display maps is 
listed on the screen: 

 
1. File Id   The three digit identification number of the saved 

display map.  The file id is the extension of the saved 
map display filename and is used internally by 
PCGRIDDS32. 

 
2. Map area definition Center latitude, center longitude, N/S distance.  

These values are determined when you define the 
display mode. 

 
3. Projection   The map projection used in the gridded data set 

when the display map was saved.  The values for this 
field are ‘LTLN’ (latitude longitude), ‘NPST’ (north 
polar stereographic), ‘MERC’ (mercator), and ‘NLCC’ 
(north Lambert conic conformal). 

 
4. Reference longitude The ‘vertical’ reference longitude used for polar 

stereographic and Lambert conic conformal 
projections. 

 
5. Map base   The name of the map base file that contains the map 

line segments in latitude/longitude coordinates. 
 

PCGRIDDS32 automatically checks the list of saved maps each time a display map is 
changed.  It determines if it can use a saved display map by comparing items 2-5 for 
the saved display map with the description of the currently active gridded data set.  If 
all of these items match, the saved display map is used. 
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-- Product Menus 

This option controls the display of PCGRIDDS32 products.  A product is a display generated by 
executing a series of PCGRIDDS32 commands contained in a macro file (refer to 'Defining 
Products').  When you select this option, the 'Product Category' menu is displayed (Fig.18).  
When you select a choice from the 'Product Category' menu, the corresponding 'Product List' 
menu is displayed (Fig.19). 

 
Product Category 

This menu displays a list of product categories that are available in your version of 
PCGRIDDS32 and is similar to the ‘Table of Contents’ of a book.  Each category contains a 
group of related products that belong to it.  Both the product categories and the actual 
products in each category can be modified by your system administrator to meet the needs 
of your environment (refer to 'Defining Products'). 

 
 

Fig.18 

 
 

To select a product category with the highlight 
Position the highlight to the desired choice and press [Enter].  After a category is 
selected, a list of products available in that category is displayed. 

 
To select a product category by letter 

You may select a category shown on the current page by typing the letter of that 
category.  To view additional choices on succeeding pages press [PageDown].  After 
a category is selected, a list of products available under that category is displayed. 
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Note that each line of the menu begins with a label (A.1, B.1, etc.).  The letter is used 
to indicate the sequence of the line on the current page and the number is the current 
menu page number.  For example, C.1 refers to line 3 on the first page of the menu. 

 
Multiple menu pages 

Some product menus require multiple screens for complete display.  You can press 
[PageDown] to move forward from one screen to the next.  You cannot page 
backwards through the menu.  However, by pressing [PageUp], you can reposition to 
the start of the menu. 

 
To switch to Command Mode 

If you wish to switch directly to Command Mode , press [F9].  To return to Menu Mode, 
type MENU at the prompt. 

 
Interactive work menu 

This is a special menu which can be used to display a series of customized products 
for lectures, briefings and discussions.  You can change this menu interactively by 
selecting entries from the various ‘Product List’ menus. Once you create an interactive 
work menu, the contents are saved until you change them.  Refer to the ‘Product List’ 
section for a description of the procedure used to create an interactive work menu. 

 
Before you create or modify the interactive work menu for the first time, your system 
administrator should check both of the following items. 

 
1. You must make an entry in the file MACROS\CMDMENU.LST for the 

interactive work menu.  The default entry, ’Custom Interactive Briefing’ is 
located at line 17 of CMDMENU.LST.  However, you may change the text 
and location to meet your needs. 

 
2. The name of the file that holds the interactive work menu entries must be 

entered on line 16 (Entry 16) of USER\PCGMODE.DAT.  The file name has 
the form CMDMENU.### where ### is the line number of the interactive 
work menu entry in CMDMENU.LST.  For example, if the interactive work 
menu is located on line 17 of CMDMENU.LST, the name of the interactive 
work menu file is CMDMENU.017. 
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Product List 

The ‘Product List’ menu contains a description of the products that are available for the 
product category you selected.  The name of the product category you chose from the 
‘Product Category’ menu is shown at the top of the menu.  When you select a product, the 
results are displayed on the screen. 

 
 

Fig.19 

 
 

Selections from the ‘Product List’ menu are made using the same procedures as for the 
‘Product Category’ menu. 

 
To select a product with the highlight 

Position the highlight to the desired choice and press [Enter]. 
 

To select a product by letter 
Each line of the menu begins with a label (A.1, B.1, etc.) where the letter indicates the 
sequence of the line on the current page and the number shows the current menu 
page number.  For example, C.1 refers to line 3 on the first page of the menu.  You 
may select a product on the current page by typing the letter of that product. 
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Multiple menu pages 
Some product menus use multiple screens to display the complete list of product 
options.  You can press [PageDown] to move forward from one screen to the next.  
You cannot page backwards through the menu.  However, by pressing [PageUp], you 
can reposition to the start of the menu. 

 
Product overlays 

Two or more product displays can be overlaid using the [F2] key (Overlay).  After the 
display of the first product is completed, position the highlight to the product you wish 
to overlay using the up/down arrow keys and press [F2]. 

 
Note: When using overlays you cannot use the first letter selection method.  You 

may overlay products only when the Print Option is 'No print' (N) or 
'Immediate print' (I) as described later. 

 
 

Stepping through product displays for successive times 
Special characters are provided which allow you to step through displays of products 
at sequentially increasing or decreasing forecast hours. 

 
[>] Displays the current product at the next time. 
[<] Displays the current product at the previous time. 
[^] Redisplays the current product at the current forecast hour. 

 
The forecast hours selected by the time looping characters depend on the ‘Initial time-
looping values’ set in the file C:\PCGRIDDS32\USER\PCGMODE.DAT.  The 
beginning and ending forecast hours define the range for the looping while the hour 
increment determines the interval between the selected forecast hours. 

 
 
 
 

Example: The beginning and ending forecast hours are set to 12 and 24 with an 
increment of 6.  The currently selected product is displayed at forecast hour 
18.  The table below shows the sequence of keys pressed and the forecast 
hour at which the product is displayed. 

 
 

Key sequence 
 
Forecast hour 

 
[^] 

 
18 

 
[<] 

 
12 

 
[>] 

 
18 

 
[>] 

 
24 

 
[>] 

 
12 

 
[^] 

 
12 
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The initial reference time is the forecast hour at which the current product 
was first selected (18).  Pressing [^] redisplays the product at the selected 
time.  The remaining times are incremented or decremented by the value 
set for the time looping increment.  If the time is incremented past the 
ending forecast hour, then the time is reset to the beginning forecast hour 
for time looping.  Likewise, if the time is decremented past the beginning 
forecast hour, then the time is reset to the ending forecast hour.  Each time 
[<] or [>] is pressed, the current forecast hour is reset as indicated in the 
grid information line at the bottom of the screen. 

 
To obtain product help 

Detailed descriptions of many of the products can also be accessed.  You can display 
HELP for an individual product, if it is available, by positioning the highlight to the 
product  and pressing [F1].  No general HELP is available for the 'Product List' menu. 

 
Switch to Command Mode 

You can switch directly to Command Mode at any time, by pressing [F9].  Once in 
Command Mode, you can return to Menu Mode by typing MENU at the prompt. 

 
Print Options 
 The command to print the screen is PRNT.   

 
-- Command Mode Option 

This option allows you to switch from Menu Mode to Command Mode.  You are still within the 
PCGRIDDS32 system and all your settings are intact.  Four character PCGRIDDS32 commands 
must be entered to start and control all processes (refer to Appendix C).  Using this mode allows 
the greatest flexibility, but also requires the greatest understanding of PCGRIDDS32.  Enter 
MENU at the prompt to return to Menu Mode. 

 
 
 
 
 
-- Quick Access to PCGRIDDS32 

After your data are converted from GRIB into PCGRIDDS32 format (refer to ‘Ingesting GRIB 
Data’) and your system is configured to run PCGRIDDS32, you can bypass the PCGRIDDS32 
Applications menu and access PCGRIDDS32 directly. 

 
1. Change directory to \PCGRIDDS32 

Changes to the PCGRIDDS32 directory. 
 

2. Double click on the file PCG32.BAT or Type: PCG32 at the command prompt. 
The PCGRIDDS32 logo is displayed on the screen. 
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Defining Products 
 
A product is a display produced by executing a sequence of PCGRIDDS32 commands that are stored 
in an ASCII formatted file.  These files which are called macros or command files are placed in the 
MACROS directory.  Macro filenames are composed of a 4 character macro name followed by the 
extension CMD (for example, DWPD.CMD).  You can execute a macro from both Command Mode and 
Menu Mode. 
 
-- Command Mode execution 
 

To execute macros 
To execute a macro from Command Mode enter the name of the macro followed by [.]. 

 
DWPD. 

 
The above entry erases the screen and produces a display of DeW Point Depression. 

 
To overlay macros 

A macro can be overlayed on the display produced by a previous command or macro.  To 
overlay a macro enter the name of the macro followed by [:] (colon key). 

 
TEMP 
DWPD: 

 
The above sequence of commands erases the screen, displays TEMPerature, and overlays 
temperature with DeW Point Depression. 

 
Frequently used macro 

The name !!!!.CMD is reserved for a frequently used macro.  This file is created by copying 
an existing macro or using a text editor to enter a set of frequently used PCGRIDDS32 
commands.  To execute this macro from Command Mode press [.] (period key). 

 
 
-- Menu Mode execution 
 

To display products 
A product is generated by executing a series of PCGRIDDS32 commands contained in a 
macro  file.  The results are displayed on the screen. 

 
1. Select 'Products' from the main menu. 

The 'Product Category' menu appears which shows you a list of product categories that are 
available. 

 
2. To select a category, position the highlight to the desired choice and press [Enter] or 

type the letter of the category. 
After a category is selected, the 'Product List' menu appears which shows you the first page of a 
list of products available under the selected category. 
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3. Select a specific product in the same manner as a category. 
The 4 letters that appear to the left of the product description are the name of the macro which is 
executed to create the desired product. 

 
To overlay two or more products 

 
1. Select the first product. 

 
2. When the display of the first product  is complete, position the highlight to the product 

you wish to overlay and press [F2]. 
 

Note: You CANNOT use the first letter selection method when you overlay.  You may 
overlay products only when the 'Print Option' is 'No print' (N) or 'Immediate print' 
(I).  You cannot overlay when the 'Print Option' is 'Save print' (S) or 'Delay print' 
(D).  Refer to 'Printing' for a description of print options. 

 
Default products 

PCGRIDDS32 is delivered with a default set of menus and products.  You are encouraged 
to develop additional products to meet the needs of your environment.  The command lines 
required to display a product must be stored in a macro file.  You must then add to and/or 
modify the menu system before you can display new products in Menu Mode.  Remember to 
include the associated HELP files.  These procedures are discussed in the following 
sections. 

 
 
-- Overlay data from different files 

Overlaying is the term used to refer to the simultaneous display of multiple data fields.  Data from 
different files can be overlaid on the same plot providing the following conditions are met: 

 
1. The data must be on the same grid projection, though not necessarily from the same model. 
2. The initial and final grid points used in any data subsetting must be the same.  This means 

that the areas selected during the ingest process must be identical. 
 

If the above conditions are not met, a message is displayed indicating that the files are of a 
different size or type.  If this condition occurs when a file is opened, the current plot is cleared 
from the screen and the available fields for the current forecast hour are displayed. 

 
 
-- Product directories 

The product menus and the macro files used by PCGRIDDS32 are stored in the product directory  
PCGRIDDS32\MACROS.  The MACROS directory is the active directory from which 
PCGRIDDS32 references files.   

 
-- Product menus 

The product menus are stored in ASCII formatted files which are located in the 
C:\PCGRIDDS32\MACROS directory and may be modified by your system administrator.  The 
'Product Category' menu is similar to the ‘Table of Contents’ in a book.  It provides a list of product 
categories.  When you select an entry from the 'Product Category' menu, a list of the available 
products in that category is displayed ('Product List' menu). 
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Product Category file 
Name The entries for the 'Product Category' menu are stored in the file, 

CMDMENU.LST. 
 

Format This file can be modified using a standard text editor.  Each line in the file defines 
a specific product category.  A maximum of 72 characters can be entered on a 
line.  The lines are displayed sequentially in groups of 18 lines per screen.  The 
file can contain a maximum of 10 screens of data (180 categories). 

 
PCGRIDDS automatically ‘numbers’ the order of appearance for each entry on 
the menu page.  All other characters displayed for the entry lines must be 
contained in the menu file.  All lines in the menu must contain text.  If you wish to 
leave an empty line for clarity, add dashes as shown in the example below.  
Supply a dummy ‘Product List’ file that contains a line of blanks.  For the example 
below, the file CMDMENU.012 is a dummy file (refer to Appendix A). 

 
The file contents for the first screen of the default 'Product Category' menu are listed below.  
A complete listing is contained in Appendix A. 

 
............... Begin file CMDMENU.LST ............................ 

BASIC  PCGRIDDS  SETUP 
SURFACE MAPS 
UPPER AIR MAPS 
STABILITY INDICIES AND MISC. 
PLOT PREDEFINED MAPS FOR SELECTED TIME AND LEVEL 
EXPERIMENTAL QPF MAPS 
CHOOSE NEW MAP FOR DISPLAYS 
OVERVIEW OF ENTIRE FORECAST CYCLE 
DETAILED OVERVIEW OF A SINGLE TIME 
 
BUILD YOUR OWN MAPS 
CUSTOM INTERACTIVE BRIEFING 
BOUNDARY LAYER PRODUCTS                               (RH, wind, etc...) 
"ANY LEVEL" PRODUCTS    (ie. choose level you want)   (RH, wind, etc...) 
LAYER PRODUCTS         (Q vectors, Potential Vorticity, Mean RH, etc...) 
RAIN/SNOW PRODUCTS      (Critical Thickness, Estimated Snowfall, etc...) 
ISENTROPIC PRODUCTS       (Isentropic Lift, Potential Vorticity, etc...) 
CONVECTIVE/SEVERE WEATHER     (CAPE, Estimated Storm Motion, LI, etc...) 
HEAVY PRECIPITATION PRODUCTS                (Precipitable Water, etc...) 
WINTER TYPE PRECIPITATION - MENU 1          [MUST SPECIFY VALID FX HOUR] 
WINTER TYPE PRECIPITATION - MENU 2          [MUST SPECIFY VALID FX HOUR] 
WINTER TYPE PRECIPITATION - MENU 3          [MUST SPECIFY VALID FX HOUR] 
SEVERE CONVECTION - MENU 1                  [MUST SPECIFY VALID FX HOUR] 
SEVERE CONVECTION - MENU 2                  [MUST SPECIFY VALID FX HOUR] 
SEVERE CONVECTION - MENU 3                  [MUST SPECIFY VALID FX HOUR] 
SEVERE CONVECTION - MENU 4                  [MUST SPECIFY VALID FX HOUR] 
QPF - MENU 1                                [MUST SPECIFY VALID FX HOUR] 
QPF - MENU 2                                [MUST SPECIFY VALID FX HOUR] 
MAPS SURFACE ANALYSIS                       [MUST SPECIFY VALID FX HOUR] 
---- 
WAFS - Display ICAO Upper-Air MAPS 
Set WAFS Map Display Areas 
WAFS - WIND/TEMPERATURE  Charts for Americas 
---- 
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............... End page CMDMENU.LST ................................. 
 
 

Product List file 
 

Name All the files for the ‘Product List’ menus have the name CMDMENU.  The line 
number of the entry in the 'Product Category' file (CMDMENU.LST) determines 
the extension of the file (CMDMENU.###) that provides the information for the 
corresponding 'Product List' menu.  For example, if you select the entry  
‘SURFACE MAPS' which is on line 1 of the 'Product Category' file, the product 
list contained in the file, CMDMENU.001, is displayed. 

 
Format This file can be modified using a standard text editor.  Each line in the file 

describes a specific product. The lines are displayed sequentially in groups of 17 
lines per screen.  The file can contain a maximum of 10 screens of data (170 
products). 

 
A maximum of 72 characters can be entered on a line.  The first 4 characters of 
each line in a 'Product List' file must be the name of the macro file that 
corresponds to the selected entry.  For example, if you select the entry, ‘Mean 
Sea-level Pressure and 1000-500mb Thickness' from CMDMENU.001 (listed 
below), the macro file, SFTH.CMD, is executed. 

 
PCGRIDDS32 automatically ‘numbers’ the order of appearance for each entry on 
the menu page.  All other characters displayed for the entry lines must be 
contained in the menu file.  In the example below, some entries are left blank for 
clarity.  If the user selects a blank entry, PCGRIDDS32 will beep and return to 
the menu. 

 
The contents for the first screen of the default ‘Product List’ file, CMDMENU.001, are listed 
below.  Complete listings of all the default ‘Product List’ files are contained in Appendix A. 

 
............. Begin file CMDMENU.002 ................................ 

                    *****  SURFACE MAPS *****    
SFTH Mean Sea-level Pressure and 1000-500mb Thickness   (Set TIME first) 
10TH 1000 mb Height and Winds, 1000-500mb Thickness     (Set TIME first) 
10TD 1000 mb Height, Dew Point and Wind                 (Set TIME first) 
10TE 1000 mb Height, Equiv. Pot. Temp., and  Winds      (Set TIME first) 
NSTM NGM MSL Pressure, S982 Temperatures and Winds      (Set TIME first) 
NSTD NGM MSL Pressure, S982 Dew Points and Winds        (Set TIME first) 
NSTE NGM MSL Pressure, S982 Equiv. Pot. Temp. and Winds (Set TIME first) 
ESTM ETA MSL Pressure, B015 Temperature and Winds       (Set TIME first) 
ESTD ETA MSL Pressure  B015 Dew Points and Winds        (Set TIME first) 
ESTE ETA MSL Pressure, B015 Equiv. Pot. Temp. and Winds (Set TIME first) 
THPW MSL Pressure, 1000-500mb Thickness, Precip. Water  (Set TIME first) 
PCPP 12 hour Total and Convective Model Precipitation   (Set TIME first) 
P24L Loop 24 Hour Precipitation Totals for Model cycle(Reset TIME after) 
          
SFIL Change Active File           (Must have multiple files open) 
SFHR ** Set TIME  ** (Forecast Hour: F00,F12,F24,F36,F48,...) 

.............. End page CMDMENU.002 .................................. 
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-- MACRO files 

MACRO files contain a sequence of PCGRIDDS32 command lines that are executed in series 
and can be used as shorthand notations for frequently used command sequences or to produce 
specific graphical products.  The command lines may contain a maximum of 16 PCGRIDDS32 
commands and aliases in upper or lower case letters (refer to 'User Defined Alias Commands'), 
but they cannot reference another macro. 

 
Note: The commands within a command line are processed from right to left.  Refer to the 

files HELP.DAT, HLPC.DAT, and HLPG.DAT in the HELP directory (or Appendices B, 
C, and D) for a more detailed description of the full set of PCGRIDDS32 commands. 

 
The following parameters can be set from within a macro:  forecast hour, time range, vertical 
level, and layer.  If the macro is run from Command Mode, these settings will remain in effect after 
the completion of the macro.  If the macro is run from Menu Mode, the settings normally remain in 
effect only for the duration of the macro.  At the end of the macro, the settings return to the values 
they had before the macro was started.  If you want the settings defined in a macro to remain in 
effect after the completion of the macro, you must add the PMSV command to the beginning of 
the macro. 

 
When a macro is executed, the results from processing the requested command lines are 
displayed in sequence with a prompt to press [Enter] between displays when needed.  Below is 
listed a sample macro file which requires you to press [Enter] after each command line.  This 
sample file sets the display to PLAN view, requests the user to press [Enter], then reads the 
WIND data, converts the Vector wind to KNoTs (VKNT), and plots the resulting vectors as wind 
BARBs. 

 
PLAN 
BARB VKNT WIND 

 
If you want to eliminate the prompt to press [Enter] after each command line, use the LOOP and 
ENDL (END Loop) commands.  All command lines between these commands are then executed 
without a request to press [Enter].  The command file listed below only pauses for you to press 
[Enter] after the ENDL command. 

 
LOOP 
PLAN 
BARB VKNT WIND 
ENDL 

 
Listed below is an example of a macro file (WTMP.CMD) that displays wind as barbs and 
temperature contours as dashed lines.  An explanation is included after every line to describe the 
action of each command in the line. 

 
Note: Within a macro, either an & or a / can be used to indicate that two sets of data will be 

overlaid on the same display. 
 

LOOP 
-- LOOP The prompt to press [Enter] is suppressed until the ENDL command 

is executed or the end of file is encountered. 
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PLAN 
-- PLAN Set screen to PLAN view  

 
LNDF 

-- LNDF Do Not print DeFault Labels  
 

LTX1 WIND / TEMPERATURE Contours 
-- LTX1 Display the Label TeXt following this command on line 1 of the plot. 

 
LTM1 LLN1 

-- LLN1 Display the Label, forecast LeNgth, on line 1 of the plot. 
-- LTM1 Display the Label, TiMe, on line 1 of the plot. 
-- The label on line 1 has the order:  text, forecast length, time. 

 
LFD2 LFL2 

-- LFL2 Display the Label, Flight Level, on line 2 of the plot. 
-- LFD2 Display the Label, Forecast model Date, on line 2 of the plot 
-- The label on line 2 has the order:  level, date. 

 
LMN3 LFO3 

-- LFO3 Display the Label, Forecast model Origination, on line 3 of the plot. 
-- LMN3 Display the Label, forecast Model Name, on line 3 of the plot. 
-- The label on line 3 has the order:  origination, name. 

 
CLR2 DASH CIN2 TEMP&CLR7 BARB VKNT WIND 

-- WIND Get the WIND field from the gridded data file. 
-- VKNT Convert units for Vector wind data to KNoTs. 
-- BARB Plot wind as BARBs. 
-- CLR7 Use data-display CoLoR 7 for the barbs. 
-- &  End plot 1 and prepare to overlay next plot. 
-- TEMP Get the TEMPerature field from the gridded data file. 
-- CIN2 Set Contour INterval to 2 units (degrees) 
-- DASH Use DASHed lines for contours. 
-- CLR2 Use data-display CoLRr 2 for the contour lines. 

 
ENDL 

-- ENDL Reinstate the need to press [Enter] after each command line.  This 
command is optional if it is the last command in the macro. 

 
 

Listed below is an example of a macro file (IC24.CMD) that sets the flight level to 240, displays 
wind as barbs and displays temperature values at the grid points.  An explanation is included after 
every line to describe the action of each command in the line. 

 
LOOP 

-- LOOP The prompt to press [Enter] is suppressed until the ENDL command 
is executed or the of file is encountered. 

 
PLAN 

-- PLAN Set screen to PLAN view  
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LNDF 
-- LNDF Do Not print DeFault Labels  

 
LTX1 WIND / TEMPERATURE 

-- LTX1 Display the Label TeXt following this command on line 1 of the plot. 
 

LTM1 LLN1 
-- LLN1 Display the Label, forecast LeNgth, on line 1 of the plot. 
-- LTM1 Display the Label, TiMe, on line 1 of the plot. 
-- The label on line 1 has the order:  text, forecast length, time. 

 
LFD2 LFL2 

-- LFL2 Display the Label, Flight Level, on line 2 of the plot. 
-- LFD2 Display the Label, Forecast model Date, on line 2 of the plot 
-- The label on line 2 has the order:  level, date. 

 
LMN3 LFO3 

-- LFO3 Display the Label, Forecast model Origination, on line 3 of the plot. 
-- LMN3 Display the Label, forecast Model Name, on line 3 of the plot. 
-- The label on line 3 has the order:  origination, name. 

 
CLR7 BARB VKNT WIND SLVL 400 

-- SLVL 400 Set the pressure LeVeL to 400 hPa 
-- WIND Get WIND data from the gridded data file. 
-- VKNT Convert units for Vector wind data to KNoTs. 
-- BARB Plot wind as BARBs. 
-- CLR7 Use data-display CoLoR 7 for the barbs. 

 
PPLS DAT+ SCL0 SSUM TEMP RGTN 0 MLTN 0 VCMP LAST CLR2& 

-- This command line overlays temperature data plots on the previous wind display.  
Temperature values are expressed as unscaled whole integers and unsigned 
values are negative.  The digits are plotted above the grid point, but only at grid 
points where the V component of the wind is positive (‘southerly’) to prevent the 
wind barbs from overwriting the temperature data. 

-- &  Overlay the following plot on current display. 
-- CLR2 Use data-display CoLoR 2. 
-- LAST Retrieve the previous fields (WIND) already stored in memory. This 

operation is faster than retrieving data from the gridded data file. 
-- VCMP Get the V CoMPonent of the wind field that is stored in memory. 
-- MLTN 0 Set all values Less ThaN 0 as missing data (10**31). 
-- RGTN 0 Replace all values Greater ThaN 0 with 0.  This produces a field of 

zeros and missing values. 
-- TEMP Get the TEMPerature field from the gridded data file. 
-- SSUM SUM the previous two Scalar fields.  This produces a field of 

temperature values and missing values.  The missing values are 
located at grid points where the V component of the wind is less than 
0. 

-- SCL0 Rounds displays to whole integer numbers. 
-- DAT+ Plot DATa values above (+) the grid point. 
-- PPLS Plot PLuS signs.  Unsigned numbers are negative.  Plus signs are 

plotted before positive numbers. 
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PPLS DAT- SCL0 SSUM TEMP RLTN 0 MGTN 0 VGRD CLR2& 
-- This command line overlays the remaining temperature data on the previous 

display.  Temperature values are expressed as unscaled whole integers and 
unsigned values are negative.  The digits are plotted below the grid point, but 
only at grid points where the V component of the wind is negative (‘northerly’) to 
prevent the wind barbs from overwriting the temperature data. 

-- &  Overlay the following plot on current display. 
-- CLR2 Use data-display CoLoR 2. 
-- VGRD Retrieve the the V component of the wind from the GRiDded data file.  

The wind field is no longer available in memory as it was in the 
previous command line. 

-- MGTN 0 Replace all values Greater ThaN 0 as missing data points. 
-- RLTN 0 Replace all values Less ThaN 0 with 0.  This produces a field of zeros 

and missing values. 
-- TEMP Get the TEMPerature field from the gridded data file. 
-- SSUM SUM the previous two Scalar fields.  This produces a field of 

temperature values and missing values.  The missing values are 
located at grid points where the V component of the wind is greater 
than 0. 

-- SCL0 Rounds displays to whole integer numbers. 
-- DAT- Plot DATa values below (-) the grid point. 
-- PPLS Plot PLuS signs.  Unsigned numbers are negative.  Plus signs are 

plotted before positive numbers. 
 

ENDL 
-- ENDL Reinstate the need to press [Enter] after each command line.  This 

command is optional if it is the last command in the macro. 
 
 
-- Macro Help 

PCGRIDDS has a provision for providing HELP about individual macros in both Menu Mode and 
Command Mode. 

 
To access HELP for a particular macro in Menu Mode, display the 'Product List' menu that 
contains an entry for the macro (refer to ‘Menu Mode Execution’).  Position the highlight to the 
desired menu and press [F1].  The contents of the HELP file is displayed on the screen. 

 
You can use one of two methods to access macro HELP in Command Mode.  Access the HELP 
menu by typing HELP[Enter] on the command line.  After the menu is displayed, type the four 
character macro name to display the HELP text.  To obtain EXTENDED HELP directly from the 
command line, type HLPX followed by the four character macro name. 

 
Macro HELP files are located in the HELP directory.  The filename is composed of the 4 character 
macro name followed by the extension, HLP.  For example, DWPD.HLP is the HELP filename for 
the macro, DWPD.CMD.  Refer to 'Menu Help File Format' in the 'Online Help' section for a 
description of the HELP file structure. 
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-- Plot Labels 
 

Default labels 
Plots are automatically labelled with a default label format.  Sample default labels for a 
temperature plot are shown below. 

 
Plan view 

WAFG= 250:LYR=1000/ 500 :FHR= 12:FHRS=  0/ 24::FIL1=WAF28APR.00Z 
95/ 4/28/ 0--TEMP 
V:10/2003--N/X/MN/SD=   -56.49   -42.85   -48.43     3.17 

 
The plan view label displays the following information: 

 
Line 1  

WAFG    Forecast model name 
LVL= 250    Pressure level 
LYR=1000/ 500   Pressure layer 
FHR= 12    Forecast hour 
FHRS=  0/ 24   Time range 
FIL1=WAF28APR.00Z Last active forecast data file 

 
Line 2 

95/ 4/28/ 0   Last active forecast model date (yy/mm/dd/hh) 
TEMP    Command line that produced the display 

 
Line 3 

V:10/2003    PCGRIDDS32 version 
N/X/MN/SD   Statistics line key: 

minimum/maximum/mean/standard deviation 
-56.49    Maximum data value 
-42.85    Minimum data value 
-48.43    Mean 
   3.17    Standard deviation 

Time-section  (TSCT) 
WAFG:Lat/Lon 35S/ 59W=> 36/  0 :FHR= 12:FHRS=  0/ 24::FIL1=WAF28APR.00Z 
95/ 4/28/ 0--TEMP 

 
The time-section label displays the following information when TSCT is used to define 
the time-section point: 

 
Line 1  

WAFG    Forecast model name 
Lat/Lon 35S/ 59W  Latitude and longitude coordinates of the time-

section point 
=> 36/  0    Hour range over which the time-section is displayed 
FHR= 12    Forecast hour (used for plan and cross-section) 
FHRS=  0/ 24   Time range (used for plan and cross-section) 
FIL1=WAF28APR.00Z Last active active forecast data file 

 
Line 2 

95/ 4/28/ 0   Last active forecast model date (yy/mm/dd/hh) 
TEMP    Command line that produced the display 
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Time-section  (TSTN) 

WAFG: BOS@42N/ 71W=> 48/  0 :FHR= 12:FHRS=  0/ 24::FIL1=WAF28APR.00Z 
95/ 4/28/ 0--TEMP 

 
The time-section label displays the following information when TSTN is used to define 
the time-section point: 

 
Line 1  

WAFG    Forecast model name 
BOS     Station located at the time section point 
@42N/ 71W   Latitude and longitude coordinates of the time-

section point 
=> 48/  0    Hour range over which the time-section is displayed 
FHR= 12    Forecast hour (used for plan and cross-section) 
FHRS=  0/ 24   Time range (used for plan and cross-section) 
FIL1=WAF28APR.00Z Last active active forecast data file 

 
Line 2 

95/ 4/28/ 0   Last active forecast model date (yy/mm/dd/hh) 
TEMP    Command line that produced the display 

 
 

Cross-section (XSCT) 
WAFG:Lat/Lon 53N/ 14E=> 28N/ 77E :FHR= 12:FHRS=  0/ 24::FIL1=WAF28APR.00Z 
95/ 4/28/ 0--TEMP 

 
The cross-section label displays the following information when XSCT is used to define 
the cross-section line: 

 
Line 1  

WAFG    Forecast model name 
Lat/Lon 53N/ 14E  Left latitude and longitude coordinates of the cross-

section line 
=> 28N/ 77E   Right latitude and longitude coordinates of the cross-

section line 
FHR= 12    Forecast hour 
FHRS=  0/ 24   Time range 
FIL1=WAF28APR.00Z Last active active forecast data file 

 
Line 2 

95/ 4/28/ 0   Last active forecast model date (yy/mm/dd/hh) 
TEMP    Command line that produced the display 
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Cross-section (XSTN) 
WAFG: ORD> BOS@42N/ 88W=>42N/ 71W :FHR= 12:FHRS=  0/ 24::FIL1=WAF28APR.00Z 
95/ 4/28/ 0--TEMP 

 
The cross-section label displays the following information when XSTN is used to define 
the cross-section line: 

 
Line 1  

WAFG    Forecast model name 
ORD     Station located at left end of cross-section line 
> BOS    Station located at right end of cross-section line 
@42N/ 88W   Left latitude and longitude coordinates of the cross-

section line 
=>42N/ 71W   Right latitude and longitude coordinates of the cross-

section line 
FHR= 12    Forecast hour 
FHRS=  0/ 24   Time range 
FIL1=WAF28APR.00Z Last active active forecast data file 

 
Line 2 

95/ 4/28/ 0   Last active forecast model date (yy/mm/dd/hh) 
TEMP    Command line that produced the display 

 
 

Custom labels 
You can produce custom labels using the PCGRIDDS32 label commands. 

 
Output commands 

Eleven of the label commands are 4 character output commands.  The first three 
characters identify the command.  The fourth character, indicated schematically by the 
symbol #, specifies the line number within the total label message.  For example, if the 
entire label contains 3 lines, then LPL2 specifies that the label for pressure level is on 
line 2.  Listed below are the eleven possible output commands, the type of information 
displayed, and a sample of the output format. 

 
LTM# TiMe and TiMe range 

VT 12 UTC FRI 28 APR 1995 
VT 12 UTC TUE 7 JUN 1994-00 UTC MON 6 JUN 1994  

 
LPL# Pressure Level and Pressure Layer 

LEVEL=250 
LAYER=1000/500 

 
LFL# Flight Level and Flight Layer 

FL 340 (250 hPa) 
FL LAYER 050-180 

 
LDN# Data file Name 

FILE=WAF28APR.00Z 
 

LFD# Forecast model Date 
From 12 UTC 22 MAR 1991 
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LMN# forecast Model Name 
WAFG 

 
LFO# Forecast model Origination (text in file PCGLBL.USR) 

DOC/NOAA/NWS    WAFC-WASHINGTON 
 

LLN# forecast LeNgth 
12H FORECAST 

 
LLL# Latitude and Longitude (time-section and cross-section only) 

LAT/LON: 35S/ 59W 
LAT/LON: 53N/ 14E=>28N/ 77E 

 
LSN# StatioN identifier (time-section and cross-section only) 

STNID:  BOS 
STNID:  ORD=> BOS 

 
LTX# user TeXt 

WIND/TEMPERATURE 
 

Label message lines 
The symbol # in all the above commands indicates the line number within the total 
label message.  The total number of lines in a label message depends on the value of 
the maximum line number specified in the label commands for a plot.  If the commands 
LFL1 LFO3 LTM1 are issued, then the total message will contain three lines with line 
2 blank.  

 
Line 1 VT 12 UTC FRI 28 APR 1995   FL 340 (250 hPa) 
Line 2 
Line 3 DOC/NOAA/NWS    WAFC-WASHINGTON 

 
Command entry 

LTX# must be entered on a single line followed by its associated text.  It cannot be 
combined with any other commands.  The remaining nine commands can be entered 
on separate lines or combined on one or more lines.  All label commands for a plot 
must be entered before the command line that actually produces the display. 

 
Note: The first label command on a line must start in the leftmost column. 

 
Examples I, II, and III produce the same results:  a pressure level label on line 1 and a 
time label on line 2.  Example IV is incorrect because the label command, LPL2, is 
issued after the plot command line (TEMP). 

 
I   II   III   IV 
--------------- --------------- --------  -------- 
LPL1 LTM2 LTM2 LPL1 LPL1           LPL1 
TEMP  TEMP  LTM2  TEMP 

TEMP  LPL2 
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Label construction 
Label commands are combined to produce message lines.  The labels for a line are 
displayed in the order that the commands are processed.  If multiple commands are on 
one line, they are processed starting with the rightmost command.  LTX# is the 
exception in that the specified text will always be left justified within the message line.  
A maximum of 132 characters can be output on one line of a printed copy, but only the 
first 78 characters are displayed on the screen. 

 
A sample command sequence and its corresponding message lines are shown below. 

 
Commands: LTM1 LPL2 LLN2 

LTX2 TEMPERATURE 
TEMP 

 
Label:  VT 12 UTC FRI 28 APR 1995 

TEMPERATURE   12H FORECAST   LEVEL=250 
 

Note: The forecast length precedes the pressure level in the label because the 
commands are processed from right to left. 

 
Default labels 

The initial setting for each plot is to display default labels.  This condition is always 
restored at the start of a new display after all overlays are completed. 

 
Default labels can be combined only with the LTX# and LWT# label commands.  If any 
other label commands are used, default labels are automatically turned off for the 
current plot.  Default labels are restored for the next plot regardless of whether it is a 
new display or an overlay, unless the LNDF command is used. 

 
LNDF (No DeFault labels) This command turns off the default labels.  No labels are 

produced unless you enter label commands.  This 
condition will remain in effect for all overlays except menu 
overlays using the [F2] key.  The default label state is 
restored when all overlays are completed.  The LNDF 
command is useful when overlaying multiple data fields.  If 
label commands are entered when the first data field is 
displayed, the LNDF command prevents the display of 
default labels for the remaining overlays. 

 
LDEF (DEFault labels) This command turns on the default labels.  If LNDF was 

used to turn off the default labels, you can use the LDEF 
command to turn on the default labels before all overlays 
are completed.  It will remain in effect until the another 
LNDF command is issued. 

 
Label processing 

The control label commands (LNDF, LDEF, LWT#) and the LTX# command are 
processed for all command sequences that produce a display.  The remaining output 
label commands are only processed for command sequences that generate a display 
from gridded data fields.  If gridded data fields are not displayed, output label 
commands are ignored and no label of any kind except text is displayed for the current 
plot.  For example, if you are in time-section mode, the command LFO1 HOUR does 
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not produce labels because hour lines are generated internally and not from a gridded 
data field.  Similarly, if you are in plan view, the command LFO1 LATT does not 
produce labels because latitude lines are not produced from a gridded data field.  
However, the command LFO1 TEMP does produce labels because TEMP is a gridded 
data field.  The following examples illustrate these rules. 

 
Example 1 

Commands: LNDF  Turn off default labels. 
LTM1  Command is not processed because LATT 

does not use gridded data. 
LATT  Display latitude lines. 
TEMP&  Overlay temperature contours on latitude lines. 

 
Label:  No labels 

 
Example 2 

Commands: LATT  Display latitude lines.  Default labels are produced. 
LNDF  Turn off default labels. 
LTM1  Display time label on line 1 of the label 

message. 
TEMP&  Overlay temperature contours on latitude lines. 

 
Label:  VT 12 UTC FRI 28 APR 1995 

95/ 4/28/ 0--LATT 
V:10/2003--N/X/MN/SD= -28.75   -56.25   -42.50   8.29 

 
Example 3 

Commands: LNDF  Turn off default labels. 
LATT  Display latitude lines. 
LTM1  Display time label on line 1 of the label 

message. 
TEMP&  Overlay temperature contours on latitude lines. 

 
Label:  VT 12 UTC FRI 28 APR 1995 

 
Label display 

Labels are automatically displayed on the screen after a data field is processed.  All 
previous labels are rewritten on the screen with the display of each overlay.  This 
prevents contour lines from writing over the label text.  By default a set of label 
message lines starts on line 1, the line following the command line on the screen. 

 
For printed output the label message lines are written consecutively at the bottom of 
the page immediately below the plot.  The number of label lines you can print depends 
on the maximum number of lines reserved for labels.  The default value is 6.  You can 
revise this value by modifying the file PCGMODE.DAT (Refer to 'Customizing 
PCGRIDDS32'). 

 
LWT# (begin WriTe) This command specifies the line number of the screen to start 

WriTing the current label set.  If this command is not used then 
the label set starts at line 1.  This command has no effect on the 
label position for printed plots. 
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Overlays 
Overlaying is the term used to refer to the simultaneous display of multiple data fields.  
If an overlay is composed of two plots with identical time and level specifications and 
user labels are requested for both plots, only one set of labels will be displayed.  This 
applies to all label commands except LTX#.  The text associated with an LTX# 
command will always be displayed.  The example below illustrates the overlay 
restrictions. 

 
Note: The pressure level label is not displayed because it is requested for plot 2 

and labels are suppressed for overlays with the same time and level 
specifications. 

 
Commands: LTM1    Display time on line 1 

LTX2 WIND   Display text on line 2 
WIND    Display wind data 
LPL3    Display pressure level on line 3 
LTX4 TEMPERATURE Display text on line 4 
TEMP&    Overlay temperature contours 

 
Label:  VT 12 UTC FRI 28 APR 1995 

WIND 
 

TEMPERATURE 
 

Overlays produced by using the REST command (refer to ‘Print Commands’ in 
‘Printing’) to display saved graphics are treated as separate displays for label 
purposes.  This means that user labels for both the restored graphics and the first 
overlay are displayed.  Menu overlays produced using [F2] also fall into this category.  
The previous example was modified slightly to illustrate this concept. 

 
Note: The pressure level label is now displayed because the overlay was used in 

conjunction with the REST command. 
 

Commands: SAVE PLT1   Save graphics in file PLT1.SVG 
LTM1    Display time on line 1 
LTX2 WIND   Display text on line 2 
WIND    Display wind data 
ENDS    Stop saving graphics 
ERAS    Erase screen 

 
REST PLT1   Restore graphics in file PLT1.SVG 
LPL3             Display pressure level on line 3 
LTX4 TEMPERATURE Display text on line 4 
TEMP&    Overlay temperature contours 

 
Label:  VT 12 UTC FRI 28 APR 1995 

WIND 
LEVEL= 250 
TEMPERATURE 
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Annotation of screen displays 
Default labels and those produced by label commands are displayed both on the 
screen and on printer output.  The TXT# command can write text annotation only to 
the screen. 

 
TXT# (screen TeXT) This command must be entered on a single line followed by its 

associated text.  It cannot be combined with any other 
commands.  The # symbol indicates the line on the screen to 
which the text is written.  Text written with the TXT command will 
never be output to the printer nor can it be displayed with the 
REST command.  This command is processed and output 
immediately.  It should be issued AFTER the data field is 
displayed. 
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PCGRIDDS32 Command Mode 
 

The following discussions describe the operation of PCGRIDDS32 in Command Mode. 
 

NOTE: The default operating mode for your PCGRIDDS32 system is controlled by the value of 
'PCGRIDDS32 startup mode' in the file C:\PCGRIDDS32\USER\PCGMODE.DAT.  When 
PCGRIDDS32 is installed, the default operating mode is 'Menu'.  You can set the default to either 
Menu Mode or Command Mode (refer to 'Customizing PCGRIDDS32' for more detailed 
instructions). 

 
-- Starting PCGRIDDS32 

Use the following steps to initiate a PCGRIDDS32 session in Command Mode: 
 
  1. From the desktop, double-click the icon PCGRIDDS32 

The ‘PCGRIDDS32 Applications’ menu is displayed on the screen (Fig.1). 
 

3. Type: 2 
Selects choice #2 (Run PCGRIDDS32) from the Applications menu.  Displays the PCGRIDDS32 
logo and begins the session. 

 
 

Fig.1 
┌────────────────────────────────────────────────────────────┐ 
│  ╔══════════════════════════════════════════════════════╗  │ 
│  ║                PCGRIDDS32 Applications               ║  │ 
│  ║                                                      ║  │ 
│  ║  1. Ingest GRIB Data                                 ║  │ 
│  ║  2. Run PCGRIDDS32                                   ║  │ 
│  ║  X. Exit pcgridds32                                  ║  │ 
│  ║                                                      ║  │ 
│  ║ Version 3/2005                            MARCH 2005 ║  │ 
│  ╚══════════════════════════════════════════════════════╝  │ 
│  Your choice? (1-2 or X to exit)                           │ 
└────────────────────────────────────────────────────────────┘ 

 
A listing of the file, C:\PCGRIDDS32\HELP\HELP.DAT, which provides an online Command Mode 
tutorial (refer to >Online Help=), is supplied below. 
 
Command Mode requests are input as series of FOUR LETTER INSTRUCTIONS separated  
by Spaces or Delimiters, followed by the Enter key.   
 
A maximum of 16 commands can be entered on 1 line as indicated by the 
following guiding template line which is displayed at the top of the screen. 
 
?____.____.____.____.____.____.____.____.____.____.____.____.____.____.____.___ 
 
NOTE:  With few exceptions, a line of commands is processed in order from  
                               RIGHT to LEFT,  
        so the last command entered on a line is the first to appear. 
 
Additional information on the use of individual commands can be obtained by 
typing  HLPC  [ HeLP for Commands ]  or by using the Command Help option on  
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the Help Menu.   At any time, you can switch to a menu mode of operations by 



typing  MENU. 
 
 
**- To Begin - 
Before any displays can be generated, a data file must be opened.   
 
In Command Mode, PCGRIDDS32 begins by requesting the name of a data file.   
 
The file opening process reads and displays a list of fields available from  
that data set and then initializes a number of Variables used to specify  
data levels and forecast hours.   
 
It also establishes a map background for a user specified default portion  
of the grid area.   
 
The  OPEN  command can make up to 20 data files available for access. 
 
The  LIST  command will list the current grid information variables and  
the contents of the currently active data set. 
 
The  FILS  command lists the files already opened and their access codes. 
Once opened, access can change from one file to another using the  FIL#   
command, where # is number in order of when the file was opened. 
 
 
**- Initial Default values - 
The default Flag Variable values are: 
 
A Forecast Hour (FHOR) -- Default = 12 
 
A four letter Grid Level (LEVL) -- Default =  850  
 
A pair of Forecast Hours (FHRS) consisting of  -- Default = 00/24 
  [See FHR1 and FHR2 later -- Used for time differences, etc.] 
 
A grid layer (LAYR) consisting of two levels -- Default = 1000  500 
  [See LVL1 and LVL2 later -- Used for level differences, etc.] 
 
 
The default values can be customized by the user by modifying the file 
USER\INITGRID.SPC, in which the initial values of the six variable parameters 
LEVL LVL1 LVL2 FHOR FHR1 FHR2  are specified. 
 
 
 
 
**- Changing Flag Variable Values - Level/Layer Specification 
The LeVeL/LaYeR defaults can be Set by typing SLVL or SLYR followed by the 
four character specifications in the next input positions.  For example, 
 
SLVL 1000   - Changes default level to 1000 mb, 
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SLVL  MSL   - Changes default level to mean sea level, 
SLVL S896   - Changes default level to the Sigma level centered at 896 mb, 
SLVL I300     - Changes default level to the 300K Isentropic level, 
SLVL H150   - Changes default level to the 15,000 ft Height level, 
SLYR  850  300   - Changes layer bottom and top default levels (in order)  
                               to 850 and 300 mb. 
 
For convenience, the LeVeL can also be specified by simply typing the desired 
level as part of the command line to the right of the desired field, e.g., 
reading from RIGHT to LEFT, the command sequence   TEMP 850   will first set 
the level to 850 mb and then read, decode and contour the temperature field. 
 
 
**- Changing Flag Variable Values - Time Specification 
The time defaults can be changed by typing  FHOR [or SFHR]  or  FHRS [or SFHS] 
and answering a free-format prompt.   
 
Alternatively, the time defaults can be changed by typing  SFHR  or  SFHS  
followed by the desired hour in the next 4 character command line locations.  
For example, 
 
SFHR   12         -  Changes the time default to a 12 hour Forecast, 
SFHR   -1          -  Changes the time default to the ANALysis, 
SFHR   00         -  Changes the time default to the 00 h initialized fields, 
SHFS   12   24  -  Changes the time pair defaults to the 12 and 24 h Forecasts. 
 
For convenience, SFHR can also be omitted from the command string if desired, 
typing instead only  ANAL, F00, F12, F24, F36 or F48 for those specific times, 
e.g., reading from RIGHT to LEFT, the command sequence   TEMP 850 F24  will  
first set the forecast hour to 24 hours, then set the level to 850 mb and 
lastly read and contour the temperature field. 
 
 
**- Specifying the Display Area 
The display area can be changed by typing  AREA  at the LEFT end of the command 
line, followed a new central latitude and longitude (given by degrees followed 
immediately by the letters N/S or E/W to indicate hemisphere) and 
North-to-South display distance in degrees.  For example, the command sequence  
AREA 40N 20E 20   will provide a display over southern Europe, extending 
roughly from 30 to 50 N. 
 
If no hemisphere indicator is included, positive values are used to represent 
Northern and Western hemispheric locations.  --  If no lat/lon information is 
included, a prompt will appear showing location at the center of the grid. 
 
The Entire grid area can be displayed by entering  AREA followed by 3 zeros, 
e.g.,  AREA 0 0 0.  The initial display AREA used in each PCGRIDDS32 session can 
be specified in a file INITMAP.CRD. 
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The Area can also be defined centered at a STatioN location using the  ASTN 
command followed by a 3 or 4 character station identifier and a North-to-South 
display distance.  If no N-to-S distance is included, a value of 30 is used.  
This default can be changed using  NS##, where ## is the N-to-S distance.  
 
 
**- Command Structures -- Displaying Primary Data Fields - 
Once a file has been opened, data can be displayed by typing a series of 
requests on the command line.  In general, a command line is read by the 
program from RIGHT TO LEFT to request grids and perform various functions.  
Results of the last (left most) operations are then displayed automatically.   
 
To display any of the grids stored in the gridded data set, simply type the  4 
letter  NAME  of the grid followed by [Enter]. (Again, a list of the available 
grids will be shown by typing  LIST  .)  For example,  
 
HGHT      - will clear the screen & display contours of the 850 mb HeiGHT field 
TEMP      - will clear the screen & display contours of the 850 mb TEMPerature 
 
 
A listing of the parameters possibly included in the gridded data sets follows: 
 
**- Primary Gridded Data Fields: 
HGHT > Geopotential HeiGHT (meters) 
PRES > Pressure (mb) 
 
TEMP > TEMPerature (degree C) 
THTA > Potential Temperature - THeTA(degree K) 
 
MIXR > MIXing Ratio (g/kg) 
RELH > Relative Humidity (%) 
DWPT > DeW Point Temperature (degree C) 
TMPK > TeMPerature (degrees K) 
TMPF > TeMPerature (degrees F) 
THTE > Equivalent Potential Temperature - THeTa/E (degree K) 
 
WIND > Total WIND vector (m/sec) 
WSPD > Total Wind Speed (m/sec) 
WDDF > Packed value of Wind Direction/speed (tens of degrees and m/sec) 
WDRC > Wind DiReCtion (degrees) 
BWND > WiND Barbs (m/sec) 
BKNT > Wind Barbs (KNoTs) 
 
PMSL > Mean Sea Level Pressure fields, provided without resetting LEVeL 
          Note:  If mean sea level pressure (GRIB ID=002) is not  
                 available, then an attempt is made to retrieve the  
                 RUC Reduction, the Eta Model Reduction, and the  
                 Standard Atmosphere Reduction, in that order. 
 
TPCP > Total Precipitation fields, provided without resetting LEVeL (mm) 
CPCP > Convective Precipitation fields, provided without resetting LEVeL (mm) 
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TPCI > Total Precipitation fields, provided without resetting LEVeL (in) 



CPCI > Convective Precipitation fields, provided without resetting LEVeL (in) 
 
       NOTE:  TPCx/CPCx attempt to retrieve a 12 hour accumulation.  If this 
              is not possible, then they try to obtain the longest 
              accumulation (6,3,2,1) available. 
 
LIFT > Pre-calculated LIFTed Index, provided without resetting LEVeL 
PWAT > Precipitable Water fields, provided without resetting LEVeL 
 
THCK > Generates Thickness fields determined by LVL1/LVL2 settings 
THWN > Generates Thermal Wind determined by LVL1/LVL2 settings 
 
 
**- Automatically derived parameters - 
In addition to displays of LISTed forecast fields already in the data 
file, a number of derived parameters and functions can also be requested and 
calculated automatically as the data are being read from the computer.  For 
example, a request of  THTA  will automatically calculate and display the 
potential temperature (THeTA) field.  Some of the automatically calculated derived 
parameters include: 
 
THTA (Potential Temperature)             
SDEF (Saturation Deficit) 
MIXR (Mixing Ratio)                      
SMIX (Saturation Mixing Ratio) 
 
GEOS (Geostrophic Wind - vector)         
AGEO (Ageostrophic Wind - vector) 
 
LNDX > Provides Lifted Index calculated between LVL1 and LVL2 
PLCL > Calculates the Pressure of the LCL from LEVeL data 
PDEF > Calculates the Pressure lift needed for saturation form the LCL 
 
See  the Appendix or  the Online Command Help for more commands and detailed explanations. 
 
 
**- Overlaying displays on a single command line - 
Command requests can also be presented in strings, with & (or /) as a command 
delimiter to indicate field overlays. For example,  
 
RELH&      - will overlay the RELative Humidity analysis on the previously 
             requested fields in a second color, according to the sequence of 
             colors on the color bar at the bottom of the screen. 
 
TEMP&HGHT  - will display contours of HeiGHTs at 850 mb and the 850 mb  
             TEMPerature field in different colors on the same map. 
 
NOTE:  All command requests are processed from right to left (a la Reverse  
Polish Notation).  As such, the command  TEMP&HGHT  will produce a Height  
field first, followed by a temperature field in a second color.   
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Data from different files can be overlaid under the following conditions: 



   1. The data must be on the same grid projection (models can differ) 
   2. The initial and final grid points used in any data subsetting must be the 
      same (i.e., identical areas must be selected during the ingest process). 
If these conditions are not met, a message is displayed indicating the files  
are a different size or type.  The current plot is cleared; processing stops. 
 
 
**- Changing Contour Intervals - 
The Contour INTerval will be calculated automatically based on the variability 
of the field by default.  Specific Contour INTerval requests can be specified 
in several ways.  By typing  CINT  to the  left  of a field requested for 
display, the maximum and minimum of the field will be written on the screen and 
a prompt for a desired contour interval will appear.  For example, 
 
CINT HGHT  -  will read the height field and ask the user for a desired contour 
              interval (to be input in free format, with a  0  input requesting 
              an automatically calculated 'reasonable' interval. 
 
NOTE:  A contour interval specification normally is only in effect for one  
plot.  To keep a contour specifications from one plot to another, type  CISV 
The contour interval specification mode can be returned to the single plot 
convention by typing  CINX.  For example, 
 
 
 
 
HGHT CINX&DWPT&TEMP CISV CIN5  -  will read the TEMPerature and DeWPoinT field 
                                  and display them with a 5 degree contour and  
                                  then reset to automatic contour determination 
                                  and overlay the HeiGHT contours. 
 
 
**- Simplified Contour Interval selection -  
Any contour interval can also be requested without the additional user prompt 
by including any of the following commands to the left or right of the desired 
field:   
                                CIN5 - contour intervals of    5 units 
                                CIN# - contour intervals of    # units 
                                CI10 - contour intervals of   10 units 
                                CI#0 - contour intervals of   #0 units 
                                C100 - contour intervals of  100 units 
                                C#00 - contour intervals of  #00 units 
                                CI.2 - contour intervals of   .2 units 
                                CI.# - contour intervals of   .# units 
                                C2+3 - contour intervals of 2000 (10**2) units 
                                C#+$ - contour intervals of #*10**$ units 
                                C2-3 - contour intervals of .002 (10**-2) units 
                                C#-$ - contour intervals of #*10**-$ units 
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For example, the command line - 
HGHT CI60 SLVL  500&PRES CIN4 SLVL  MSL  -  will display the Mean Sea Level  
                                            PRESsure field contoured at 4 mb  
                                            intervals and the 500mb HeiGHTs  
                                            contoured at 60m intervals.   
 
 
**- Changing Contour Colors / Dashed Contours 
The Contour / Wind display colors will be assigned automatically in sequence 
according to the template shown at the bottom of the screen.  The default color 
can be overridden by using the  CLR#  command,  
     
   where CLR1 refers to the first color on the template, 
              CLR2 refers to the second color on the template, . . . 
              CLRA refers to the tenth color on the template, . . . 
              CLRH refers to the first dashed color on the template, . . . 
              CLRX refers to the first dotted color on the template. 
 
Dashed contours can also be produced by including  DASH  in the command line.  
DASH  is only in effect for one plot and must be reset for additional displays. 
 
The commands  DNEG  and  DPOS  can be used to dash either the Negative or 
Positive contours in a data field. 
 
 
 
** - Single Line Contour Plot –  
PCGRIDDS32 can plot single-line scalar plots.  For example, if you wish to plot the 5700 dm height 
contour on the 500 mb level, enter the following commands: 
 

HGHT 500&SLIN 5700 
 
The new command, SLIN ####, is Single LINe  followed by a four digit value of the contour you 
wish to plot.  This is valuable for creating “spaghetti plots” of the same contour from different model 
runs or comparing different times or making a single contour stand out from the others like the 
freeze line. The SLIN command is valid for only that one plot and must be called every time it is 
needed. 

 
 
**- Plotting Digital Grid Values at Data Points / Scaling Output 
Digital values of the gridded data can also be requested as follows: 
     DATA > Sets display mode to plot data values at grid points. 
     DATT > Sets display mode to plot data values above grid points. 
     DATB > Sets display mode to plot data values below grid points. 
     DATO > Sets display mode to plot data values high Over grid points. 
     DATU > Sets display mode to plot data values low Under grid points. 
 
Data Displays and Contour Labels can be requested to display specific digits 
using the following Scaling and Modulo commands: 
 
     SCL0 - Display only signed digits greater than or equal to 10**0 (1) 
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     SCL1 - Display only signed digits greater than or equal to 10**1 (10) 
     SCL# - Display only signed digits greater than or equal to 10**# 
     SC-1 - Display only signed digits greater than or equal to 10**-1 (.1) 
     SC-# - Display only signed digits greater than or equal to 10**-# 
      
     MOD# > Display labels using Modulo of SCALED display value and 10**# 
 
**- Wind Displays - 
Vector displays will be generated automatically for vector quantities, or when 
two grids area queued for plotting.  Again, 4 letter commands can be used to 
change the mode of display to either arrows  {AROW} , barbs  {BARB, m/s} or 
streamlines {STRM}. Winds can be displayed on pressure, height or isentropic levels. 
 
Several wind options are available.  These include: 
 
WIND  to display the gridded total wind data,   
GEOS  to display the geostrophic wind, and   
AGEO  to display the ageostrophic wind.         
 
For example,   
 
WIND&HGHT  - displays contour of the height field with wind arrows overlaid 
 
A number of shorthand alias requests are also available, including 
 
WKNT > Retrieves the total wind Vector in knots. 
WMPH > Retrieves the total wind Vector in mph. 
WKPH > Retrieves the total wind Vector in kph. 
BKNT > Retrieves the total wind Vector in knots and sets display as wind barb. 
BMPH > Retrieves the total wind Vector in mph and sets display as wind barb. 
BKPH > Retrieves the total wind Vector in kph and sets display as wind barb 
 
 
**- Changing Wind Arrow Length or Displaying Wind Barbs - 
The contour interval specification also acts as means for changing the length 
of arrows used in wind displays.  Normally, the lengths of wind arrows are 
scaled so that the arrow representing the largest wind speed in a display is 
set to be equal to the distance between two adjacent grid points.  Adjustments 
in the length can be made using the "CI" commands, where the requested "contour 
interval" specifies the speed to be plotted as a one grid interval length 
arrow.  For example, 
 
WIND CI10  -  will produce wind arrows in which the length of a 10 m/s wind  
              is one grid spacing unit. 
 
 
Winds can also be displayed as Barbs by typing  BARB. 
 
Winds can also be displayed as Streamlines by typing  STRM. 
 
To return the wind display to Arrows type  AROW. 
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**- Use of Layers or Multiple time periods - 
Layer and/or time manipulation of PRIMARY DATA VARIABLES can be triggered by 
inserting keywords to the right of the desired variable.  Options include: 
 
   LDIF (Layer Difference)    
   LAVE (Layer Average) 
   LTOT (Layer Sum or Total) 
   TDIF (Time Difference)          
   TAVE (Time Average) 
   TTND (Time Tendency - TDIF/time)     
   TTOT (Time Sum or Total)    
 
NOTE: These commands MUST be positioned to the RIGHT of the variable name and 
can ONLY be used with PRIMARY VARIABLES. 
 
For example, the sequence of commands  
 
SLYR 1000  500  -  will calculate the DIFference in HGHT between the top and  
HGHT LDIF             bottom levels defined by the SLYR command, in this case 
                                producing a 1000 to 500 mb thickness field, and 
 
SFRS  F00  F24  - will calculate and display the difference 
HGHT TDIF           in the HeiGHT fields between the initial conditions and the 
                               24 h forecast. 
 
Entries in the SLYR or LVL#  may be in either pressure or isentropic levels. 
 
For example, the command line 
 
SLYR 750  400 - will set the layer limits to 750 and 400 mb 
SLYR I300 I320 – will set the layer limits to the isentropic layers of 300K and 320K. 
 
 
Calculations using either the top or bottom levels of the layer defined by  
SLYR and/or the beginning or end times of a forecast period defined by FHRS 
can be requested without explicitly resetting the level or time defaults by 
inserting the following keywords to the right of the desired variable: 
 
LVL1 (First level of LAYR)              
LVL2 (Second level of LAYR) 
FHR1 (First time of FHRS)                
FHR2 (Second time of FHRS)   
 
For example, the command line 
 
HGHT LDIF&HGHT LVL2&HGHT LVL1 CI60 SLYR 1000  500  -  will set the layer limits 
                                                      at 1000 and 500 mb and then produce contours of  

                                             the 1000 and 500 mb HeiGHTs, followed by the 1000-500 mb   
                                             thickness, all contoured with 60 m intervals. 
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NOTE:  Once a layer or time period is set, it continues in effect for the remainder  
of that plot request unless overturned by another entry.                                                           
 
 
 
 
** - Animation –  
 
PCGRIDDS32 has the ability to animate both PLAN and CROS screen plots.   
This is accomplished in one of three ways.  If PCGRIDDS32 is in Command-line Mode 
and you wish to animate the 500 mb heights through the full forecast length of the  
model run, you enter: 
 

HGHT 500 & ANIM 
 
The command for animation is ANIM and must be the most right command on the  
line. This command will cycle through every forecast hour in the active model file.  
The following are other animate commands: 

 
ANMA – ANimate Macro 
ANFA – ANimate Forecast hours 
 
Command Macros can now be animated as well.  The command ANMA (Animate  
Macro) must be before any LOOP command and there must be only one LOOP/ 
ENDL set in the macro.   
 
If you wish to compare two or more model runs which may have different time  
steps or you wish to only animate specific time steps, it is easiest to create a  
Macro but the function can be done from the Command line if the total commands  
are less than 16.  Use the following example to use only the 00h, 12h, and 24h  
time steps out of the 00h, 06h, 12h, 18h and 24h time steps available: 
 
From the Command line: 
 
ENDA&ENDL&HGHT 500&SFHR 24&LOOP&ENDL&HGHT 500&SFHR 12&LOOP&  
ENDL&HGHT 500&SFHR 00&LOOP&ANFA 
 
Or in a Macro: 
ANFA 
LOOP 
SFHR 00 
HGHT 500 
ENDL 
LOOP 
SFHR 12 
HGHT 500 
ENDL 
LOOP 
SFHR 24 
HGHT 500 
ENDL 
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ENDA 



 
If you notice, the first Macro command is ANFA and the plots are made up of  
repeating the  LOOP/ENDL command with the last Macro command being ENDA  
which is ENDAnimation creation.  When the ANFA command is executed,  
PCGRIDDS32 proceeds through the forecast hours and “builds” the animation  
frames.  Once it has cycled through all the forecast hours, it will begin to loop  
through the animation cycle with a preset delay between frames and with a  
longer delay between cycles to show the end of the cycle.  There are five  
commands which the operator can enter while the animation is cycling; the  
[UP-ARROW] key speeds up the loop speed and [DN-ARROW] slows down  
the loop speed.  The animation cycle can also be switched from a free-run mode  
to a step-mode at any time by pressing the [F] key to step forward one frame or  
press the [B] key to step back one frame.  The animation cycle will stay in the step  
mode till the [L] key places it back in loop mode.  The animation cycle is terminated  
by pressing the [S] key. At the end of the animation sequence, all of the bitmap  
files in the ANIMATION directory are deleted. 
       

         
 
 
 
**- Specify a Cross Section Path  
Cross-section displays can display data on isentropic surfaces and constant height  
surfaces as well as pressure surfaces.  The isentropic levels are predefined from  
270K-400K every 10k. The height surfaces can be displayed in either feet or meters.   
This selection is made on line 3 in the file PCGMODE.DAT. The vertical range for  
CROS sections in height mode is 500 ft to 65,000 ft in 5,000 ft increments or 2000  
meters to 24,000 meters in 2,000 meter increments.  These are fixed in software.  
The user can use pressure and forecast hour data in the file USER\INITGRID.SPC,  
which is the default settings or the user can utilize all the model pressure levels or  
use the commands XLVL (followed by file name) to use predefined pressure levels.   
Cross-section displays for pressure surfaces can be established by typing XSCT,  
displays for Isentropic surfaces can be established by typing XSCI and displays for  
height surfaces can be established by typing XSCH.   They are followed by the left  
display latitude and longitude and the right latitude and longitude. (If no lat/lon information  
is included, a prompt will appear.)  Two formats can be used, either latitudes and longitudes  
followed IMMEDIATELY (no spaces between) by 1 character hemisphere indicators  
(e.g., 40S  for 40 degrees South latitude) or signed numeric values, where positive  
values indicate Northern and Western Hemispheres. 
 
Cross-sections can also be defined between two Station locations using the  
Command XSTN for pressure levels, XSTI for Isentropic levels or XSTH for Height  
levels followed by two 3 or 4 letter station identifiers. Once a cross-section has been  
defined, the base map can be redrawn with the cross section path shown as a dotted  
line using either the MAP  command (to overlay a map on the existing product) or the   
EMAP  command to erase the screen before drawing the map.   
 
To set up a cross section using all model levels, these commands are executed: 
ALVL 
XSCT  55.00   80.00  25.00   80.00 
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To set up a cross section using XLVL with the file name ‘505m’ , these commands are executed: 



XLVL 505m 
XSCT  55.00   80.00  25.00   80.00  
 
The look of the Cross section display is created by a series of commands executed from the files 
USER\CROSSSECTION.DAT for cross sections.  This file can be customized by the user to change 
the look of the display.  If these files are not found while attempting to build a CROS section, to 
program will default to the current operational CROS display. 
 
The following commands are what are in the included in the USER\CROSSSECTION.DAT file: 
 
NLBL XLTN CLRY& 
NCLB NLBL PRES CLRY& 
XLBL SCL0 NLBL CLRF LAST& 
XLBB SCL0 NLBL ALAT CLRF& 
XLBB SCL0 NLBL DATT ALON CLRF& 
 
 
To remove the cross section path, type either XSTN 9999 or XSCT 9999. 
 
Defining a cross section path also initiates the cross section display mode. 
Display modes can be switched from cross section to plan view by typing  PLAN, 
and from plan view to the previously established cross section by typing  CROS. 
 
 
**- Cross Section Wind displays 
Cross-sectional wind displays can be modified to provide rotated, cross-section 
relative wind representations by typing  XREL  to the left of the desired wind 
type. Individual cross-sectional relative components can be displayed using  
TANG  and  NORM  for contour of the tangential and normal wind components and 
VTNG  and  VNRM  for vector component displays. 
 
Vertical circulations displays of the tangential component of the wind and the 
vertical velocity are produced by typing  VCRC  followed by a wind type. 
 
A number of shorthand notation aliases are available for cross-sectional 
wind displays, including: 
 
WNDX  to display the total wind rotated relative to the cross section   
GEOX  to display the geostrophic wind rotated relative to the cross section 
AGEO  to display the ageostrophic wind rotated relative to the cross section 
WCRC  to display vertical/tangential circulations of total wind 
GCRC  to display vertical/tangential circulations of geostrophic wind 
ACRC  to display vertical/tangential circulations of ageostrophic wind 
 
 
 
**- Specify a Time Section Point 
Time-section displays can display data on isentropic surfaces and constant height  
surfaces as well as pressure surfaces.  The isentropic levels are predefined from  
270K-400K every 10k. The height surfaces can be displayed in either feet or meters.   
This selection is made on line 3 in the file PCGMODE.DAT. The vertical range for  
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TIME sections in height mode is 500 ft to 65,000 ft in 5,000 ft increments or 2000  
meters to 24,000 meters in 2,000 meter increments.  These are fixed in software.  
The user can use pressure and forecast hour data in the file USER\INITGRID.SPC,  
which is the default settings or the user can utilize all the model pressure/forecast  
hours or use the commands XLVL and THRS (followed by file names) to use  
predefined pressure levels and forecast hours respectively.  Time-section displays  
can be established for pressure surfaces by typing TSCT, for Isentropic surfaces by  
typing TSCI and for Height surfaces by typing TSCH.  They are followed by the 
display latitude and longitude. (If no lat/lon information is included, a  
prompt will appear.)  Two formats can be used, either latitudes and longitudes  
followed IMMEDIATELY (no spaces between) by 1 character hemisphere indicators  
(e.g., 40S  for 40 degrees South latitude) or signed numeric values, where  
positive values indicate Northern and Western Hemispheres. 
 
Time-sections can also be defined for a Station location using the TSTN   
command followed by a 3 or 4 letter station identifier. Once a time-section  
has been defined, the base map can be redrawn with the time section point  
shown as a dotted line using either the  MAP  command (to overlay a map  
on the existing product) or the  EMAP  command to erase the screen before 
drawing the map. 
 
To set up a time section using all model levels, these commands are executed: 
ALVL 
TSCT  55.00   80.00  25.00   80.00 
 
To set up a time section using XLVL with the file name ‘505m’ , these commands are executed: 
XLVL 505m 
TSCT  55.00   80.00  25.00   80.00  
 
To set up a time section using all model levels and all forecast hours, these commands are executed: 
ATIM 
ALVL 
TSCT  42.37   71.03 
 
To remove the time section point, type either TSTN 9999 or TSCT 9999. 
 
Defining a time section also initiates the time section display mode. 
Display modes can be switched from time section to plan view by typing  PLAN, 
and from plan view to the established time section by typing  TIME. 
 
The look of the Time section display is created by a series of commands executed  
from the file USER\TIMESECTION.DAT for time sections.  This file can be customized  
by the user to change the look of the display.  If this file is not found while attempting  
to build a TIME section, to program will default to the current operational TIME display. 
The following commands are what are in the included in the USER\TIMESECTION.DAT file: 
 
NCLB NLBL PRES CLRY& 
XLBL SCL0 NLBL CLRF LAST& 
XLBB SCL0 NLBL HOUR CLRF& 
NLBL HOUR CLRY& 
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**- PRINTING - 
PCGRIDDS32 prints to the default system printer. This printer can be either local or networked and can 
print in either Portrait or Landscape mode.  The command PRNT will print the current screen contents 
automatically to the Windows default printer and no Print Dialog is displayed.  If you wish to make any 
modifications to the Windows printer setup, it must be done outside of PCGRIDDS32. There are no 
other print modes in PCGRIDDS32 as there were in the DOS PCGRIDDS. Print copies seem to look 
the best at 800x600 video mode.  Special thanks goes out to Dave Ballinger for his programming 
contribution for this function. 
 
 
 
**- Diagnostic Functions - Background and Philosophy - 
The ability to calculate and combine a variety of quantities derived from the  
grid point data greatly enhances the diagnostic capabilities of the system.   
The diagnostics are expressed in functional form, in that a function name is  
followed by an ordered set of arguments, optionally enclosed in parentheses or 
brackets and separated by commas. 
 
As an illustration, advection is expressed as the function  ADVT  followed by 
a Scalar quantity and a Wind Type.  As such, the Temperature Advection field 
should be thought of as "ADVecTion of the TEMPerature by the Total WIND" and 
correspondingly requested using the sequence  ADVT(TEMP,WIND).  Similarly, the 
ageostrophic component of the Moisture Advection is expressed as "ADVecTion of 
the MIXing Ratio by the AGEOstropic wind" and requested by  ADVT(MIXR,AGEO).  
Here, both the Mixing Ratio and Ageostrophic Wind are derived automatically. 
 
Functional calls can also be chained together.  For example, Vorticity  
Advection is thought of as "Advection of the Vorticity of the Total Wind by the 
Total Wind."  As such, the functional request becomes  ADVT[VORT(WIND),WIND].   
 
For clarity, either parentheses - ( and ) - or brackets - [ and ] - can, as an 
option, be used to group the function arguments. 
 
 
**- Available Diagnostic Functions -  
See the Appendix or the Command Help option for full listing of available commands. 
 
Some frequently used functions available, include: 
 
SSUM [Followed by 2 Scalars] > Calculates Scalar grid sum 
SAVR [Followed by 2 Scalars] > Calculates Scalar grid average 
SDIF [Followed by 2 Scalars] > Calculates Scalar grid difference 
STND [Followed by 2 Scalars] > Calculates Scalar grid time tendency  
SMLT [Followed by 2 Scalars] > Multiplies two Scalar fields 
SDVD [Followed by 2 Scalars] > Divides two Scalar fields 
SADC [Followed by a 4 digit value] > Sum of Scalar & specified constant 
SSBC [Followed by a 4 digit value] > Difference of Scalar & specified constant 
SMLC [Followed by a 4 digit value] > Multiplies Scalar by specified constant 
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SDVC [Followed by a 4 digit value] > Divides Scalar by specified constant 



INVS [Followed by a Scalar] > Finds INVerSe of a Scalar 
INV1 [Followed by a Scalar] > Finds INVerse of a Scalar with max. of 1 
ABSV [Followed by Scalar] > Calculates ABSolute Value of Scalar grid 
SINE [Followed by Scalar] > Calculates the SINE of Scalar grid (e.g., WDRC) 
COSN [Followed by Scalar] > Calculates the COSiNe of Scalar grid (e.g., WDRC) 
TNGT [Followed by Scalar] > Calculates the TaNGenT of Scalar grid (e.g., WDRC) 
SNEG [Followed by Scalar] > Finds the NEGative of a Scalar grid 
 
DSDX [Followed by Scalar] > Calculates X gradient of Scalar 
DSDY [Followed by Scalar] > Calculates Y gradient of Scalar 
MGRD [Followed by a Scalar] > Magnitude of the GRaDient of a Scalar field 
GRAD [Followed by a Scalar] > Finds the GRADient of a Scalar field 
NGRD [Followed by a Scalar] > Finds the Negative GRaDient of a Scalar field 
MGRD [Followed by a Scalar] > Magnitude of the GRaDient of a Scalar field 
 
VADC [Followed by a 4 digit value] > Sum of Vector & specified constant 
VSBC [Followed by a 4 digit value] > Difference of Vector & specified constant 
VMLC [Followed by a 4 digit value] > Multiplies Vector by specified constant 
VDVC [Followed by a 4 digit value] > Divides Vector by specified constant 
VNEG [Followed by Vector] > Finds the NEGative of a Vector field 
VSUM [Followed by 2 Vectors] > Calculates the Vector sum 
VAVR [Followed by 2 Vectors] > Calculates the Vector average 
VDIF [Followed by 2 Vectors] > Calculates the Vector difference 
VTND [Followed by 2 Vectors] > Calculates the Vector time tendency 
VMLT [Followed by 2 Vectors] > Multiplies two Vectors by components 
DOTP [Followed by 2 Vectors] > Calculates the DOT Product of 2 Vectors 
CRSP [Followed by 2 Vectors] > Calculates the CRoSs Product of two Vectors 
VDVD [Followed by 2 Vectors] > Divides two Vectors by components 
 
VKNT [Followed by a Vector] > Converts a Vector from m/s to KNoTs 
VMPH [Followed by a Vector] > Converts a Vector from m/s to MPH 
VKPH [Followed by a Vector] > Converts a Vector from m/s to KPH 
MAGN [Followed by a Vector] > Calculates MAGNitude of a Vector 
SKNT [Followed by a Scalar] > Converts a Scalar (e.g., WSPD) from m/s to KNOTs 
SMPH [Followed by a Scalar] > Converts a Scalar (e.g., WSPD) from m/s to MPH 
SKPH [Followed by a Scalar] > Converts a Scalar (e.g., WSPD) from m/s to KPH 
 
ISAL > Computes the Isallobaric Wind 
INAD > Computes the Inertial Advective Wind 
JCBN [Followed by 2 Scalars] > Computes the Jacobian determinate of two scalars 
FRTG [Followed by wind Vector] > Computes Frontogenesis of the wind 
DFCP [Followed by a vector] > Calculate the Deformation components  
                              (X COMP, Y COMP) of any vector 
FVCT >  Calculates F (Normal wind) Vectors 
QVCT > Calculates Q (Geostrophic wind) Vectors 
THTS > Calculates Saturated Theta-e 
 
ADVT [Followed by Scalar and Vector] > Calculates advection 
DVRG [Followed by a Vector] > Calculates divergence 
FLUX [Followed by a Scalar & a Vector] > Produces a flux Vector 
SDVR [Followed by Scalar and Vector] > Calculates flux divergence 
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RVRT [Followed by a Vector] > Calculates relative vorticity 



VORT [Followed by a Vector] > Calculates absolute vorticity 
IPVO > Isentropic Potential Vorticity calculated between LVL1 and LVL2 when 
       LVL1 and LVL2 are set to Theta levels. 
IPVA > Isentropic Potential Vorticity Advection calculated between LVL1 and  
       LVL2 when LVL1 and LVL2 are set to Theta levels. 
PVTA > Isobaric Potential Vorticity (Theta) calculated between LVL1 and LVL2 when 
       LVL1 and LVL2 are set to pressure levels. 
PVTE > Isobaric Potential Vorticity (Theta-E) calculated between LVL1 and LVL2 when 
       LVL1 and LVL2 are set to pressure levels. 
PVTS > Isobaric Potential Vorticity (Theta-S) calculated between LVL1 and LVL2 when 
       LVL1 and LVL2 are set to pressure levels. 
PVAA > Isobaric Potential Vorticity (Theta) Advection calculated between LVL1 and  
       LVL2 when LVL1 and LVL2 are set to pressure levels. 
PVEA > Isobaric Potential Vorticity (Theta-E) Advection calculated between LVL1 and  
       LVL2 when LVL1 and LVL2 are set to pressure levels. 
PVSA > Isobaric Potential Vorticity (Theta-S) Advection calculated between LVL1 and  
       LVL2 when LVL1 and LVL2 are set to pressure levels. 
 
SMTH > Applies a binomial smoother to the active Scalar gridded data 
VSMT > Applies a binomial smoother to the active Vector gridded data 
 
ZPOS > Sets all positive values to zero 
ZNEG > Sets all negative values to zero 
RLTN [Followed by a 4 digit value] > Replaces values Less ThaN with that value 
RGTN [Followed by a 4 digit value] > Replaces values Greater ThaN with value 
 
**- Diagnostic Functions - Cross Section Specific: 
XREL [Followed by Vector] > Rotates Vector from earth to cross sector relative 
TANG [Followed by Vector] > Finds cross-section relative tangential component 
VTNG [Followed by Vector] > Plots cross-section relative tangential component 
VCRC [Followed by Vector] > Plots VTNG & VVEL 
VCR2 [Followed by Vector] > Plots VTNG & VVEL scaled by 2 
VCR5 [Followed by Vector] > Plots VTNG & VVEL scaled by 5 
NORM [Followed by Vector] > Finds cross-section relative normal component 
VNRM [Followed by Vector] > Plots cross-section relative normal component 
 
 
**- Examples of Diagnostic Functions -  
Some sample diagnostic command sequences include: 
 
MAGN(WIND)      -  will calculate and display isotachs of the MAGNitude of the  
                                total WIND. 
SDIF(MIXR,SMIX) -  will produce the difference between the true and Saturation 
                                 MIXing Ratios  --- the saturation deficit. 
ADVT[TEMP,WIND] -  will produce the TEMPerature ADVecTion field using the total 
                                   WIND, - Note brackets/parends are interchangeable. 
ADVT TEMP GEOS  -  will produce the TEMPerature ADVecTion field using the 
                                    GEOStrophic wind, - Note brackets can be omitted 
ADVT(PRES,WIND) S982 - will set the default level to the bottom sigma level 
                   of the NGM and calculate the ADVecTion of PRESsure on a  
                   sigma surface by the WIND, a measure of the orographic  
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                   vertical motion, 



DVRG[WIND]      -  will calculate and display the DiVeRGence of the total WIND, 
SDVR(MIXR,WIND) -  will contour the Scalar flux DiVeRgence of the MIXing Ratio 
                                   using the total WIND, etc. 
 
 
**- Shorthand specifications and Commonly Used Diagnostic Functions -  
For simplicity, frequently used sequences of commands can be grouped together 
and given a 4 character ALIAS name.  These alias names can be used in exactly 
the same fashion as all other PCGRIDDS32 commands, with the difference that they 
are completely user defined in the file  USER\ALIAS.DAT.  
 
Some predefined systems aliased diagnostic commands include, 
 
WSPD > Generates isotachs for the Total wind 
WVRT > Generates vorticity of the Total wind 
GVRT > Generates vorticity of the Geostrophic wind 
THCK |TKNS| > Generates Thickness fields on levels defines by LVL1/LVL2 
THWN |TWND| > Generates Thermal Wind on levels defines by LVL1/LVL2 
 
TADV > Generates Temperature Advection using the Total wind 
QADV > Generates Mixing Ratio Advection using the Total wind 
 
 
**-Saving and Restoring Pre-Generated Graphics 
Plots can be saved for rapid redisplay by typing the command  SAVE  followed by 
a space and a 4-character file name (the qualifier .SVG will also be added 
automatically).  All plot commands are saved until the command  ENDS is used. 
To restore the saved plot file, either type  REST  followed by the file name 
(again without the .SVG qualifier) or type the file name followed by a 
semicolon.  The results will be displayed over whatever is on the screen 
already, so be sure to erase the existing graphics using  ERAS  if you do not 
want the graphics overlaid on the existing screen display.  The .SVG files can 
also be used to produce hard-copy on HP laser printers. 
 
For example, the sequence of commands - 
SAVE 500Z 
VORT WIND&HGHT SLVL  500 
ENDS 
ERAS 
REST 500Z   [This command line could alternatively be input as  500Z; ] 
 
  -  will create a .SVG file labeled 500Z.SVG, generate contours of the 500 mb 
     HeiGHT and VORTicity fields and save the plotting commands, close the .SVG 
     file, erase the screen and then restore graphics. 
 
The screen contents can be saved to a BMP-format file. The command SAVS followed by 
a space and a 4-character file name (the qualifier .BMP will be added automatically) will save the 
contents of the screen. 
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**- Repeating previous commands 
A list of the previous 21 commands input from the keyboard is given by entering 
the command  CMDS.  This command ERASES the screen.  Individual commands can be 
examined without erasing the screen by using the command  CMD#,  where # is the 
order number of the previous command, e.g., CMD2 will list the 2nd previous 
command.  For commands 10 through 21, the letters A through L are used. 
 
A previous command can be repeated by using the command  RPT#,  where again # 
refers to the order number of the previous command.  The command results can 
be overlaid on the existing graphics by including a  &  after the command.  As 
such,  RPTB&  will overlay the 11th previous command on the existing graphics. 
 
A historical record of all commands used in a particular session is stored in 
the file COMMAND.OUT.  Reference to particularly complicated commands from this 
file can simplify writing the command files to be described next. 
 
 
**-Calculating Convection and Shear Parameters 
PCGRIDDS32 can now directly calculate numerous convection and wind shear parameters.  
PCGRIDDS32 also has new flag commands to control the way the convection and shear parameters 
are calculated.  Below are the new control flags for convection: 
 
  VTMP – Virtual Temperature Correction 

All convection parameters are calculated without virtual temperature correction by default.  This      
flag enables that correction. 

   SBSI – Surface-Based Lifted Parcel Selected 
   MLSI – Mean-Layer Lifted Parcel Selected 
   MUSI – Most Unstable Lifted Parcel Selected 
   USSI – User-Selected Lifted Parcel Selected 
If no Lifted Parcel method is selected, Surface-Based Lifted Parcel is default. 
 
Examples –  
 
To calculate CAPE with virtual temperature correction and using the Mean-Layer Lifted Parcel, enter: 
   CPOS VTMP MLSI 
 
PCGRIDDS32 can also calculate various wind shear and supercell wind-motion parameters.  There is a 
new control flag for shear calculations: 
 
   **KM – Defines the Lower/Upper bounding levels in Kilometers 
 The first * (0-9) defines the lower level to use and the second * (0-9) defines the     
            upper level to use.  Therefore, a command 14KM defines the 1km to 4km layer. 
 
The wind shear Vector/Scalar diagnostics can be calculated on Pressure, Isentropic or Height layers 
defined with the SLYR command or with the **KM flag: 
 
Examples –  
 
To calculate the total shear between the isentropic layers I320 and I350, enter: 
TSHR & SLYR I320 I350 
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To calculate the right-moving storm-relative helicity through the 0-3km layer, enter: 
SRHR 03KM 
 
***************************************************************************************** 
******* NOTICE – NOTICE – NOTICE – NOTICE – NOTICE – NOTICE ******** 
***************************************************************************************** 
 
The calculations of shear and convection parameters may not exactly match what other programs 
calculate due to the variations in near surface/boundary-layer data used to calculate the parameters.  
Some calculations are very sensitive to the lower layer data.  However, the results you get with 
PCGRIDDS32 should be very close to other programs’ calculations.  Remember – the accuracy of the 
product is only as good as the data used in the calculation.  The less vertical data which is available, 
the less accurate the solution. 
 
 
 
 
**- COMMAND {MACRO} FILES - 
A command file is simply a sequence of command lines to be executed in series, 
and can be used as shorthand notations for frequently used or particularly 
complicated command sequences or to produce pre-defined products. 
 
Pre-specified sequences of command lines can be written into an ASCII file 
using any word processor.  The Command File can be given any  4  letter  NAME  
and must be followed by the qualifier ".CMD".  To execute the Command File, 
type the file NAME at the BEGINNING of a command line, followed IMMEDIATELY by 
a period.  The requested command lines will be displayed in sequence, with a 
prompt to press  [Enter]  displayed between command lines. 
 
Loops can also be set up by including the word  LOOP  alone at the beginning of 
any line of the Command File.  Loops are ended by including the command line  
ENDL.  User prompts at the end of each command line are NOT given while in LOOP 
mode. Pauses between looped command lines can be included by adding the 
commands 1SEC, 3SEC, 5SEC, 7SEC, or 9SEC, depending on the number of seconds 
desired. 
       
Annotation can also be added to any line on the screen using the  TXT#  
command.  For example,  'TXT3  This is line 3' will write the text on the third 
line of the screen. 
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**- Sample  COMMAND FILE - 
A sample Command File containing - 
 
WIND&TEMP CIN5&HGHT CI60 SLVL  850  F00  
LOOP 
WIND&TEMP CIN5&HGHT CI60  F12  
WIND&TEMP CIN5&HGHT CI60  F24 5SEC 
WIND&TEMP CIN5&HGHT CI60  F36 5SEC 
WIND&TEMP CIN5&HGHT CI60  F48 5SEC 
ENDL 
 
  -  will display the initial 850 mb heights, temperatures and winds, request 
     the user to press  [Enter], and then display a loop of the 12, 24, 36,  
     and 48 h forecasts, pausing 5 seconds between each completed graphic. 
 
 
 
 
PCGRIDDS32 Automatic Mode 
 

The following discussions describe the operation of PCGRIDDS32 in Automatic Mode. 
 
PCGRIDDS32 can be run in an automatic mode.  Within a batch file or if you are at a Windows 
Command prompt, you can enter PCGRIDDS32 followed by a listing of up to 20 PCG Data files 
followed by a single Command Macro file name.  PCGRIDDS32 will startup, load all the data files 
in the order they were listed and will execute the command macro file and will then quit.  This 
process is useful for generating PCGRIDDS32 graphics (a screen save operation) without 
needing to have a user do it by hand.  The screen save commands (SAVS) must be included in 
the command macro and the command macros cannot require any user intervention or the 
system will pause waiting for the user to enter the required data. 

 
-- Automatic Starting PCGRIDDS32  

Use the following example to initiate a PCGRIDDS32 session in Automatic Mode: 
 
  1. From the MS command line within the PCGRIDDS32 directory or within a batch file, enter: 
    c:\PCGRIDDS32> PCGRIDDS32 JL030312.ETA211 TEST.CMD 
 

All commands are separated by spaces and the last entry MUST be the name of a 
single command macro file name with the .CMD extention. 

 
 
 
Online Help 
 
-- Menu Mode 

The [F1] key is used to access ONLINE HELP when you are in Menu Mode.   
When HELP is available for a particular screen, F1 is displayed on the top line  
of the screen (function key line).  The HELP text that is displayed describes the  
current menu or form, available options, and function keys. 
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The 'Product List' menu is an exception.  No general HELP is provided.  Instead,  
you can display HELP for an individual product if it is available.  To display HELP  
for a product, position the highlight to the product and press [F1]. 

 
Once HELP is selected, you can press [PageDown] to move forward through  
the text.  You cannot page backwards through the text.  However, when you  
press [PageUp], you are positioned at the start of the text.  Use the [ESC] key  
to exit HELP. 

 
 
-- Command Mode 

HELP in Command Mode provides information about the use of individual  
PCGRIDDS32 commands.  To access the ‘HELP’ menu (Fig.28), type HELP  
or [?] on the command line followed by [Enter]. 

 
 

Fig.28 
  ┌────────────────────────────────────────────────┐ 
  │                                                │ 
  │          PCGRIDDS32  --  HELP MENU             │ 
  │                                                │ 
  │  OPTIONS   ----    INPUT DESIRED OPTION        │ 
  │                                                │ 
  │  1           COMMAND MODE TUTORIAL             │ 
  │  2           COMMAND FUNCTION SUMMARY          │ 
  │  3           ALPHABETICAL COMMAND SUMMARY      │ 
  │  4           LISTING OF BASIC GRID FIELDS      │ 
  │  5           ALPHABETICAL LIST OF BASIC GRIDS  │ 
  │  NAME        HELP FOR SPECIFIC NAMED COMMAND   │ 
  │  X           RETURN TO PCGRIDDS                │ 
  │                                                │ 
  │                                                │ 
  │OPTION?                                         │ 
  └────────────────────────────────────────────────┘ 

 
 

To select an option, type the option value at the prompt.  The option, NAME,  
refers to a four character PCGRIDDS32 command.  Once HELP is selected,  
you can press [Enter] to move forward through the text.  You cannot page  
backwards through the text.  Press [X] [Enter] to exit the HELP option. 

 
A description of the options available in the Command Mode HELP menu follows: 

 
1. COMMAND MODE TUTORIAL provides basic instructions for operating 

PCGRIDDS32 in Command Mode (refer to Appendix B). 
2. COMMAND FUNCTION SUMMARY provides a one line description  
of all the PCGRIDDS32 commands.  The commands are grouped by  
functional categories, for example, Level specification or Diagnostic  
functions (refer to Appendix C). 
3. ALPHABETICAL COMMAND SUMMARY displays the same  
information as option 2 except that the commands are arranged in  
alphabetical order. 
4. LISTING OF BASIC GRID FIELDS provides a one line description  
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of commands that directly retrieve data stored in the gridded data file  
(refer to Appendix D). 
5. ALPHABETICAL LIST OF BASIC GRIDS displays the same  
information as option 4 except that the basic grid field commands are arranged in 

alphabetical order. 
6. HELP FOR SPECIFIC NAMED COMMAND --  Type a four character  
PCGRIDDS32 command to display EXTENDED HELP for that command. 
7. RETURN TO PCGRIDDS32  --  Press [X] [Enter] to exit the ‘HELP’  
menu and return to PCGRIDDS32 in Command Mode. 

 
To obtain EXTENDED HELP from the command line, type HLPX followed by a  
four character PCGRIDDS32 command or product on the command line.  This  
displays a description of the command that is contained in its associated HELP  
file (xxxx.HLP) if it is available.  For example, to obtain an extended description  
of the LIST command, type:  HLPX LIST 

 
If less detailed HELP is desired, QUICK HELP is available directly from the  
command line.  Type HELP or [?] followed by a four character PCGRIDDS32  
command on the command line.  This displays a one line description of that  
command without disrupting the current screen display. 

 
Note: A blank must precede the PCGRIDDS32 command name.  For  
example, to obtain a description of the LIST command, type:  ? LIST 

 
 
-- Help Files 

Text for ONLINE HELP is stored in ASCII files located in the HELP directory.   
These files can be viewed, modified, or supplemented using a standard text  
editor.  They can also be printed if a hard copy is desired. 

 
The general HELP files for Menu Mode and the HELP files for Command Mode  
are provided as part of the PCGRIDDS software.  A standard set of product  
(macro) HELP files is also included.  If you add custom macros to the product  
set, you should also provide the corresponding HELP files.  Refer to the 'Defining  
Products' section for a discussion of macros. 

 
Types of HELP files: 

 
Menu  These files provide the ONLINE HELP for menus and  
   forms in PCGRIDDS32. 

 
Name The filename consists of a 5-8 character name  
  defined in the PCGRIDDS32 program followed  
  by the extension HLP.  The name of the HELP  
  file must be a minimum of 5 characters to prevent  
  confusion between product and menu HELP files.   
  The name of the HELP file should be written at  
  the end of the help text.  This allows the system  
  administrator to determine the HELP file associated  
  with a given menu. 
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Format The maximum number of characters per line is 78.   



  All lines must end with 'hard' carriage returns. 
 

Product  These files provide the EXTENDED HELP for products, commands, and 
aliases. 

 
Name The name of the file must be xxxx.HLP where xxxx is the four 

character PCGRIDDS32 command or product name. 
 

Format The maximum number of characters per line is 78.  All lines 
must end with 'hard' carriage returns. 

 
Command These files provide GENERAL HELP and QUICK HELP in Command Mode. 

 
Names --- HELP.DAT This file provides basic instructions and a 

tutorial for operating PCGRIDDS32 in 
Command Mode. 

--- HLPC.DAT This file provides a one line description of 
PCGRIDDS32 commands and aliases. 

--- HLPG.DAT This file provides a one line description of the 
basic gridded data fields. 

 
Format The maximum number of characters per line is 78.  All lines 

must end with a ‘hard’ carriage return. 
 

The characters **- at the beginning of a line indicate the start of 
a new page.  A line beginning with % indicates the end of the 
file. 

 
The files, HLPC.DAT and HLPG.DAT contain one line 
descriptions of commands or gridded data fields.  Each line must 
begin with the 4 character name of the command or data field 
that is described. 
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Customizing the PCGRIDDS32 System 
 
    Customizing WAFS GRIB Ingest 
 
 The WAFS GRIB ingest process requires the user to select the Octant(s) area of the globe which 
covers the surface area the user is interested in viewing.  The user is expected to have downloaded the 
similar GRIB data which coincides with the Octant coverage which was selected.  This is Option 3 in 
the Ingest GRIB Data Menu.   
 
-- Areas for Gridded Data Set 

The menu which contains the list of areas used for the gridded data set is stored in the ASCII 
formatted file, C:\PCGRIDDS32\GRIB\USER\OCTETS.MNU. 

 
This file can be modified using a standard text editor.  Each line in the file describes the 
latitude/longitude boundaries of an area.  The lines are displayed sequentially in groups of 
17 lines per screen.  The file can contain a maximum of 10 screens of data (170 entries). 
A maximum of 72 characters can be entered on a line.  The first 3 characters of each line in 
the menu refer to the extension of a file, C:\PCGRIDDS32\GRIB\OCTETS.xxx, that contains 
parameters which define the selected area for PCGRIDDS.  For example if you select the 
entry, ‘WSW - GRIDDED DATA for SOUTHERN HEMISPHERE Centered on Western 
Hemisphere’, the area is described in the file OCTETS.WSW.  All the OCTET files 
referenced in the default menu are provided with PCGRIDDS. 

 
PCGRIDDS32 automatically ‘numbers’ the order of appearance for each entry on the menu 
page.  All other characters displayed for the entry lines must be contained in the menu file.  
In the example below, some entries are left blank for clarity.  If the user selects a blank 
entry, PCGRIDDS32 will beep and return to the menu. 

 
The default menu file is shown below.  It contains the areas that can be formed from the octets 
available to PCGRIDDS32.  Depending on the needs of your environment, you can display the 
entire set of areas or select a subset. 

 
................ Begin file OCTETS.MNU.......................... 
                   *** WAFS AREA SELECTION MENU *** 

 
                   *** WAFS AREA SELECTION MENU *** 

 
** GRIB data for ALL required octants must be in GRIB\WAFS\OCTANT# 

 
                           --- Global Coverage --- 
WFG - GLOBE Centered on Greenwich                    (Octants=OPMNKLIJ) 
WFD - GLOBE Centered on the Date Line                (Octants=MNOPIJKL) 
WFW - GLOBE Centered on the Western Hemisphere       (Octants=NOPMJKLI) 
WFE - GLOBE Centered on the Eastern Hemisphere       (Octants=PMNOLIJK) 
                         --- Hemisphere Coverage --- 
WNG - NORTHERN HEMISPHERE Centered on Greenwich          (Octants=KLIJ) 
WND - NORTHERN HEMISPHERE Centered on the Date Line      (Octants=IJKL) 
WNW - NORTHERN HEMISPHERE Centered on Western Hemisphere (Octants=JKLI) 
WNE - NORTHERN HEMISPHERE Centered on Eastern Hemisphere (Octants=LIJK) 
WSG - SOUTHERN HEMISPHERE Centered on Greenwich          (Octants=OPMN) 
WSD - SOUTHERN HEMISPHERE Centered on the Date Line      (Octants=MNOP) 
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WSW - SOUTHERN HEMISPHERE Centered on Western Hemisphere (Octants=NOPM) 
WSE - SOUTHERN HEMISPHERE Centered on Eastern Hemisphere (Octants=PMNO) 
                            --- Selected Areas --- 
PL2 - The Caribbean and the Americas                    (Octants=PL) 
OK4 - The Pacific and the Americas                      (Octants=OPKL) 
MI4 - Europe,Africa and Western Asia                    (Octants=MNIJ) 
                  --***-- Northern Hemispheric Areas --***-- 
WI1 - AREA between  30W to  60E and  0N to 90N          (Octants=I) 
WI2 - AREA between  30W to 150E and  0N to 90N          (Octants=IJ) 
WI3 - AREA between  30W to 120W and  0N to 90N          (Octants=IJK) 
WI4 - AREA between  30W to  30W and  0N to 90N          (Octants=IJKL) 
WJ1 - AREA between  60E to 150E and  0N to 90N          (Octants=J) 
WJ2 - AREA between  60E to 120W and  0N to 90N          (Octants=JK) 
WJ3 - AREA between  60E to  30W and  0N to 90N          (Octants=JKL) 
WJ4 - AREA between  60E to  60E and  0N to 90N          (Octants=JKLI) 
WK1 - AREA between 150E to 120W and  0N to 90N          (Octants=K) 
WK2 - AREA between 150E to  30W and  0N to 90N          (Octants=KL) 
WK3 - AREA between 150E to  60E and  0N to 90N          (Octants=KLI) 
WK4 - AREA between 150E to 150E and  0N to 90N          (Octants=KLIJ) 
WL1 - AREA between 120W to  30W and  0N to 90N          (Octants=L) 
WL2 - AREA between 120W to  60E and  0N to 90N          (Octants=LI) 
WL3 - AREA between 120W to 150E and  0N to 90N          (Octants=LIJ) 
WL4 - AREA between 120W to 120W and  0N to 90N          (Octants=LIJK) 
 
                  --***-- Southern Hemispheric Areas --***-- 
WM1 - AREA between  30W to  60E and 90S to  0N          (Octants=M) 
WM2 - AREA between  30W to 150E and 90S to  0N          (Octants=MN) 
WM3 - AREA between  30W to 120W and 90S to  0N          (Octants=MNO) 
WM4 - AREA between  30W to  30W and 90S to  0N          (Octants=MNOP) 
WN1 - AREA between  60E to 150E and 90S to  0N          (Octants=N) 
WN2 - AREA between  60E to 120W and 90S to  0N          (Octants=NO) 
WN3 - AREA between  60E to  30W and 90S to  0N          (Octants=NOP) 
WN4 - AREA between  60E to  60E and 90S to  0N          (Octants=NOPM) 
WO1 - AREA between 150E to 120W and 90S to  0N          (Octants=O) 
WO2 - AREA between 150E to  30W and 90S to  0N          (Octants=OP) 
WO3 - AREA between 150E to  60E and 90S to  0N          (Octants=OPM) 
WO4 - AREA between 150E to 150E and 90S to  0N          (Octants=OPMN) 
WP1 - AREA between 120W to  30W and 90S to  0N          (Octants=P) 
WP2 - AREA between 120W to  60E and 90S to  0N          (Octants=PM) 
WP3 - AREA between 120W to 150E and 90S to  0N          (Octants=PMN) 
WP4 - AREA between 120W to 120W and 90S to  0N          (Octants=PMNO) 

 
                --***-- Rectangular Pole-to-Pole Areas --***-- 
MI2 - AREA between  30W to  60E and 90S to 90N        (Octants=MI) 
MI4 - AREA between  30W to 150E and 90S to 90N        (Octants=MNIJ) 
MI6 - AREA between  30W to 120W and 90S to 90N        (Octants=MNOIJK) 
MI8 - AREA between  30W to  30W and 90S to 90N        (Octants=MNOPIJKL) 
NJ2 - AREA between  60E to 150E and 90S to 90N        (Octants=NJ) 
NJ4 - AREA between  60E to 120W and 90S to 90N        (Octants=NOJK) 
NJ6 - AREA between  60E to  30W and 90S to 90N        (Octants=NOPJKL) 
NJ8 - AREA between  60E to  60E and 90S to 90N        (Octants=NOPMJKLI) 
OK2 - AREA between 150E to 120W and 90S to 90N        (Octants=OK) 
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OK4 - AREA between 150E to  30W and 90S to 90N        (Octants=OPKL) 
OK6 - AREA between 150E to  60E and 90S to 90N        (Octants=OPMKLI) 
OK8 - AREA between 150E to 150E and 90S to 90N        (Octants=OPMNKLIJ) 
PL2 - AREA between 120W to  30W and 90S to 90N        (Octants=PL) 
PL4 - AREA between 120W to  60E and 90S to 90N        (Octants=PMLI) 
PL6 - AREA between 120W to 150E and 90S to 90N        (Octants=PMNLIJ) 
PL8 - AREA between 120W to 120W and 90S to 90N        (Octants=PMNOLIJK) 
................ End file OCTETS.MNU.......................... 

 
 
 
Customizing PCGRIDDS32  
 
You can customize the basic operation of PCGRIDDS32 by modifying the files in the 
C:\PCGRIDDS32\USER directory.  Unless otherwise specified, all files discussed in this section reside 
in the C:\PCGRIDDS32\USER directory.  Many files contain internal documentation that describes each 
item and its range of acceptable values.  It is IMPERATIVE that you make the data entries at the 
specified line and column of the file. 

Note: The documented files identify a line number and an entry number for each data entry. The line position of an 
entry should not be changed except in very special cases.  If for any reason the line position of a data entry is 
changed, the change in the input line number must be recorded by your system administrator in 
C:\PCGRIDDS32\DATA\FILTBL.DAT.  The entry numbers indicate the order in which the line numbers are 
recorded in this file . 

 
 
-- PCGRIDDS32 Configuration 

The file, PCGMODE.DAT, contains the most basic information about the requirements of your 
PCGRIDDS32 environment.  This includes the default operating mode (Menu or Command), the 
location of the gridded data files, the default name of the map base file, and printing 
specifications.  Refer to the file itself for a description of each item and its acceptable values.  A 
sample file is shown below. 
 

 
 102



….............. Begin file PCGMODE.DAT ..................... 
'MENU' 
'C:\PCGRIDDS32\GRIDDATA' 'C:\PCGRIDDS32\GRIDDATA' 
'FEET' 
'WORLD' 
'<' '^' '>' 
12 30 6 
'C:\PCGRIDDS32\PRTFIL\' 
'SCRN' 
1.0 
'BLKW' 
'LT'  
'L'  
8 
6 
'LPT1' 
'CMDMENU.017' 
'EXT' 
**************** File structure documentation *********************** 
LINE 1 (Entry 1)   PCGRIDDS32 startup mode 
       ENTER:  'MENU' or 'CMD.'    (Use single quotes) 
               'MENU'= PCGRIDDS32 will start up in MENU mode 
               'CMND'= PCGRIDDS32 will start up in COMMAND mode 

 
LINE 2 (Entry 2)   Source and destination directories for forecast  
                   data 
       ENTER:  SOURCE DIRECTORY (1) for forecast data displayed 
               by PCGRIDDS32 followed by DESTINATION DIRECTORY (2) 
               for forecast data converted from GRIB to PCGRIDDS  
               format.  (Use single quotes) 
               Entries on the line have the format: 
                   'd:\xxxxxxxx\yyyyyyyy' 'd:\xxxxxxxx\yyyyyyyy' 
               Where d is the drive letter, xxxxxxxx is the directory, 
               and yyyyyyyy is the subdirectory that contains the 
               forecast data.   
               The path name can contain a maximum of 20 characters. 
               The directory and subdirectory names are optional.   
               Separate SOURCE DIRECTORY (1) from DESTINATION  
               DIRECTORY (2) by one or more spaces. 
               NOTE:  Entries for the two directories may have the  
                      same value.  If the DESTINATION DIRECTORY (2)  
                      is omitted, then the SOURCE DIRECTORY (1) is used. 

 
    LINE 3 (ENTRY 11)  Height Scale 
           ENTER:  '****'=   This entry is for the HEIGHT displays to display 
             height data in meters or feet 
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LINE 4 (Entry 3)   Map base file name 
       ENTER:  'xxxxxxxx'   (Use single quotes) 
               Where xxxxxxxx is the name (1-8 characters) of the map 
               base file.  Do not include the directory or the file 
               extension. The file must be in the directory 'DATA' and 
               have the extension 'MAP'.  The name entered on line 4 
               will be the default value used when PCGRIDDS32 is 
               started.  It can be changed during the execution of 

       PCGRIDDS with the 'BSMP' command. If you wish to use the new      
       high resolution map files, which would be listed in the       
       MAPFILE.DAT, you must enter ‘OTHER’ on Line 4. 

 
 

Line 5 (Entry 15)  Time looping control characters 
       ENTER:  'b' 'c' 'f'    (USE SINGLE QUOTES) 
               'b' is the backward time loop character; default='<' 
               'c' is the current time loop character; default='^' 
               'f' is the forward time loop character; default='>' 
                   The above control characters should be changed only 
                   if the default character is not on the keyboard.  
                   Most ASCII characters (34<code<256) can be used 
               except for ?(63), .(46), :(58), &(38), and \(92). 

 
LINE 6 (Entry 13)  Initial time looping values 
       ENTER:  b# e# d# 
               b#  is the beginning forecast hour 
               e#  is the ending forecast hour 
               d#  is the hour increment 

 
    LINE 7 (Entry 15)  Print Save Directory (max 60 characters) 
 
 LINE 8 (Entry 4)   Type of print output 

                   *** Used for printing within PCGRIDDS and 'Delayed  
                       PostScript Print'; does NOT apply to  
                       'HP Compatible Print' *** 
       ENTER:  'POST' or 'SCRN'    (Use single quotes) 
               'POST'=    Print output will be sent to a PostScript 
                          printer 
               'SCRN'=    A screen dump will be sent to the printer.  It 
                          will not work on a PostScript printer unless 
                          the printer is set to automatically detect and 
                          switch modes.   
                          Note:  If you use this setting, you must add  
                                 the 'GRAPHICS' command to your 
                                 AUTOEXEC.BAT file. 

 
LINE 9 (Entry 5)   Aspect ratio adjustment -- Keeps the proportions of 
                   the printed plot the same as on the screen  
                   *** Used if Entry 4='SCRN' or with PRSC command *** 
       ENTER:  Y_FACTOR of the printer for screen dump 
               Y_FACTOR = .75 (X_UNADJ/Y_UNADJ) 
                          X_UNADJ,Y_UNADJ are the X,Y dimensions of 
                          the box surrounding a plot that is produced 
                          using A Y_FACTOR=1.0 

 
LINE 10 (Entry 6)   Color capability of PostScript printer 
                   *** Used ONLY if Entry 4='POST'; does NOT apply to  
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                       'HP Compatible Print' *** 



       ENTER:  'BLKW', 'COLR' or 'NOPS' (Use single quotes) 
               'BLKW' = Black and white PostScript printer 
               'COLR' = Color PostScript printer 
               'NOPS' = No PostScript printer 

 
LINE 11 (Entry 7)  Paper Size 
                   *** Used ONLY if Entry 4='POST'; does NOT apply to  
                       'HP Compatible Print' *** 
       ENTER:  'LT', 'LG' or 'A4'  (Use single quotes) 
               'LT' = Paper size is letter (8.5in x 11in) 
               'LG' = Paper size is legal (8.5in x 14in) 
               'A4' = Paper size is A4 (210mm x 297mm) 

 
LINE 12 (Entry 8)  Paper Orientation 
                   *** Used ONLY if Entry 4='POST'; does NOT apply to  
                       'HP Compatible Print' *** 
       ENTER:  'P' or 'L'    (Use single quotes) 
               'P' = Print plot in portrait mode 
               'L' = Print plot in landscape mode 

 
LINE 13 (Entry 9)  Text size for plot labels 
                   *** Used ONLY if Entry 4='POST'; does NOT apply to  
                       'HP Compatible Print' *** 
       Enter an integer number to indicate the text size used for the  
       labels written underneath the plot.  The recommended value is 8 
       points. 

 
LINE 14 (Entry 10) Number of label lines printed 
                   *** Used ONLY if Entry 4='POST'; does NOT apply to  
                       'HP Compatible Print' *** 
       Enter an integer number to indicate the maximum number of text 
       lines allowed underneath the plot.  For text size=8 and letter 
       size paper in landscape mode, the recommended value is 6.  The 
       number of lines specified by this parameter can sometimes affect 
       the size of the plot.  The maximum number of text lines and the 
       text size determine the proportion of the available paper height 
       that must be used for labels.  The remainder is available to use 
       for the plot. 

 
LINE 15 (Entry 12) Printer port 
                   *** Used to load the DOS PRINT command for 'Delayed 
                       PostScript Print' with standalone printers *** 
       ENTER:  'LPT#' or 'COM#'  (Use single quotes) 
       'LPT#'= The parallel [LPT] port where the printer is attached. 
               # is the id number of the specific port, for example, 
               'LPT1' or 'LPT2'.  The default port is LPT1.   
       'COM#'= the serial [COM] port where the printer is attached. 
               # is the id number of the specific port, for example,  
               'COM1' or 'COM2'. 
                
LINE 16 (Entry 16) Interactive work menu file 
        ENTER:  'CMDMENU.xxx'  (Use single quotes) 
                where xxx is the extension of the command menu file  
                where user selected interactive work menu entries  
                are saved.  The extension is the number of the line 
                in the file CMDMENU.LST that contains the entry for 
                the interactive work menu.  The value of xxx may range  
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                from '001' to '099'. 



 
LINE 17 (Entry 17) Sort order for list of forecast data filenames in 
                   Menu mode 
        ENTER:  'NAM' or 'EXT'    (Use single quotes) 
                'NAM'= Sort by filename, then by extension 
                'EXT'= Sort by extension, then by filename 
................. End file PCGMODE.DAT .............................. 

 
 
-- Model Origination and Flight Levels for Labels 

The file, PCGLBL.USR, provides information that PCGRIDDS32 uses to customize the labels 
which describe output from the products (refer to 'Defining Products').  The file contains the model 
and plot origination for the LFO# label command.  It also contains a corresponding list of pressure 
levels (hPa) and flight levels for the LFL# label command.  Refer to the file for a description of 
each item and its acceptable values.  A sample file is shown below. 

 
................ Begin file PCGLBL.USR .............................. 
'DOC/NOAA/NWS    WAFC-WASHINGTON' 
LINE 1 (Entry 1) MODEL AND PLOT ORIGINATION 

THE TEXT IS DISPLAYED IN THE PLOT LABEL WHEN THE LFO# 
COMMAND IS USED.  THE TEXT MUST BE ENCLOSED IN QUOTES. 

********************************************************************* 
850,700,500,400,300,250,200,150,100, 70,  -1,-1,-1,-1,-1 
050,100,180,240,300,340,390,450,530,450,  -1,-1,-1,-1,-1  
LINE 7 (Entry 2) LIST OF PRESSURE LEVELS (UNITS=hPa). 
LINE 8 (Entry 3) LIST OF FLIGHT LEVELS THAT CORRESPOND TO THE PRESSURE LEVELS 

IN LINE 7.  
THE TEXT IS DISPLAYED IN THE PLOT LABEL WHEN THE LFL# 
COMMAND IS USED.  EACH VALUE MUST BE SEPARATED BY A 
COMMA.  VALUES FOR ALL 15 LEVELS MUST BE ENTERED.  A 
VALUE OF -1 INDICATES THAT NO VALUE IS DEFINED FOR THAT 
POSITION.  ALL THE UNDEFINED POSITIONS MUST BE AT THE 
END OF THE LIST AND MUST CONTAIN -1. 

............... End file PCGLBL.USR ................................. 
 
 
-- Initial Pressure Levels and Forecast Hours 

When PCGRIDDS32 starts, the level and time specifications are set to the default values defined 
in the file INITGRID.SPC. 

 
Line 1 Pressure level, vertical layer, forecast hour, and time range are defined on line 1 of the 

file.  Each of the 6 fields has a length of 4 characters. 
 

Line 2 The pressure levels used for time-section and cross-section plots are defined on line 2 
of the file.  A maximum of 19 pressure levels can be entered.  The number of pressure 
levels entered (field 1) has a length of 2 characters and can have a value between 1 
and 19.  Each of the pressure level fields has a length of 4 characters.  The number of 
pressure level fields you actually enter must agree with the number of levels you 
specify in field 1. 

 

 
 106



Line 3 The forecast hours used for time-section plots are defined on line 3 of the file.  A total 
of 19 forecast hours MUST be entered.  If you wish to define fewer hours, the 
remaining values must be set to zero.  The number of hours defined (field 1) has a 
length of 2 characters.  Each of the hour values (fields 2-20) has a length of 4 
characters.  The increment between selected hour fields (field 21) has a length of 2 
characters.  This increment determines which of the defined hour fields will actually be 
used by PCGRIDDS32 for time-section plots.  Refer to 'Changing Forecast Hours for 
Time-section Plots' for a discussion of the effect these values have on the plot display. 

 
Each line of the file must begin in column 1.  Values must be right justified within their field.  There 
are no spaces between the fields.  Numerical values are expressed as integers with no decimal 
point. 

 
Below is a sample INITGRID.SPC file.  The lines are formatted as described above. 

 
 2501000 500  12   0  24 
101000 850 700 500 400 300 250 200 150 100 
13  36  33  30  27  24  21  18  15  12  09  06  03  00  00  00  00  00  00  00 2 

 
This second example contains the same data as the previous sample file, but with the field 
positions indicated below each line for clarity.  The lines are grouped into pairs.  The first line is 
the file entry.  The second line indicates the field positions for reference, but is not actually 
entered into the file. 

 
 2501000 500  12   0  24 
111122223333444455556666 
101000 850 700 500 400 300 250 200 150 100 
112222333344445555666677778888999900001111 
13  36  33  30  27  24  21  18  15  12  09  06  03  00  00  00  00  00  00  00 2 
11222233334444555566667777888899990000111122223333444455556666777788889999000011 

 
This example defines the following initial specifications: 

 
Pressure level:  250 hPa 
Vertical layer:  1000 hPa-500 hPa 
Forecast hour:  12 
Time range:  0-24 
10 Pressure levels: 1000 850 700 500 400 300 250 200 150 100 
13 Forecast hours: 36  33  30  27  24  21  18  15  12  09  06  03  00   

The field increment of 2 selects 7 hours:  36 30 24 18 12 6 0 
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-- Changing Width of a Cross-section Plot 
By default, cross-sections are displayed in proportion to the vertical height.  As a result, very 
narrow cross-sections may cover a small portion of the screen width.  To control the width of the 
cross-section display while the program is in execution, you can use one of the following 
commands: 

 
XNRO Displays the cross-section in proportion to vertical height 

 
XWID Displays the cross-section in proportion to the vertical height 

 
Both of these commands must be entered in PLAN view. 

 
 
-- Changing Pressure Levels for Cross-section and Time-section Plots 

PCGRIDDS32 initializes the pressure levels used for cross-section and time-section plots from 
the default set of values defined in the file INITGRID.SPC.  The information specified in this file 
includes the number of levels defined and the level values.  To change this default set of levels 
while the program is in execution, you can use the command 'XLVL xxxx', where xxxx is a 4 
character file name (xxxx.LVL).  Once a set of pressure levels is defined, it will remain in effect 
until a new set is defined with the 'XLVL' command. 

 
MAND.LVL is a sample file that defines the values of the pressure levels used for time-section 
and cross-section plots using only mandatory pressure levels.  The number of pressure levels 
entered and the value of each level are entered on line 1 of the file starting in column 1.  A 
maximum of 19 pressure levels can be defined.  The number of pressure levels entered (field 1) 
has a length of 2 characters while each of the pressure level fields has a length of 4 characters.  
The actual number of pressure level fields you enter must agree with the number of levels you 
specify in field 1.  The values must be right justified within the field.  There are no additional 
spaces between the fields.  Numerical values are expressed as integers without decimal points. 

 
In the example shown below, the first line is the actual file entry.  The second line indicates the 
field positions for clarity, but is not actually entered into the file. 
 

101000 850 700 500 400 300 250 200 150 100 
112222333344445555666677778888999900001111 

 
This example defines 10 pressure levels:  1000 850 700 500 400 300 250 200 150 100. 

 
 
-- Changing Forecast Hours for Time-section Plots 

PCGRIDDS32 initializes the forecast hours used to generate time-section plots with the default 
set of values defined in the file INITGRID.SPC.  The information specified in this file includes the 
number of hours defined, the hour values and the time increment  The time increment determines 
which of the defined hour fields will actually be used by PCGRIDDS32 for time-section plots.  You 
can use the command 'THRS xxxx', where xxxx is a 4 character file name (xxxx.HRS), to change 
the default set of hours while the program is executing.  Once a set of hours is defined, it will 
remain in effect until a new set is defined with the 'THRS' command.  The time increment is 
defined in the .HRS file, but it can be changed independently with the 'TINC ####' command, 
where #### is the time increment. 

 
36HR.HRS is a sample file that defines the forecast hours used for time-section plots.  The 
number of hours defined, the hour values and the time increment are entered on line 1 of the file 
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starting in column 1.  A total of 19 forecast hours MUST be entered.  If you wish to define fewer 
hours, the remaining values must be set to zero.  The number of hours defined (field 1) has a 
length of 2 characters.  Each of the hour values (fields 2-20) has a length of 4 characters.  The 
increment between selected hour fields (field 21) has a length of 2 characters.  The values must 
be right justified within the field.  There are no spaces between the fields.  Numerical values are 
expressed as integers. 

 
In the example shown below, the first line is the actual file entry.  The second line indicates the 
field positions for clarity, but is not actually entered into the file.  All the data must be entered on 
the first line of the file. 
 

13  36  33  30  27  24  21  18  15  12  09  06  03  00  00  00  00  00  00  00 2 
11222233334444555566667777888899990000111122223333444455556666777788889999000011 

 
This example defines 13 times:  36  33  30  27  24  21  18  15  12  09  06  03  00.  The time 
increment of 2 selects 7 times (36 30 24 18 12 6 0) that are actually used to create displays. 

 
Note that the number of times defined is also used to control the width of the time-section screen 
displays.  The time-section plot is scaled so that up to 19 times can be displayed across the full 
width of the screen.  If you define fewer times, the display is centered but covers less of the 
screen width, as illustrated in the following examples. 
 
Example 1: This file entry defines only 4 times (30,24,18,12).  The time increment of 1 

specifies all four hours for data selection.  The data for hours 30,24,18,12 are 
displayed from the top to the bottom of the screen, but only across the center 
4/19 of the horizontal screen width. 

 
04  30  24  18  12  00  00  00  00  00  00  00  00  00  00  00  00  00  00  00 1 
11222233334444555566667777888899990000111122223333444455556666777788889999000011 

 
Example 2: This file entry defines 7 times (30,27,24,21,18,15,12).  The time increment of 2 

specifies only four of the times (30, 24,18,12) for data selection.  The data used 
to create the displays come from the same hours as example 1 (30,24,18,12), 
but are now displayed across 7/19 of the screen because more hours were 
defined. 

 
07  30  27  24  21  18  15  12  00  00  00  00  00  00  00  00  00  00  00  00 2 
11222233334444555566667777888899990000111122223333444455556666777788889999000011 

 
Example 3: This file entry defines 10 times (30,28,26,24,22,20,18,16,14,12).  The time 

increment of 3 still specifies the same hours for data selection as Example 1 
(30,24,18,12), but now the data are displayed across 10/19 of the screen. 

 
10  30  28  26  24  22  20  18  16  14  12  00  00  00  00  00  00  00  00  00 3 
11222233334444555566667777888899990000111122223333444455556666777788889999000011 
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-- Station Id List 
The list of station id’s used to define a display mode (refer to ‘Display Menu’) is contained in the 
file, C:\PCGRIDDS32\DATA\STNID.DAT.  If necessary, your system administrator can add 
additional station id’s to the end of the file.  The following items must be entered for each station 
you add: 

 
Station id  3 or 4 character id; a 3 character id must be contain a leading blank (e.g., 

_ADS).  Use uppercase letters. 
 

Latitude  Real number of the form ###.## (e.g., _35.23); North latitudes are positive; 
South latitudes are negative. 

 
Longitude  Real number of the form ####.## (e.g., -101.70); East longitudes are 

positive; West longitudes are negative. 
 

It is imperative that new entries be aligned with the current values in the file. 
 
 
-- User Defined Alias Commands 

PCGRIDDS32 performs computations using internally defined basic commands and combinations 
of these basic commands called alias commands.  An alias command can be defined in terms of 
basic PCGRIDDS32 commands and other alias commands.  It is useful to define alias commands 
when you repeatedly execute a group of PCGRIDDS32 commands or if you want to create a 4-
letter command that is more appropriate to an international user. 

 
Basic systems alias commands are defined in the file, C:\PCGRIDDS32\DATA\ALIAS.DAT, and 
SHOULD NOT BE MODIFIED.  You can expand the number of available alias commands by 
making an entry in the file, ALIAS.USR, in the C:\PCGRIDDS32\USER directory.  The format of 
the entry is 

 
xxxx=aaaa bbbb cccc ... oooo 

 
where 'xxxx' is the 4 character alias and 'aaaa bbbb cccc ... oooo' is the series of PCGRIDDS32 
and other alias commands that define the new alias.  All entries must be in uppercase and 
have the exact format specified above.  The definition may contain a maximum of 15 
commands/aliases and must be entered on one line of the file starting in column 1.  An alias 
definition must not reference a macro (refer to 'Defining Products').  It can, however, be used in a 
macro.  An alias command must not duplicate a PCGRIDDS32 command name or system alias.  
Once an alias is entered into ALIAS.USR, it can be used like any PCGRIDDS32 command. 

 
A sample alias command that plots the vector wind as barbs is shown below. 

 
WNDB=BARB WIND 

 
Alias commands can also be used to translate PCGRIDDS32 commands for international users. 

 
VENT=WIND (French) 
VNTO=WIND (Spanish/Portuguese) 
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-- GRIB Specifications for Data Ingest 
The ingest process requires information relating GRIB identification values to convert model, grid, 
level, and parameter identifiers to the corresponding PCGRIDDS32 identifiers.  Lists of these 
relationships are provided by the following set of files which reside in the GRIB directory.  For 
most users, the default values contained in these files are sufficient.  However, they may be 
modified if a required relationship was omitted. 

 
GRIBMODL.DAT 

This file is composed of entries containing a GRIB model value and its corresponding 
PCGRIDDS32 character model identifier.  The GRIB model value is expressed as 3 numeric 
characters beginning in column 1.  This is followed by the PCGRIDDS32 model id which 
consists of 3 alphanumeric characters beginning in column 5. 

 
The PCGRIDDS32 model identifier has the following functions. 

 
1. The model id followed by a 1 character grid id forms the 4 character 

PCGRIDDS32 model name which is used to reference information in the green 
area at the bottom of the screen while in Menu mode. 

 
2. The first 2 characters of the PCGRIDDS32 model id followed by a 1 character 

grid id form the 3 character extension of the NWS and WAFS data file name. 
 

Note: Some models, analyses, and/or forecasts from the same model run may be assigned 
different GRIB model values.  To collate this data into a single PCGRIDDS32 
data set, these different GRIB model values are given the same PCGRIDDS32 
model identifier. 

 
GRIBSPEC.DAT 
         This file is obsolete in PCGRIDDS32 and is no longer used. 
 
GRID.DAT         

This file is composed of entries relating a GRIB grid identification value to a corresponding 
PCGRIDDS32 grid identifier.  The PCGRIDDS32 grid identifier is used in conjunction with 
the PCGRIDDS32 model identifier as described above. 

 
A portion of GRID.DAT is listed below.  The first line indicates the field positions for clarity, 
but is not actually entered into the file.  Note that there can be multiple entries for some 
GRIB grid identifiers.  When this situation occurs, the first entry in the file for a given GRIB 
grid identifier is processed and the remaining entries (included only for historical purposes) 
are ignored. 

 
111 2 ______________33333333333333333333333333333333 
212 4               AWIPS 40KM FULL GRID 
212 4               AWIPS 40KM SUBSETTED GRID 
211 8               AWIPS 80KM FULL GRID 
211 8               AWIPS 80KM SUBSETTED GRID 
  6 L               LFM GRIDS 
101 G               NGM 'OLD' C-GRID 
104 S               NGM SUPER C-GRID 
105 C               NGM '83' C-GRID 
201 H               AWIPS NORTH HEMISPHERIC GRID 
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A sample entry (line 2 in the above sample file) and a description of each field in the entry is 
shown in the following table.  Optional fields must be blank filled if they are not used. 

 
 
Example 

 
Field 

 
Description 

 
Start 
column 

 
Number of 
characters 

 
Character 
type 

 
212 

 
1 

 
GRIB grid identification number 

 
1 

 
3 

 
Numeric 

 
4 

 
2 

 
PCGRIDDS32 grid identifier 

 
5 

 
1 

 
Text 

 
AWIPS 40KM 
SUBSETTED 
GRID 

 
3 

 
Grid description-optional 

 
20 

 
N/A 

 
Text 

 
 

GRIBPARM.DAT and MOSGRIBPARM.DAT 
These files are composed of entries relating GRIB parameter identifiers to corresponding 
PCGRIDDS32 parameter names.  The PCGRIDDS32 parameter name followed by the 
PCGRIDDS32 level identifier is then used to form the 8 character PCGRIDDS32 field name 
(e.g., TEMPB015).  GRIBPARM.DAT is used for WAFS and NWS general GRIB file 
processing and MOSGRIBPARM.DAT is only used for MOS GRIB processing due to the 
different parameters which pertain to MOS data. 

 
A portion of GRIBPARM.DAT is listed below.  The first line indicates the field positions for 
clarity, but is not actually included in the file. The MOSGRIBPARM.DAT layout is similar. 

 
111 2222 3333 444 55555555555555555555555 
001 PRES       -2 PRESSURE 
002 PRES  MSL  -2 MEAN SEA LEVEL PRESSURE 
003 PTND       -2 PRESSURE TENDENCY 
007 HGHT          HEIGHT - GEOPOTENTIAL 
008 GHGT          HEIGHT - GEOMETRIC 
010 OZON          TOTAL OZONE 
011 TEMP          TEMPERATURE 
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A sample entry (line 2 in the above example) and a description of each field in the entry is 
shown in the following table.  Optional fields must be blank filled if they are not used.  The 
level override is used to set a standard level when there are potentially conflicting levels in 
the GRIB message.  If a level override is given, that value is used in place of the 
PCGRIDDS32 level identifier.  The ‘power of 10' scale factor is used to convert the data 
from the units used in the GRIB message to those desired for PCGRIDDS32.  It is the user’s 
responsibility to assure that the final scaled value is within the floating point range of -
3.4E+38 to +3.4E+38. 
 

 
 
Example 

 
Field 

 
Description 

 
Start 
column 

 
Number of 
characters 

 
Character type 

 
001 

 
1 

 
GRIB parameter identifier 

 
1 

 
3 

 
Numeric 

 
PRES 

 
2 

 
PCGRIDDS parameter name 

 
5 

 
4 

 
Alphanumeric 

 
MSL 

 
3 

 
Level override (optional) 

 
10 

 
4 

 
Alphanumeric 

 
-2 

 
4 

 
Power of ten scale factor (optional) 

 
15 

 
3 

 
Signed integer 

 
MEAN SEA 
LEVEL 
PRESSURE 

 
5 

 
Parameter description (optional) 

 
19 

 
N/A 

 
Text 

 
 

GRIBLEVL.DAT 
This file is composed of entries containing a numeric GRIB level value and its corresponding 
PCGRIDDS32 character level identifier.  Only information for special levels is contained in 
this file.  PCGRIDDS32 identifiers for other levels are described in the section ‘Variables for 
Gridded Data Set’.  The PCGRIDDS32 parameter name followed by the PCGRIDDS32 level 
identifier form the 8 character PCGRIDDS32 field name. 

 
The GRIB level value is expressed as 3 numeric characters beginning in column 1.  This is 
followed by the PCGRIDDS32 level id which consists of 4 alphanumeric characters 
beginning in column 5.  No PCGRIDDS32 level id can begin with zero except for the 
currently used values of 0000, 0DEG, 0DGX. 

 
-- Map Type Specifications 
 
        The MAPTYPE.DAT file is obsolete in PCGRIDDS32 and is not required for the processing of the    

PCG Version 2 data files.  HOWEVER – If you wish to display PCG Version 1 data files created      
with the DOS versions of PCGRIDDS, you MUST copy the MAPTYPE.DAT file from your 
PCGRIDDS program into PCGRIDDS32 for PCGRIDDS32 to accurately display the Version 1 
files.  Please refer to the DOS PCGRIDDS documentation concerning the explaination of the 
MAPTYPE.DAT file fields  
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 Menu Colors 
 
   Menu colors within PCGRIDDS32 are fixed and can not be changed. 
 
-- Streamline Setup Parameters 

 
          When PCGRIDDS32 is commanded to plot winds in Streamline mode, it reads the file: 

 USER/STREAMLN.DAT.  PCGRIDDS32 reads the parameters within this file to determine the     
 way the streamlines will look.  Below is a printout of the file STREAMLN.DAT along with the  
 definitions of the parameters.  The user is free to modify this file to adjust the streamline display.    
It is recommended that if the user wishes to modify this file, they make a backup copy in case  
their modifications render the display unusable and it is needed to return to the default settings. 
 
STREAMLIN.DAT 
 
1.00                    Filter to thin streamlines 
1.50                    Filter to thin streamline arrows  
0.50                    Controls stopping of streamline when near another streamline 
0.67                    Controls stopping of streamline when wind speed is small 
0.33                    Controls pre-scaling of vectors 
0.25                    Controls size of streamline arrow head 

 
 

-- Background Map Selection 
 
 New to PCGRIDDS32, there are many new high resolution map files with a variety of different 
features which can be used.  A new file has been created in the \PCGRIDDS32\USER directory called 
MAPFILE.DAT.  The names of the new map files which the user wishes to display are listed in this file.  
The PCGMODE.DAT file must be modified to enable the use of the new map files.  Line 4 is the Map 
Base File name and must be modified.  See the example below: 

….............. Begin file PCGMODE.DAT ..................... 
'MENU' 
'C:\PCGRIDDS32\GRIDDATA' 'C:\PCGRIDDS32\GRIDDATA' 
'FEET' 
'OTHER' 
'<' '^' '>' 
12 30 6 
'C:\PCGRIDDS32\PRTFIL\' 
'SCRN' 
1.0 
'BLKW' 
'LT'  
'L'  
8 
6 
'LPT1' 
'CMDMENU.017' 
'EXT' 
**************** File structure documentation *********************** 

 
                <<<<<< entries 1-3 snipped >>>>>> 
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LINE 4 (Entry 3)   Map base file name 
       ENTER:  'xxxxxxxx'   (Use single quotes) 
               Where xxxxxxxx is the name (1-8 characters) of the map 
               base file.  Do not include the directory or the file 
               extension. The file must be in the directory 'DATA' and 
               have the extension 'MAP'.  The name entered on line 4 
               will be the default value used when PCGRIDDS32 is 
               started.  It can be changed during the execution of 

       PCGRIDDS with the 'BSMP' command. If you wish to use the new      
       high resolution map files, which would be listed in the       
       MAPFILE.DAT, you must enter ‘OTHER’ on Line 4. 

 
 
There are 3-4 origional maps which may be listed in the PCGMODE.DAT line 4. They are 
ALASKA.MAP, USA.MAP, WORLD.MAP and some users have WORLD2.MAP.  In order to use the 
new map files, line 4 MUST have the word OTHER with single quotes ( ‘’ ).  In the MAPFILE.DAT, you 
list the new map file names you wish to display.  You can list multiple files for display.  Below is a list of 
the new map files and what they display: 
 
AFRICABOUND – Africa boundaries and lakes 
AFRICARIVER – Africa rivers 
ASIABOUND – Asia, Australia and Pacific Islands boundaries 
ASIARIVER – Asia and Australia rivers 
COUNTY – US Counties 
COUNTY2 – US Counties 
EUROPEBOUND – Europe boundaries and lakes 
EUROPERIVER – Europe lakes 
HRWO – Hi-Resolution World Outlines 
HRWOB – Hi-Resolution World Outlines  
HRUSS – Hi-Resolution US Streams 
LRUSR – Lo-Resolution US Rivers 
MRUSR – Med-Resolution US Rivers 
NOAM1-BDY – US-Canada boarder 
NOAM2-CIV – North America Outer Boundaries & Lakes 
NOAM3-STATE – North America State Boundaries 
NOAM4-RIV – North America Rivers 
NOAM – North and Central America Borders and boundaries 
NARR – North America Rural Roads 
NAIH – North America Interstate Highways 
NASH – North America State Highways 
NASR – North America State Roads 
SOUTHAMBOUND – South and Central America Boundaries and Lakes 
SOUTHAMRIVER – South and Central America Rivers 
STATES – US Hi Resolution State Boundaries 
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Appendix A:  Command Function Summary 
 
A listing of the file, C:\PCGRIDDS32\HELP\HLPC.DAT, which provides a >Command Function 
Summary= for online help in Command Mode (refer to >Online Help=), is supplied below. 
 
 
**-                PCGRIDDS32 --- COMMAND SUMMARY   
 
    General Commands:  -- |NAME| indicates an alternative name -- 
                       -- [....] describes additional information needed 
                       -- Ch. is an abbreviation for  Character 
                       -- ! following command name indicates system alias 
 
HELP > Provide general HELP and elementary Tutorials 
HELP |HLPC [Followed by command name]| > Provides specific command HELP 
HLPX [Followed by command name] > Provides EXtended command HeLP, if available 
DOS  |DIR !| > Returns to DOS for one command, such as DIR 
ERAS |ERSN!,ERSC!| > ERASes current screen display 
MENU |M   | > Changes from Command mode to MENU mode for user input 
CMND > Changes from Menu mode to CoMmaND mode for user input 
EXIT |X  QUIT  Q  STOP  S  END  or  E|  > Terminates the program 
 
 
**- Gridded Data File Manipulation Commands: 
LIST |L  | > Lists contents of the currently active file 
 
OPEN [Optional Name] > Opens another grid file [A total of 20 can be opened] 
FILS |LFIL,LFI=!| > Lists the files already OPENed and currently active file 
SFIL > Interactively resets active grid file 
          
FIL1 > Changes active grided data file to first file opened 
FIL2 > Changes active grided data file to second file opened 
...  
FIL9 > Changes active grided data file to ninth file opened 
FILA > Changes active grided data file to tenth file opened 
... 
FILK > Changes active grided data file to twentieth file opened 
 
FI-# > Changes active grided data file to #th file earlier on list 
FI+# > Changes active grided data file to #th file later on list 
 
 
**- Setting Forecast Time Specifications for data requests:   
FHOR |SFHR| > Requests input of Forecast HOuR 
FHRS |SFHS| > Requests input of PAIR OF Forecast HOuRs 
SFHR [Followed by 1 integer time] > Changes default forecast time  
SFHS [Followed by 2 integer times] > Change default fcst time pair  
ANAL |F-1 , F-1| > Sets Forecast Hour to use analysis grids 
GUES |F-3 , F-3| > Sets Forecast Hour to use analysis guess grids 
GES6 |F-6 , F-6| > Sets Forecast Hour to use analysis 6 h guess grids 
F### | F##| > Sets Forecast Hour to use ### hour forecast grids 
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FOO  |INIT| > Sets Forecast Hour to use initialized grids 
F12  | F12| > Sets Forecast Hour to use 12 hour forecast grids 
F24  | F24| > Sets Forecast Hour to use 24 hour forecast grids 
F36  | F36| > Sets Forecast Hour to use 36 hour forecast grids 
F48  | F48| > Sets Forecast Hour to use 48 hour forecast grids 
FHR1 > Gets data from first time of FHRS time pair for commands to left 
FHR2 > Gets data from second time of FHRS time pair for commands to left 
 
 
**- Setting Level/Layer specifications for data requests: 
SLVL [Followed by one 4 chtr level] > Specifies LeVeL for data selection 
 
#### > |###| {3 or 4 digit integer} > Sets Level to numerical value #### 
 
S### > Sets Level to Sigma level centered at ### mb 
S### |S982,S943,S896,S844,S784| > Sets Level to bottom 5 sigma level of NGM 
###M |0M, 2M, 10M| > Sets Level to ### Meters above ground (height<100m) 
M### > Sets Level to ### hectometers above ground (height>=100m) 
###Z > Sets Level to ### Meters above mean sea level (height<100m) 
Z### > Sets Level to ### hectometers above mean sea level (height>=100m) 
###U > Sets Level to ### centimeters below land surface (depth<1000cm) 
U### > Sets Level to ### meters below land surface (depth>=1000cm) 
B### > Sets Level to "Boundary" layer centered at ### mb above ground 
I### > Sets Level to ### degree (K) Isentropic surface  
L### > Sets Level to Flight Level ### 
H### > Sets Level to ### feet or meters above sea level (x10) 
MSL  > Sets Level to Mean Sea Level 
TROP > Sets Level to TROPopause 
MAXW |WMAX!| > Sets Level to MAXimum Wind level 
SFC  |0000| > Sets Level to the Earth SurFaCe 
 
 
**- Level/Layer specifications: 
SLYR |LAY=!,LAYR| [Followed by two 4 Ch. levels] > Change data LaYeR specs. 
 
LV+# > Increments LeVel to next # higher level 
 
SVLV > SaVes current LeVel specification 
SVLY > SaVes current LaYer specification 
RSLV > ReStores saved LeVel specification 
RSLY > ReStores saved LaYer specification 
LV-# > Increments LeVel to next # lower level 
 
LS+# > Changes LeVel to # higher than current LVL (useful in XSCT processing) 
LS-# > Changes LeVel to # lower than current LVL (useful in XSCT processing) 
LVL0 > Return to originally defined LVL after completing LS+# or LS-# commands 
 
LY+# > Changes LaYer Top (LVL2) to # higher than LVL 
LY-# > Changes LaYer Bottom (LVL1) to # lower than LVL 
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**- Output specifications: 
AROW |VCTR!| > Sets display mode to plot winds as arrows (Default) 
BARB > Sets display mode to plot winds as Barbs (m/s) 
STRM > Sets display mode to plot winds IN STReaMline like presentation 
 
DASH > Sets display mode to plot DASHed lines for this plot only 
DOTS > Sets display mode to plot DOTTed lines for this plot only 
DDSH > Sets display mode to plot DOTTED/DASHED dashed lines for this plot only 
LDSH > Sets display mode to plot Long DaSHed lines for this plot only 
DPOS > Dash POSitive contours 
DNEG > Dash NEGative contours 
 
DATA > Sets display mode to plot DATa values At grid points - no contours 
DAT+ > Sets display mode to plot DATa values slightly above grid points 
DAT- > Sets display mode to plot DATa values slightly below grid points 
DATT > Sets display mode to plot DATa values on Top of grid points 
DATB > Sets display mode to plot DATa values Below grid points 
DATO > Sets display mode to plot DATa values Over grid points - Above DATT 
DATU > Sets display mode to plot DATa values Under grid points - Below DATB 
PMNS > Plots - in front of all negative numbers; positive numbers unsigned 
PPLS > Plots + in front of all positive numbers; negative numbers unsigned 
 
 
**- Output specifications: 
HILO > Plots H or L above data at local maximum/minimum (with contours) 
HIIS > Plots H above data at local maximum (with contours) 
HIID > Plots H above data at local maximum (without contours) 
LOWS > Plots L above data at local minimum (with contours) 
LOWD > Plots L above data at local minimum (without contours) 
 
MXMN > Plots X or N above data at local maximum/minimum (with contours) 
MAXS > Plots X above data at local maximum (with contours) 
MAXD > Plots X above data at local maximum (without contours) 
MINS > Plots N above data at local minimum (with contours) 
MIND > Plots N above data at local minimum (without contours) 
 
BOXS!> Plots boxes at grid points below the surface 
BOX# > Plots a box at each grid point; # indicates box size 
 
 
**- Output specifications: 
SCL# > Display labels with signed digits greater than or equal to 10**# 
SCL0 > Display labels with signed digits greater than or equal to 10**0 (1) 
SCL1 > Display labels with signed digits greater than or equal to 10**1 (10) 
SC-# > Display labels with signed digits greater than or equal to 10**-# 
SC-1 > Display labels with signed digits greater than or equal to 10**-1 (.1) 
          
MOD# > Display labels using Modulo of SCALED display value and 10**# 
          
STON > Stops display of grid statistics at top of screen 
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STOF > Starts display of grid statistics at top of screen 



          
CNSM |KSMO,KSM=!| [Followed by integer] > Sets CoNtour SMoothing (Default=1) 
 
CNUM [Followed by integer] > Changes maximum number of contours to display 
 
#DGT > Plot maximum of # digits on contour labels / data plots (default 4) 
 
 
**- Layer/Time interval manipulations >>> For data in gridded data set <<< 
LAVE |LAVR!| > Calculate Layer AVErage of variables to LEFT in Command line 
LSUM |LADD!| > Calculate Layer SUM of variables to LEFT in Command line 
LDIF > Calculate Layer DIFference of variables to LEFT in Command line 
LVL1 |LYR1,LY1=!| > Gets data from bottom of Layer for variables to LEFT 
LVL2 |LYR2,LY2=!| > Gets data from top of Layer for variables to LEFT 
LEVL > Overrides LVL1 and LVL2 and gets data from original level 
 
TAVE > Calculate Time AVEerage of variables at LEFT using times FHR1 and FHR2 
TTOT > Calculates Time TOTal of variables at LEFT using times FHR1 and FHR2 
TDIF > Calculate Time DIFference of variables at LEFT between FHR1 and FHR2 
TTND > Calculate Time TeNDency of variables at LEFT between FHR1 and FHR2 
 
**- Layer/Time interval manipulations >>> For data in gridded data set <<< 
          
     >>> For data grids or computed functions -- Appears right of last & <<< 
LYSM > Calculates LaYer SuM of functions to RIGHT - One plot per line 
LYAV > Calculates LaYer AVerage of functions to RIGHT - One plot per line 
LYDF > Calculates LaYer DiFference of functions to RIGHT - One plot per line 
 
TMSM > Calculates TiMe SuM of functions to RIGHT - One plot per line 
TMAV > Calculates TiMe AVerage of functions to RIGHT - One plot per line 
TMDF > Calculates TiMe DiFference of functions to RIGHT - One plot per line 
TMTN > Calculates TiMe TeNdency of functions to RIGHT - One plot per line 
HRLY |PRHR| > Converts diagnostic command results from  /sec  to  /hour 
DALY |PRDY| > Converts diagnostic command results from  /sec  to  /day 
 
**- Special Gridded Data Requests: 
MIXR > Calculates Mixing Ratio from available data fields 
SPFH > calculates Specific Humidity from available data fields 
RELH > Calculates Relative Humidity from available data fields 
SMIX > Calculates Saturation Mixing Ratio from available data fields 
SDEF > Calculates Mixing Ratio Saturation Deficit from available data fields 
DWPT |DWPC!| Calculates DeW Point Temperature from available data fields (C) 
DWPK!> Calculates DeW Point Temperature from available data fields (K) 
DWPF!> Calculates DeW Point Temperature from available data fields (F) 
PRES > Calculates Pressure from available data fields 
TEMP |TMPC!| > Calculates temperature in degrees C 
TMPK |TMPA!| > Calculates temperature in degrees K 
TMPF!> Calculates temperature in degrees F 
THTA > Calculates Potential Temperature from available data fields (K) 
THTE > Calculates Equivalent Potential Temperature from data fields (K) 
THTS > Calculates Saturated Equivalent Potential Temperature from data fields (K) 
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THCK |TKNS!| > Generates Thickness fields 



SVPR > Saturated Vapor Pressure 
VAPR > Vapor Pressure 
LVAP > Latent heat of vaporization 
WBTP > Wet-Bulb Temperature 
WBPT > Wet-Bulb Theta 
SWPT > Saturated Wet-Bulb Theta-e 
CPDF > Condensation Pressure Deficit 
DPDP > Dew Point Depression 
 
 
WIND > Retrieves the total wind Vector in m/s 
WKNT!> Retrieves the total wind Vector in knots 
WMPH!> Retrieves the total wind Vector in mph 
WKPH!> Retrieves the total wind Vector in kph 
BWND!|WNDB!| > Retrieves the total wind Vector in m/s for display as wind barb 
BKNT!> Retrieves the total wind Vector in knots and sets display as wind barb 
BMPH!> Retrieves the total wind Vector in mph and sets display as wind barb 
BKPH!> Retrieves the total wind Vector in kph and sets display as wind barb 
WNDA!> Retrieves the total wind Vector in m/s and sets display as wind arrow 
GEOS > Generates the Geostrophic wind Vector 
AGEO!> Generates the Ageostrophic wind Vector 
TWND |THWN!| > Generates Thermal Wind 
ISAL > Computes the Isallobaric Wind 
INAD > Computes the Inertial Advective Wind 
JCBN [Followed by 2 Scalars] > Computes the Jacobian determinate of two scalars 
FRTG [Followed by wind Vector] > Computes Frontogenesis of the wind 
FVCT >  Calculates F (Normal wind) Vectors 
QVCT > Calculates Q (Geostrophic wind) Vectors 
 
 
SPED![Followed by wind Vector] > Calculates magnitude of wind Vector (m/s) 
SPKT![Followed by wind Vector] > Calculates magnitude of wind Vector (knots) 
SPML![Followed by wind Vector] > Calculates magnitude of wind Vector (mph) 
SPKM![Followed by wind Vector] > Calculates magnitude of wind Vector (kph) 
DRCT [Followed by a Vector] > Contours values of DiReCTion of a Vector 
DDFF [Followed by Vector] > Displays packed value of Vector Direction/speed 
DDDD [Followed by a Vector] > Displays values of DiReCTion of a Vector 
WSPD!> Generates isotachs for Total wind (m/s) 
WSPK!> Provides total Wind SPeed in Knots 
WDDF!> Displays packed value of Total Wind Direction/speed (m/s) 
WDRC!> Contours value of Total Wind Direction (degrees) 
WDDD!> Displays value of Total Wind Direction (degrees) 
XCMP |UCMP [Followed by vector]| > Returns grid relative X CoMPonent of vector 
YCMP |VCMP [Followed by vector]| > Returns grid relative Y CoMPonent of vector 
 
LIFT |LIFX,LIFB| > Provides Lifted Index fields without reseting LEVeL 
TTHE > Temperature of a parcel lifted from the bottom to the top of LAYeR 
CNVT > Temperature needed for parcel from surface to lift freely to LEVeL 
 
TPCP > Provides Total Precipitation fields without reseting LEVeL (cm) 
CPCP > Provides Convective Precipitation fields without reseting LEVeL (cm) 
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LPCP > Provides Large-Scale Precipitation fields without reseting LEVeL (cm) 



TPCI!> Provides Total Precipitation fields without reseting LEVeL (in) 
CPCI!> Provides Convective Precipitation fields without reseting LEVeL (in) 
LPCI!> Provides Large-Scale Precipitation fields without reseting LEVeL (in) 
 
PMSL > Provides Mean Sea Level Pressure fields without reseting LEVeL 
          Note:  If mean sea level pressure (GRIB ID=002) is not  
                 available, then an attempt is made to retrieve the  
                 RUC Reduction, the Eta Model Reduction, and the  
                 Standard Atmosphere Reduction, in that order. 
PMSS > Provides MSL Pressure fields (Std. atm. reduction) -- No LEVeL reset 
PMSR > Provides MSL Pressure fields (RUC reduction) -- No LEVeL reset 
PMSE > Provides MSL Pressure fields (ETA model reduction) -- No LEVeL reset 
MMSL > MSL pressure for RUC (MPAS) surface anaylsis using MAPS reduction 
NMSL > MSL pressure for RUC (MPAS) surface anaylsis using NMC reduction 
PSFC > Provides Surface Pressure fields without reseting LEVeL 
PWAT > Provides Precipitable Water fields without reseting LEVeL (mm) 
PWAI!> Provides Precipitable Water fields without reseting LEVeL (in) 
WVRT!> Generates vorticity of the Total wind 
GVRT!> Generates vorticity of the Geostrophic wind 
AVRT!> Calculates the absolute VoRTicity of Ageostrophic wind  
 
WDVR!> Calculates DiVeRgence of the total Wind field 
WSHD!> Calculates SHearing Deformation of total Wind 
GSHD!> Calculates SHearing Deformation of Geostrophic Wind 
ASHD!> Calculates SHearing Deformation of Ageostrophic Wind 
WSTD!> Calculates STretching Deformation of total Wind 
GSTD!> Calculates STretching Deformation of Geostrophic Wind 
ASTD!> Calculates STretching Deformation of Ageostrophic Wind 
TADV!> Generates Temperature Advection using the Total wind 
QADV!> Generates Mixing Ratio Advection using the Total wind 
PADV!> Generates Pressure Advection using the Total wind 
STAB |STBL!| > Computes static stability in a layer 
IMAS > Calculates Isentropic MASs (inverse static stability) in any layer 
LNDX > Calculates 'Lifted Index' between LVL1 and LVL2 
TLCL > Calculates the Temperature at the LCL from LEVeL data 
PLCL > Calculates the Pressure of the LCL from LEVeL data 
PDEF!> Calculates the Pressure DEFicit (lift) needed for saturation the LCL 
 
INRI!>Calculates the INverse of the RIchardson number 
IGRI!>Calculates the Inverse of the Geostrophic RIchardson number 
 
FFFF |F!  |> Provides coriolis parameter at each grid point 
DMAP |MFTR!,MAPF!|> Provides map factor at each grid point 
ALAT |LATT!,LAT! ,LATI!|> Latitude 
ALON |LONG!,LON! |> Longitude 
EDIR > DIRection of rotation from map standard North/South Earth longitude 
CSLT > Cosine of Latitude 
MSG0 > Produces grid with 1's at points with data and 0's at points without 
MSG1 > Produces grid with 0's at points with data and 1's at points without 
MSNG!> Produces grid with missing value flags at points without data 
ZERO > Provides scalar grid of all zeros (Used to display wind components) 
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GMIN > Produces scalar Grid with values of MINimum of last grid 



GMAX > Produces scalar Grid with values of MAXimum of last grid 
GMEN > Produces scalar Grid with values of MEaN of last grid 
GSDV > Produces scalar Grid with values of Standard DeViation of last grid  
SCPY > Produces a CoPY of a Scalar field 
VCPY > Produces a CoPY of a Vector field 
SSWP > SWaPs locations of last 2 Scalar fields in memory 
VSWP > SWaPs locations of last 2 Vector fields in memory 
DUMP > Prints grid point values in file 'GRIDS.OUT' 
 
 
**- Diagnostic Functions: 
SSUM [Followed by 2 Scalars] > Calculates Scalar grid sum 
SAVR [Followed by 2 Scalars] > Calculates Scalar grid average 
SDIF [Followed by 2 Scalars] > Calculates Scalar grid difference 
STND [Followed by 2 Scalars] > Calculates Scalar grid time tendency  
SMLT [Followed by 2 Scalars] > Multiplies two Scalar fields 
SDVD [Followed by 2 Scalars] > Divides two Scalar fields 
SADC [Followed by a 4 digit value] > Sum of Scalar & specified constant 
SSBC [Followed by a 4 digit value] > Difference of Scalar & specified constant 
SMLC [Followed by a 4 digit value] > Multiplies Scalar by specified constant 
SDVC [Followed by a 4 digit value] > Divides Scalar by specified constant 
INVS [Followed by a Scalar] > Finds INVerSe of a Scalar 
INV1 [Followed by a Scalar]] > Finds INVerse of a Scalar with maximum of 1 
ABSV [Followed by Scalar] > Calculates ABSolute Value of Scalar grid 
SNEG![Followed by Scalar] > Finds the NEGative of a Scalar grid 
 
 
**- Diagnostic Functions: 
SINE [Followed by Scalar] > Calculates the SINE of Scalar grid (e.g., WDRC) 
COSN [Followed by Scalar] > Calculates the COSiNe of Scalar grid (e.g., WDRC) 
TNGT [Followed by Scalar] > Calculates the TaNGenT of Scalar grid (e.g., WDRC) 
ASIN [Followed by Scalar] > Calculates the ARC SINe of Scalar grid 
ACOS [Followed by Scalar] > Calculates the ARC COSine of Scalar grid 
ATAN [Followed by Scalar] > Calculates the ARC TANgenT of Scalar grid 
ALOG [Followed by Scalar] > Calculates the LOG (Base e) of Scalar grid 
LG10 [Followed by Scalar] > Calculates the LOG (Base 10) of Scalar grid 
EXPP [Followed by Scalar] > Calculates the EXPonent (Base e) of Scalar grid 
EX10 [Followed by Scalar] > Calculates the EXponent (Base 10) of Scalar grid 
SQRT [Followed by scalar] > Return square root of absolute value of scalars 
 
SKNT! [Followed by Scalar] > Converts Scalar from m/s to KNoTs 
SMPH! [Followed by Scalar] > Converts Scalar from m/s to Miles Per Hour 
SKPH! [Followed by Scalar] > Converts Scalar from m/s to Kilometers Per Hour 
M2F=! [Followed by Scalar] > Converts Scalar from meters to feet 
CM2I! [Followed by Scalar] > Converts Scalar from centimeters to inches 
 
DSDX [Followed by Scalar] > Calculates X gradient of Scalar 
DSDY [Followed by Scalar] > Calculates Y gradient of Scalar 
GRAD [Followed by a Scalar] > Finds the GRADient of a Scalar field 
MGRD![Followed by a Scalar] > Magnitude of the GRaDient of a Scalar field 
NGRD![Followed by a Scalar] > Finds the Negative GRaDient of a Scalar field 
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DVDX [Followed by Vector] > Calculates X gradients of a Vector 
DVDY [Followed by Vector] > Calculates Y gradients of a Vector 
VADC [Followed by a 4 digit value] > Sum of Vector & specified constant 
VSBC [Followed by a 4 digit value] > Difference of Vector & specified constant 
VMLC [Followed by a 4 digit value] > Multiplies Vector by specified constant 
VDVC [Followed by a 4 digit value] > Divides Vector by specified constant 
VNEG![Followed by Vector] > Finds the NEGative of a Vector field 
VSUM [Followed by 2 Vectors] > Calculates the Vector sum 
VAVR [Followed by 2 Vectors] > Calculates the Vector average 
VDIF [Followed by 2 Vectors] > Calculates the Vector difference 
VTND [Followed by 2 Vectors] > Calculates the Vector time tendency 
VMLT [Followed by 2 Vectors] > Multiplies two Vectors by components 
DOTP [Followed by 2 Vectors] > Calculates the DOT Product of 2 Vectors 
CRSP [Followed by 2 Vectors] > Calculates the CRoSs Product of two Vectors 
VDVD [Followed by 2 Vectors] > Divides two Vectors by components 
 
VKNT![Followed by a Vector] > Converts a Vector from m/s to KNoTs 
VMPH![Followed by a Vector] > Converts a Vector from m/s to MPH 
VKPH![Followed by a Vector] > Converts a Vector from m/s to KPH 
MAGN |MSPC!| [Followed by a Vector] > Calculates MAGNitude of a Vector 
KNOT![Followed by a Scalar] > Converts a Scalar (e.g., WSPD) from m/s to KNOTs 
MLPH![Followed by a Scalar] > Converts a Scalar (e.g., WSPD) from m/s to MPH 
KMPH![Followed by a Scalar] > Converts a Scalar (e.g., WSPD) from m/s to KPH 
 
ADVT [Followed by Scalar and Vector] > Calculates advection 
DVRG [Followed by a Vector] > Calculates divergence 
FLUX [Followed by a Scalar & a Vector] > Produces a flux Vector 
SDVR![Followed by Scalar and Vector] > Calculates flux divergence 
RVRT [Followed by a Vector] > Calculates relative vorticity 
VORT![Followed by a Vector] > Calculates absolute vorticity 
IPVO > Isentropic Potential Vorticity calculated between LVL1 and LVL2 when 
       LVL1 and LVL2 are set to Theta levels. 
IPVA > Isentropic Potential Vorticity Advection calculated between LVL1 and  
       LVL2 when LVL1 and LVL2 are set to Theta levels. 
PVTA > Isobaric Potential Vorticity (Theta) calculated between LVL1 and LVL2 when 
       LVL1 and LVL2 are set to pressure levels. 
PVTE > Isobaric Potential Vorticity (Theta-E) calculated between LVL1 and LVL2 when 
       LVL1 and LVL2 are set to pressure levels. 
PVTS > Isobaric Potential Vorticity (Theta-S) calculated between LVL1 and LVL2 when 
       LVL1 and LVL2 are set to pressure levels. 
PVAA > Isobaric Potential Vorticity (Theta) Advection calculated between LVL1 and  
       LVL2 when LVL1 and LVL2 are set to pressure levels. 
PVEA > Isobaric Potential Vorticity (Theta-E) Advection calculated between LVL1 and  
       LVL2 when LVL1 and LVL2 are set to pressure levels. 
PVSA > Isobaric Potential Vorticity (Theta-S) Advection calculated between LVL1 and  
       LVL2 when LVL1 and LVL2 are set to pressure levels. 
SHDF [Followed by vector] > Calculates SHearing DeFormation 
STDF [Followed by vector] > Calculates STretching DeFormation 
WGEO [Followed by scalar field] > Calculates Geostrophic Wind from Scalar field 
DFCP [Followed by a vector] > Calculate the Deformation components  
                              (X COMP, Y COMP) of any vector 
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SMTH > Applies a binomial SMooTHer to the active scale data field 
SMT# > Applies a binomial SMooTHer # times to the active scalar data field 
SMOO > Applies a light SMOOther to the active scalar data field 
VSMT > Applies a binomial sMooTHer to the active Vector field 
VSM# > Applies a binomial sMooTHer # times to the active Vector field 
RLTN [Followed by a 4 digit value] > Replaces values Less ThaN with that value 
RGTN [Followed by a 4 digit value] > Replaces values Greater ThaN with value 
MLTN [Followed by a 4 digit value] > Replaces values Less ThaN as Missing 
MGTN [Followed by a 4 digit value] > Replaces values Greater ThaN as Missing 
MSKS![Followed by a field] > Replaces values below the surface as missing 
SMAX > Finds the MAXimum at each grid point of two Scalar fields 
SMIN > Finds the MINimum at each grid point of two Scalar fields 
ZNEG > Sets all NEGative values to Zero 
ZPOS > Sets all POSitive values to Zero 
 
**- Diagnostic Functions - Convection Control Flags 
 
VTMP > Virtual Temperature Correction 

All convection parameters are calculated without virtual temperature correction by default.  This      
flag enables that correction. 

SBSI > Surface-Based Lifted Parcel Selected 
MLSI > Mean-Layer Lifted Parcel Selected 
MUSI > Most Unstable Lifted Parcel Selected 
USSI > User-Selected Lifted Parcel Selected 
If no Lifted Parcel method is selected, Surface-Based Lifted Parcel is default. 
 
**- Diagnostic Functions - Convection Parameters 
 
CPOS [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Convective Positive Energy (CAPE) 
CNEG [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Convective Negative Energy (CINH) 
PLPL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Pressure Lifted Parcel Level 
TLPL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Temperature Lifted Parcel Level 
DLPL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Dew point Lifted Parcel Level 
HLPL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Height Lifted Parcel Level 
THLP [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Theta Lifted Parcel Level 
TELP [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Theta-e Lifted Parcel Level 
PLCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Pressure Lifted Condensation Level 
TLCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Temperature p Lifted Condensation Level 
MLCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Mixing ratio Lifted Condensation Level 
HLCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Height Lifted Condensation Level 
THLC [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Theta Lifted Condensation Level 
TELC [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Theta-e Lifted Condensation Level 
PLFC [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Pressure Level of Free Convection 
TLFC [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Temperature Level of Free Convection 
DLFC [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Dew point Level of Free Convection 
HLFC [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Height Level of Free Convection 
THLF [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Theta Level of Free Convection 
TELF [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Theta-e Level of Free Convection 
PCCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Pressure Convective Condensation Level 
TCCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Temperature Convective Condensation Level 
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DCCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Dew point Convective Condensation Level 



HCCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Height Convective Condensation Level 
THCC [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Theta Convective Condensation Level 
TECC [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Theta-e Convective Condensation Level 
PEQL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Pressure Equilibrium Level 
TEQL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Temperature Equilibrium Level 
DEQL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Dew point Equilibrium Level 
HEQL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Height Equilibrium Level 
MPCL [(VTMP)(SBSI,MLSI,MUSI,USSI)] > Height Max Parcel Level 
PWBZ > Pressure Wet-Bulb Zero Level 
TWBZ > Temperature Wet-Bulb Zero Level 
HWBZ > Height Wet-Bulb Zero Level 
CNPR > Condensation Pressure Ratio 
CNPD > Condensation Pressure Deficit 
WBTF > Wet-Bulb Temperature degrees F 
WBTC > Wet-Bulb Temperature degrees C 
WBTK > Wet-Bulb Temperature degrees K 
 
**- Diagnostic Functions - Shear Control Flags 
 
   **KM – Defines the Lower/Upper bounding levels in Kilometers 
 The first * (0-9) defines the lower level to use and the second * (0-9) defines the     
            upper level to use.  Therefore, a command 14KM defines the 1km to 4km layer. 
 
**- Diagnostic Functions - Shear Parameters 
 
   UAVG (Scalar) > U-average wind through layer 
   VAVG (Scalar) > V-average wind through layer 
   WAVG (Vector) > Average Wind through layer 
   BLKS (Scalar) > Bulk Shear 
   BRCH (Scalar) > Bulk Richardson Number 
   TCHS (Scalar) > Total Cumulative Shear through layer 
   USHR (Scalar) > U-Shear between layer 
   VSHR (Scalar) > V-Shear between layer 
   TSHR (Vector) > Total Wind Shear between layer 
 
The following supercell specific diagnostics are controlled with only the **KM flag except where noted.  
If the flag is omitted, 03KM is assumed.  All calculations use the Bunkers Method algorithm. 
 
   RMSU (Scalar) > Supercell U-component, Right-moving (06KM) 
   RMSV (Scalar) > Supercell V-Component, Right-moving (06KM)  
   RMSS (Vector) > Supercell Motion, Right-moving (06KM) 
   RMSP (Scalar) > Supercell Speed, Right-moving (06KM) 
   RMDR (Scalar) > Supercell Direction, Right-moving (06KM) 
   LMSU (Scalar) > Supercell V-Component, Left-moving (06KM) 
   LMSV (Scalar) > Supercell V-Component, Left-moving (06KM) 
   LMSS (Vector) > Supercell Motion, Left-moving (06KM) 
   LMSP (Scalar) > Supercell Speed, Left-moving (06KM) 
   LMDR (Scalar) > Supercell Direction, Left-moving (06KM) 
   SRHR (Scalar) > Storm-Relative Helicity, Right-moving 
   SRHL (Scalar) > Storm-Relative Helicity, Left-moving 
   SRWR (Vector) > Storm-Relative Mean Wind, Right-moving 
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   SRWL (Vector) > Storm-Relative Mean Wind, Left-moving 



 
 
**- Diagnostic Functions - Cross/Time Section Specific: 
XREL [Followed by Vector] > Rotates Vector from GRID to Cross Sector relative 
EREL [Followed by Vector] > Rotates Vector from GRID to Earth relative (TSCT) 
TANG [Followed by Vector] > Finds cross-section relative tangential component 
VTNG [Followed by Vector] > Plots cross-section relative tangential component 
VCRC [Followed vy Vector] > Plots VTNG & VVEL 
VCR2 [Followed vy Vector] > Plots VTNG & VVEL scaled by 2 
VCR5 [Followed vy Vector] > Plots VTNG & VVEL scaled by 5 
NORM [Followed by Vector] > Finds cross-section relative normal component 
VNRM [Followed by Vector] > Plots cross-section relative normal component 
DIST > Calculates DISTance from left end of cross section 
MSFC!> Calculates constant Momentum SurFaCe (M-Surfaces) 
WNDX!> Displays the total wind rotated relative to the cross section 
GEOX!> Displays the geostrophic wind rotated relative to the cross section 
AGEX!> Displays the ageostrophic wind rotated relative to the cross section 
WCRC!> Displays vertical/tangential circulations of total wind 
GCRC!> Displays vertical/tangential circulations of geostrophic wind 
ACRC!> Displays vertical/tangential circulations of ageostrophic wind 
 
 
**- Contour Specification:   
CINT > Displays Max and Min of field and requests user input 
 
CISV > Sets mode where specified contour interval is retained for future plots 
CINX > Returns to mode in which program selects contour interval for each plot 
 
CIN# > Sets Contour Internal to # units 
CIN1 > Sets Contour Interval to 1 unit 
CIN2 > Sets Contour Interval to 2 units 
... 
CI#0 > Sets Contour Interval to # of tens of units 
CI10 > Sets Contour Interval to 10 units 
CI20 > Sets Contour Interval to 11 units 
... 
C#00 > Sets Contour Interval to # hundreds of units 
C100 > Sets Contour Interval to 100 units 
C200 > Sets Contour Interval to 200 units 
 
C#+# > Sets Contour Interval to #*10**# units == C2+3 -> 2*10**3 = 2000 
C1+3 > Sets Contour Interval to 1000 units --> 10**3 
C2+3 > Sets Contour Interval to 2000 units --> 2*10**3 
... 
 
CI.# |C#-1| > Sets Contour Interval to .# units -->#*10**-1 
CI.1 |C1-1| > Sets Contour Interval to .1 units 
CI.2 |C2-1| > Sets Contour Interval to .2 units 
... 
 
C#+# > Sets Contour Interval to #*10**-# units == C2-3 -> 2*10**3 = .002 
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C2-2 > Sets Contour Interval to .02 units 



C5-3 > Sets Contour Interval to .005 units 
 
GRTN [Followed by a 4 digit value] > Displays contours greater than the value 
LSTN [Followed by a 4 digit value] > Displays contours less than the value 
GT## |GT00!|> Displays contours greater than the value  ## 
LT## |LT00!|> Displays contours less than the value  ## 
GTNE [Followed by a 4 digit value] > Displays contours greater than or equal to the value 
LTHE [Followed by a 4 digit value] > Displays contours less than or equal to the value 
 
 
**- Graphical Display Setup Commands: 
AREA [Optionally followed by center Lat/Lon&N-S Lat.Dist.] > Specify Map area 
XSCT [Followed by left and right Lat/Lon pairs] > Defines Cross-Section path 
TSCT [Followed by Lat/Lon] > Defines Time-Section location 
ASTN [Followed by center Station ID and N-S Lat.Dist.] > Specify Map area 
XSTN [Followed by left and right Station IDs] > Defines Cross-Section path 
TSTN [Followed by Station ID] > Defines Time-Section location 
XSCI [Followed by left and right Lat/Lon pairs] > Defines Isentropic Cross-Section path  
XSTI [Followed by left and right Station IDs] > Defines Isentropic Cross-Section path 
XSCH [Followed by left and right Lat/Lon pairs] > Defines Height Surfaces Cross-Section path  
XSTH [Followed by left and right Station IDs] > Defines Height Surfaces Cross-Section path 
TSCI [Followed by Lat/Lon] > Defines Isentropic Time-Section location 
TSTI [Followed by Station ID] > Defines Isentropic Time-Section location 
TSCH [Followed by Lat/Lon] > Defines Height Surfaces Time-Section location 
TSTH [Followed by Station ID] > Defines Height Surfaces Time-Section location 
NS## > Sets default North-to-South distance for ASTN to ## degrees 
XWID > Display Cross-Section across full width of screen--Set in PLAN view 
XNRO > Display Cross-Section in proportion to vertical height--Set in PLAN  
ALVL > Use all available pressure levels in Cross or Time section 
ATIM > Use all available forecast hours in Time section 
 
 
XLVL [Followed by 4 Ch. name] > Reads file ----.LVL to define TSCT/XSCT levels 
THRS [Followed by 4 Ch. name] > Reads file ----.LVL to define TSCT hours 
TINC [Followed by integer] > Changes time increments for time section 
THN# > THiN computation grid to use every #th grid point-CAN OVERFLOW PROGRAM 
THN0 > Display current display mode and grid thinning factor 
FULG > Displays grid data at full grid resolution 
NRMG > Displays grid data at normal thinning 
 
 
**- Graphics Commands: 
PLAN > Re-activates PLAN view display 
CROS > Re-activates CROSs-sectional display 
TIME > Re-activates TIME-sectional display 
XLBL > Plots values of left most column of cross/time section along left side 
XLBB > Plots values of bottom row of cross/time section along bottom 
XLTN > Calculates Latitude locations along a cross section 
XLNT > Calculates Longitude locations along a cross section 
HOUR > Places forecast hour into time section array 
NCLB > Draws contours without labels for current request only 
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NLBL > Prevents plot label (top of screen) from being overwritten 



 
SAVE [Followed by 4 Chtr NAME] > SAVEs graphics commands to file NAME 
ENDS > Stops SAVEing graphics commands 
SAVM > SAVes graphics commands for delayed print (Menu mode only) 
ENDM > Stops SAVEing graphics commands (Menu mode only) 
REST [Followed by 4 Chtr NAME] > RESTores graphics in file NAME 
;    [____;, ";" preceeded by 4 Chtr NAME] > RESTores graphics in file NAME 
SAVS [Followed by 4 Chtr NAME] > SAVes Screen contents to BMP file NAME  
 
PRSC!|BKWT| > Converts screen colors for printing using 'PRint SCreen' key 
 
POPT > List current print option and select a new print option 
PRNT [Followed by optional 4 Ch. name] > Print specified or default .SVG file 
LSVG > List files containing a set of saved graphics commands 
 
MAP  > Redraws map background with no data 
EMAP > Erases screen and draws map background with no data 
 
SVMP > Save, list, or delete map plot files 
 
BSMP |BASM!| > Defines a new file containing base map geography information 
 
&   |or /   | > Overlays output on previous graphics  
OLAY |CNTR!| > Overlays output on previous graphics -- First command in a line 
 
CLR1 > Override default and use color 1 in pallette (Solid) 
CLR2 > Override default and use color 2 in pallette (Solid) 
... 
CLR9 > Override default and use color 9 in pallette (Solid) 
CLRA > Override default and use color 10 in pallette (Solid) 
... 
CLRG > Override default and use color 16 in pallette (BLACK - ERASES LINES) 
    --- 
CLRH > Override default and use color 1 in pallette (Dashed) 
CLRI > Override default and use color 2 in pallette (Dashed) 
... 
 
CLRX > Override default and use color 14 in pallette (Dotted) 
CLRY > Override default and use color 15 in pallette (Dotted) 
CLRZ > Override default and use color 16 in pallette (Dotted) 
 
SCLR > Save current CoLoR order from pallette 
RCLR > Return to saved CoLoR order on pallette 
 
BKG1 > Use color 1 in pallette as background for plot on screen 
BKG2 > Use color 2 in pallette as background for plot on screen 
... 
BKG9 > Use color 9 in pallette as background for plot on screen 
BKGA > Use color 10 in pallette as background for plot on screen 
... 
BKGG > Use color 16 in pallette as background for plot on screen 
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--- 



BKGH > Use color 1 in pallette as background for plot on screen 
BKGI > Use color 2 in pallette as background for plot on screen 
... 
    --- 
BKGX > Use color 14 in pallette as background for plot on screen 
BKGY > Use color 15 in pallette as background for plot on screen 
BKGZ > Use color 16 in pallette as background for plot on screen 
 
ANIM > Animates a display of data using all forcast hours (PLAN or CROSS). 
             Must be first command. 
ENDA > Ends the Animation build process. 
 
 
**- Command Manipulations: 
CMDS |LCMD| > Lists the previous 21 commands lines 
          
CMD1 > Lists last CoMmanD given (without erasing screen) 
CMD2 > Lists 2nd previous CoMmanD given (without erasing screen) 
... 
CMD9 > Lists 9th previous CoMmanD given (without erasing screen) 
CMDA > Lists 10th previous CoMmanD given (without erasing screen) 
... 
CMDL > Lists 21st previous CoMmanD given (without erasing screen) 
          
          
RPT1 > RePeaTs last command given 
RPT2 > RePeaTs 2nd previous command given 
... 
RPT9 > RePeaTs 9th previous command given 
RPTA > RePeaTs 10th previous command given 
... 
RPTL > RePeaTs 21st previous command given 
 
 
**- Special COMMAND FILE (.CMD Files) Commands: 
.    {Preceeded by 4 Ch. Name} > Executes Named command (script) file 
:    {Preceeded by 4 Ch. Name} > Overlays Named command file on existing plot 
 
LOOP > All following commands will be executed without keyboard prompts 
ENDL > Ends LOOP in .CMD file 
 
#SEC > Wait # secondS before executing next request 
1SEC > Wait 1 second before executing next request 
2SEC > Wait 2 seconds before executing next request 
... 
9SEC > Wait 9 seconds before executing next request 
 
^   > Repeat last macro for current time 
<   > Repeat last macro for time equals current time - increment set by DELT 
>   > Repeat last macro for time equals current time + increment set by DELT 
BEGT [Followed by integer] > Set begin limit of time sequence for macro repeat 
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ENDT [Followed by integer] > Set end limit of time sequence for macro repeat 



DELT [Followed by integer] > Set increment of time sequence for macro repeat 
 
PMSV > Save parameters (eg, LVL) in macro as permanent settings {Menu mode} 
 
**- Special LABELING Commands: 
TXT# [Followed by line of text] > Writes TeXT on line # from top of screen 
TXT1 |TEXT,TUTR| > Writes text on TOP line of screen 
TXT2 > Writes text on 2nd line of screen 
... 
LTM# > Write forecast hour or TiMe range on line sequence # of label set 
LPL# > Write Pressure Level or layer on line sequence # of Label set 
LFL# > Write Flight Level or layer on line sequence # of Label set 
LDN# > Write Data file Name on line sequence # of Label set 
LFD# > Write Forecast model Date on line sequence # of Label set 
LMN# > Write forecast Model Name on line sequence # of Label set 
LFO# > Write Forecast model Origination on line sequence # of Label set 
LLN# > Write forecast LeNgth on line sequence # of Label set 
LLL# > Write Latitude/Longitude on line sequence # of Label set (tsct/xsct) 
LSN# > Write StatioN identifier on line sequence # of Label set (tsct/xsct) 
LTX# [Followed by line of text] > Write TeXt on line sequence # of Label set 
LNDF > Stop display of DeFault Labels (applies to current plot and overlays) 
LDEF > Start display of DEFault Labels (applies to current plot and overlays) 
LWT# > Begin WriTing current Label set on line # from top of screen 
 
 
**-    ---  To String Commands from One Line to the Next  --- 
 
CONT {LEFTMOST position} > Save fields for next comand line, without plotting 
 
LAST |LSTS!,LSTV!,LST#| {RIGHTMOST command} > Returns data to work array 
       -- NOTE:  LSTS |LST1,KEPS!| retrieves last 1 Scalar array only -- 
       -- NOTE:  LSTV |LST2,KEPV!| retrieves last 2 scalar arrays (Vector) only 
       -- NOTE:  LST# retrieve last # scalar arrays back to work array -- 
       ----------------------------------------------------------------------- 
       ** NOTE:  LAST,etc. should be used ONLY for redisplay in XSCT or TSCT 
       ** NOTE:  LSTS,LSTV can NOT be used in COMMAND ( .CMD ) files 
       ** NOTE:  LAST is not needed if CONT was in previous line -- 
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Appendix B:  Listing of Basic Grid Fields 
 
A listing of the file, C:\PCGRIDDS32\HELP\HLPG.DAT, which provides a >Listing of Basic Grid Fields= 
for online help in Command Mode (refer to >Online Help=), is supplied below. 
 
 
**-                PCGRIDDS --- BASIC GRIDDED DATA FIELDS 
      
      
HELP > Provide general HELP and elementary Tutorials 
HLPC |HELP [Followed by command name]| > Provides specific command help 
      
      
       ******   Basic ICAO-Required Fields   ****** 
      
TEMP > TEMPerature  (degree C) 
WIND > WIND (m/s) 
WKNT > Wind (KNoTs) 
      
UGRD > West-to East Wind Component (m/s)  
VGRD > South-to-North Wind COmponent (m/s) 
      
HGHT > HeiGHT (Geopotential Meters) 
MAXW |WMAX!| > Data from MAXimum Wind level 
TROP > Data From TROPopause level 
 
 
**-    ******   Additional Meteorological Fields   ****** 
 
HGHT > Geopoptential HeiGHT (meters)  
PRES > Pressure (mb) 
MIXR > MIXing Ratio (g/kg) 
VVEL > Vertical VELocity (Microbars/sec) 
 
PMSL > Mean Sea Level Pressure fields, obtained without reseting LEVeL 
 
          Note:  If mean sea level pressure (GRIB ID=002) is not  
                 available, then an attempt is made to retrieve the  
                 RUC Reduction, the Eta Model Reduction, and the  
                 Standard Atmosphere Reduction, in that order. 
 
PRSS > Mean sea level PReSsure (Std. atm. reduction) -- Set level first 
PRSR > Mean sea level PReSsure (Ruc reduction) -- Set level first 
PRSE > Mean sea level PReSsure (Eta model reduction) -- Set level first 
 
TPCP > Total Precipitation fields, obtained without reseting LEVeL (cm) 
CPCP > Convective Precipitation fields, obtained without reseting LEVeL (cm) 
      
TPCI > Total Precipitation fields, obtained without reseting LEVeL (in) 
CPCI > Convective Precipitation fields, obtained without reseting LEVeL (in) 
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       NOTE:  TPCx/CPCx attempt to retrieve a 12 hour accumulation.  If this 



              is not possible, then they try to obtain the longest 
              accumulation (6,3,2,1) available. 
 
TPC# > Total Precipitation fields in cm (#=hour accumulation)--no level reset 
CPC# > Convective Precipitation field in cm(#=hour accumulation)-no level reset 
 
 
**-    ******    Automatically Derived Scalar Parameters   ****** 
      
      
THTA > Potential Temperature - THeTA(degree K)  
RELH > Relative Humidity (%) 
DWPT > DeW Point Temperature (degree C)  
TMPK > TeMPerature (degrees K) 
TMPF > TeMPerature (degrees F) 
THTE > Equivalent Potential Temperature - THeTa/E (degree K) 
      
       ******   Automatically Derived Vector Parameters   ****** 
      
GEOS > GEOStrophic wind vector (m/sec)  
WSPD > Total Wind Speed (m/sec) 
WDDF > Packed value of Wind Direction/speed (tens of degrees and m/sec)  
WDRC > Wind DiRCtion (degrees) 
BWND > WiND Barbs (m/sec) 
BKNT > Wind Barbs (KNoTs) 
      
      
**-    ******   Isobaric Level Specifications   ****** 
      
 100 >  100 hPA level data --> FL-530  (ICAO-Required)  
 150 >  150 hPa level data --> FL-450  (ICAO-Required)  
 200 >  200 hPa level data --> FL-390  (ICAO-Required)  
 250 >  250 hPa level data --> FL-350  (ICAO-Required)  
 300 >  300 hPa level data --> FL-300  (ICAO-Required)  
 400 >  400 hPa level data --> FL-240  (ICAO-Required)  
 500 >  500 hPa level data --> FL-180  (ICAO-Required)  
 700 >  700 hPa level data --> FL-100  (ICAO-Required)  
 850 >  850 hPa level data --> FL-050  (ICAO-Required) 
1000 > 1000 hPa level data 
 
 
**-    ******   Special Level Specifications   ****** 
TROP > TROPopause level data    (ICAO-Required)  
MAXW |WMAX!| > MAXimum Wind level data  (ICAO-Required) 
 SFC > Earth's SurFaCe data 
 MSL > Mean Sea Level data 
CBAS > Cloud BASe level data 
CTOP > Cloud TOP level data 
0DEG > First freezing level above ground 
CLVL > Adiabatic Condensation LeVeL data (parcel lifted from surface) 
0DGX > Top freezing level 
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LCDB > Low ClouD Bottom level data 



LCDT > Low ClouD Top level data 
LCDL > Low ClouD Layer data 
MCDB > Middle ClouD Bottom level data 
MCDT > Middle ClouD Top level data 
MCDL > Middle ClouD Layer data 
HCDB > High ClouD Bottom level data 
HCDT > High ClouD Top level data 
HCDL > High ClouD Layer data 
 
       NOTE:  No special level can begin with 0 except 0DEG, 0DGX, 0000  
 
 
**-    ******   Additional Level/Layer Specifications   ****** 
 
###Z > Height above mean sea level in m (<100m) 
Z### > Height above mean sea level in hm (>=100m) 
 
###M > Height above ground in m (<100m) 
M### > Height above ground in hm (>=100m) 
 
###U > Depth below land surface in cm (<1000cm) 
U### > Depth below land surface in m (>=1000cm) 
 
S### > Sigma level number 
H### > Height above sea level (x10) 
I### > Isentropic level in degrees K 
B### > Boundary layer in hPa (mb) above surface at the center 
 
 
**-    ******   Time Specifications   ****** 
      
 F06 >  6 hour forecast data  
 F12 > 12 hour forecast data  (ICAO-Required)  
 F18 > 18 hour forecast data  (ICAO-Required)  
 F24 > 24 hour forecast data  (ICAO-Required)  
 F30 > 30 hour forecast data  (ICAO-Required)  
 F36 > 36 hour forecast data 
 
 
**-    ******   Special Optional Gridded Data Fields   ****** 
           
LIFT > LIFTed Index, obtained without reseting LEVeL 
PWAT > Precipitable Water fields, obtained without reseting LEVeL (mm)  
PWAI > Precipitable Water fields, obtained without reseting LEVeL (in) 
      
      
THCK > Generates Thickness fields between LVL1 and LVL2 
THWN > Generates Thermal Wind between LVL1 and LVL2 
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**-    ******  Other Parameters commonly in GRIB data sets: ****** 
 
TEMP > TEMPerature  (degree C) 
WIND > WIND (m/s) 
WKNT > Wind (KnoTs) 
PRES > PRESsure (mb, .1hPa) 
PTND > Pressure TeNDency (mb/hr, .1hPa/hr) 
HGHT > geopotential HeiGHT (m) 
GHGT > Geometric HeiGhT (m) 
OZON > Total  OZONe 
TEMP  > TEMPerature (degree C) 
VTMP > Virtual TeMPerature (degree K) 
THTA > potential temperature [TheTA] (degree K) 
THTE > equivalent potential temperature [TheTa-E] (degree K) 
DWPT > DeWPoinT temperature (degree C) 
DPTD  > DeWPoint temperature Depression (degree C) 
WNDD > WiND Direction (degree) 
WNFF > WIND SPEED (m/sec) 
UGRD > GRiD relative U wind component (m/sec) 
VGRD > GRiD relative V wind component (m/sec) 
 
SFTN > Stream FuNcTion (m**2/sec) 
PSYM > montgomery stream function [PSYM] (m**2/sec**2) 
VVEL > Vertical VELocity (micro-bars/sec) 
VTCY > absolute VorTiCitY (1/sec) 
SPFH > SPeciFic Humidity (g/g) 
RELH > RELative Humidity (%) 
MIXR > MIXing Ratio (g/g) 
PWAT > Precipitable WATer (cm) 
VCRS > Vapor pressure (mb, .1hPa) 
DEF. > Saturation DEFicit (mb, .1hPa) 
PCRT > PreCipitation RaTe (cm/sec) 
TPCP > Total PreCiPitation (cm) 
LPCP > Large-scale (stable) PreCiPitation (cm) 
CPCP > Convective PreCiPitation (cm) 
SWAT > WATer equivalent Snow depth (cm) 
SNDP > Snow DePth (cm) 
 
TCLD > Total Cloud percent (%) 
CCLD > Convective ClouD percent (%) 
LCLD > Low CLouD percent (%) 
MCLD > Middle ClouD percent (%) 
HCLD > High CLouD percent (%) 
CH2O > Cloud water [H2O] (cm) 
PCON > CONdensation Pressure (mb, .1hPa) 
WTMP > Water TeMPerature (degree K) 
TSOL > SOiL Temperature (degree K) 
SWEL > significant SWELl wave height (m) 
SWVR > net Short WaVe Radiation at surface (W/m**2) 
LWVR > net Long WaVe Radiation at surface (W/m**2) 
PRSS > mean sea level Pressure - Standard atmosphere reduction (mb, .1hPa) 
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PRSR > mean sea level Pressure - RUC reduction (mb, .1hPa) 
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PRSE > mean sea level Pressure - Eta reduction (mb, .1hPa) 
 
LIFT >  "Surface " LIFTed index (degree K) 
LFTX > "best" LiFTed index (degree K) 
LFTB > "Boundary layer" LiFTed index (degree K) 
KNDX > K iNDeX (degree K) 
SWET > SWEeT index (degree K) 
 
HQDV > Horizontal moisture [Q] DiVergence (g/g/sec) 
VSSH > Vertical wind Speed Shear (1/sec) 
PTN3 > 3 hour interval Pressure TeNdency (mb/sec) 
CRAN > Categorical RaiN (1/0 = Yes/No) 
CZRN > Categorical freeZing RaiN (1/0 =Yes/No) 
CPEL > Categorical ice PELlets (1/0 = Yes/No) 
CSNO > Categorical SNOw (1/0 = Yes/No) 
CWTR > Cloud WaTeR (cm) 
CINH > Convective INHibition (J/kg) 
CAPE > Convective Available Potential Energy (J/kg) 
TKEN > Turbulent  KENetic energy (J/kg) 
THTV > Virtual potential temperature [TheTa-V] (degree K) 
HLCY > storm relative HeLiCitY  
 
POPP > Probability Of PreciPitation (%) 
POZP > Probability Of froZen Precipitation (%) 
POFP > Probability Of Freezing Precipitation (%) 
USTM > U-component of STorM relative motion (m/sec) 
VSTM > V-component of STorM relative motion (m/sec) 
PSNC > Percent SNow Cover (%) 
 


